Federal Emergency Management Information System (FEMIS)

Installation Guide

for

FEMIS Version 1.5.3

November 20, 2002

Prepared for the CSEPP Office
United States Army Soldier and Biological Chemical Command
under a Related Services Agreement
with the U.S. Department of Energy
Contract DE-AC06-76RLO 1830
Acknowledgment

The FEMIS product is being developed by the Pacific Northwest National Laboratory as part of the US Army's Chemical Stockpile Emergency Preparedness Program (CSEPP).

This software and its documentation were produced with Government support under Contract Number DE-AC06-76RLO-1830 awarded by the United States Department of Energy. The Government retains a paid-up non-exclusive, irrevocable worldwide license to reproduce, prepare derivative works, perform publicly and display publicly by or for the Government, including the right to distribute to other Government contractors.

Disclaimer

This material was prepared as an account of work sponsored by an agency of the United States Government. Neither the United States Government nor the United States Department of Energy, nor Battelle Memorial Institute, nor any of their employees, MAKES ANY WARRANTY, EXPRESSED OR IMPLIED, OR ASSUMES ANY LEGAL LIABILITY OR RESPONSIBILITY FOR THE ACCURACY, COMPLETENESS, OR USEFULNESS OF ANY INFORMATION, APPARATUS, PRODUCT, SOFTWARE, OR PROCESS DISCLOSED, OR REPRESENTS THAT ITS USE WOULD NOT INFRINGE PRIVATELY OWNED RIGHTS.

References to any specific commercial product, process or service by trade name, trademark, manufacturer, or otherwise does not necessarily constitute or imply endorsement, recommendation, or favoring by the US Army or Battelle.

The software has not been reviewed for export out of the United States. A license or license exception may be required for export.
Federal Emergency Management Information System (FEMIS)

Installation Guide for FEMIS v1.5.3

Robert A Burnett
Richard J Carter
Brian J Homer
Daniel M Johnson
Ranata L Johnson

Sharon M Johnson
Robert M Loveall
Alex J Stephan
Blanche M Wood

November 20, 2002

Prepared for the CSEPP Office
United States Army Soldier and Biological Chemical Command
under a Related Services Agreement
with the U.S. Department of Energy
Contract DE-AC06-76RLO 1830

Pacific Northwest National Laboratory
Richland, Washington 99352
Preface

The Federal Emergency Management System (FEMIS) is an emergency management planning and response tool. The following documents were developed to support system users. The audience for each is identified.

This *FEMIS Installation Guide* provides instructions for installing and configuring the FEMIS software package.

The *FEMIS Data Management Guide* provides the information needed to manage the data used to support the administrative, user-environment, database management, and operational capabilities of FEMIS.

The *FEMIS System Administration Guide* provides information on FEMIS System Administrator activities as well as the utilities that are included with FEMIS.

The *FEMIS Release Notes* provide a description of what is new in the release and any information specific to this release that was not available when other documents were published.

The *FEMIS Bill of Materials* defines FEMIS hardware, software, and communication requirements.

The *FEMIS Online Help System* explains how to use the FEMIS program, which is designed to help emergency management personnel plan for and respond to a Chemical Accident or Incident (CAI) Event at a military chemical stockpile. For System and Database Administrators, the Troubleshooting Guide consists of error messages and known problems as well as suggestions to resolve these errors and problems.

---

(a) The FEMIS program is being developed by the Pacific Northwest National Laboratory as part of the US Army Chemical Stockpile Emergency Preparedness Program (CSEPP). Pacific Northwest National Laboratory is operated for the US Department of Energy by Battelle under Contract DE-AC06-76RLO 1830.
Contents

1.0 Overview ................................................................................................................... 1-1
1.1 Point of Contact ....................................................................................................... 1-1
1.2 Document Organization .......................................................................................... 1-1
1.3 Software Products .................................................................................................. 1-2
1.4 Installation ............................................................................................................. 1-2
  1.4.1 Environment .................................................................................................... 1-2
  1.4.2 Storage Requirements ...................................................................................... 1-3
    1.4.2.1 FEMIS Server ................................................................................... 1-3
    1.4.2.2 FEMIS PC ......................................................................................... 1-4
  1.4.3 Pre-Installation Issues ...................................................................................... 1-4
1.5 FEMIS Directory Structures .................................................................................... 1-4

2.0 FEMIS UNIX Installation ............................................................................................ 2-1
2.1 Upgrading from FEMIS v1.5........................................................................................ 2-1
  2.1.1 Removing AutoRecovery ................................................................................ 2-2
  2.1.2 Uninstalling the FEMIS v1.5 Application ....................................................... 2-2
  2.1.3 Removing the Perl Package ............................................................................. 2-3
2.2 Installing and Configuring Solaris ............................................................................ 2-3
  2.2.1 Upgrading to Solaris 8 ..................................................................................... 2-3
    2.2.1.1 New Installation of Solaris 8............................................................. 2-4
    2.2.1.2 Installing Solaris 8 ............................................................................ 2-4
    2.2.1.2 Resizing the Disk Partitions..................................................................... 2-5
  2.2.2 Installing Solaris Patches and Patch Clusters .................................................. 2-7
2.3 New Server Setup for FEMIS v1.5.3 ............................................................................ 2-8
  2.3.1 Automounting and FEMIS .............................................................................. 2-8
    2.3.1.1 Master Map ....................................................................................... 2-8
    2.3.1.2 Indirect Maps .................................................................................... 2-8
    2.3.1.3 Automounter Map Availability ......................................................... 2-9
  2.3.2 Creating FEMIS Accounts on the Server ........................................................ 2-9
2.4 Installing the FEMIS UNIX Software ........................................................................ 2-10
  2.4.1 Installing the Perl Package .............................................................................. 2-10
  2.4.2 Installing the FEMIS Package ......................................................................... 2-11
  2.4.3 Configuring Network Time Protocol (NTP) ................................................... 2-12
2.5 Installing the GIS and Oracle Database Packages ................................................... 2-13
2.6 Preparing the Server for the Upgrade ....................................................................... 2-14
2.7 Installing or Configuring the Oracle Software ........................................................ 2-16
  2.7.1 Preparing the Server for an Oracle v8.1.7 Installation ..................................... 2-16
  2.7.2 Installing the Oracle Software ....................................................................... 2-21
  2.7.3 Applying the Oracle v8.1.7.4 Patches ............................................................. 2-30
  2.7.4 Installing and Using Oracle Documentation................................................... 2-32
  2.7.5 Relinking the Oracle Software ....................................................................... 2-34
2.7.6 Configuring Existing Oracle for Latest Version of FEMIS ................................. 2-34
2.7.7 Modifying the Initialization Parameter ............................................................. 2-36
2.8 Defining the Database Topology ........................................................................... 2-36
2.8.1 Running the Build Topology Program .............................................................. 2-37
2.8.2 Configuring the FEMIS Files .......................................................................... 2-38
2.8.3 Setting Up the EOC DBA Directory ............................................................... 2-40
2.9 Creating or Updating the FEMIS Database ......................................................... 2-40
2.9.1 Creating the Database Schemas ....................................................................... 2-41
2.9.2 Importing the Data ......................................................................................... 2-42
2.9.3 Upgrading the Database Structure from Previous Version of FEMIS ............... 2-43
2.9.4 Creating Objects That Share Data ................................................................... 2-43
2.9.5 Fixing the EOC Table ...................................................................................... 2-44
2.9.6 Setting Up Oracle Backups ............................................................................. 2-45
2.9.7 Starting Replication ......................................................................................... 2-45
2.10 Miscellaneous Configurations ............................................................................ 2-46
2.10.1 Verifying the Configuration Files ................................................................. 2-46
2.10.2 Setting Up femis_event ................................................................................ 2-47
2.10.3 Verifying the /etc/hosts File ......................................................................... 2-48
2.11 Checking the FEMIS Startup ............................................................................. 2-48
2.11.1 Rebooting the Server .................................................................................... 2-48
2.11.2 Verifying the FEMIS Programs ..................................................................... 2-49
2.12 PC Connectivity ................................................................................................. 2-50
2.12.1 Using NFS File Sharing ............................................................................... 2-50
2.12.2 Installing and Configuring Samba ................................................................. 2-51
2.12.2.1 Installing Samba ...................................................................................... 2-51
2.12.2.2 Configuring Samba .................................................................................. 2-52
2.13 Installing FEMIS AutoRecovery System ............................................................ 2-54
2.13.1 Installing AutoRecovery ................................................................................ 2-55
2.13.1 Configuring AutoRecovery .......................................................................... 2-55
2.13.3 Messaging Service ....................................................................................... 2-56
2.13.4 Logging ........................................................................................................ 2-57
2.13.5 Sending E-mail ............................................................................................ 2-57
2.13.6 Running Processes ....................................................................................... 2-58
2.13.7 Monitoring Swap and Disk Space ............................................................... 2-58
2.13.8 Remote Hot Auto-File and Auto-Insert ....................................................... 2-59
2.13.9 Remote Process Monitoring ....................................................................... 2-60
2.13.10 Remote Host Connectivity ........................................................................ 2-60
2.13.11 AutoRecovery’s WatchDog Timeout Parameter ......................................... 2-61
2.13.12 Oracle Job Monitoring Parameters ............................................................ 2-61
2.14 Installing AutoRecovery Web Reporting Application ......................................... 2-62
2.14.1 Software Requirements for AutoRecovery ................................................... 2-62
2.14.2 AutoRecovery Web Reporting Description and Installation ....................... 2-63
2.14.2.1 Removing the AutoRecovery Web Reporting Package ........................... 2-63
2.14.2.2 Installing AutoRecovery Web Reporting ................................................. 2-63
2.14.3 Configuring AutoRecovery Web Reporting ............................................... 2-64
2.14.4 Customizing AutoRecovery Web Reporting

2.14.4.1 Setting the $retainFlag Variable

2.14.4.2 Changing the Refresh Rate

2.14.4.4 Customizing the Apache Web Server

2.15 Installing Web OSB

2.15.1 Installing the Java™ 2 Runtime Environment 1.4.1

2.15.1 Installing the Web OSB Software

2.15.2 Generating Secure Certificate

2.15.3 Setting Up MySQL

2.15.3 Running Web OSB

2.16 Creating a CD to Perform PC Installations of FEMIS

3.0 FEMIS GIS Migration

4.0 FEMIS PC Installation

4.1 Installing the PC COTS

4.1.1 Installing Windows 2000 Service Pack 2 or Windows NT 4.0 Service Pack 6

4.1.2 Installing Oracle Net8 Client v8.1.6 and ODBC Driver v8.1.6.2

4.1.2.1 Installing Oracle Net8 Client v8.1.6

4.1.2.2 Installing Oracle ODBC Driver v8.1.6.2

4.1.3 Installing Microsoft Data Access Components on Windows NT PCs

4.1.4 Installing ArcView GIS v3.1 and v3.1.1 Patch

4.1.4.1 Installing ArcView GIS v3.1

4.1.4.2 Installing ArcView GIS v3.1.1 Patch

4.1.4.3 Creating the ArcView GIS Icon for All Users

4.1.5 Installing Other COTS

4.2 Configuring the FEMIS Setup Program

4.2.1 Connecting the Network Install Drive

4.2.2 Validating the I:\CONFIGD\FSETUP.INI File

4.2.3 Validating the I:\CONFIGD\TNSNAMES.ORA File

4.2.4 Validating the I:\CONFIGD\ADDODBC.BAT File

4.2.5 Validating the I:\CONFIGD\AUTOEXNT.BAT File

4.2.6 Validating the I:\CONFIGD\NTP.CONF File

4.2.7 Updating Files on All PCs Using FUPDATE.BAT

4.2.8 Updating the PC HOSTS Files

4.3 Installing FEMIS Client Software

4.3.1 Preparation

4.3.2 Running the Setup Program

4.3.3 Regenerating the FEMIS GIS Dynamic Themes

4.4 Configuring the PC

4.4.1 Windows XP Only: Configuring FEMIS to Run in Windows 2000 Compatibility Mode

4.4.2 Adding User Accounts to Windows 2000, NT, and XP

4.4.3 Configuring User Accounts
4.4.4 Running the FEMIS FSTARTUP.EXE ........................................................... 4-17
4.4.5 Verifying the Temporary Directory and Environment Variables ............... 4-17
4.4.6 Creating FEMIS Icons ..................................................................................... 4-18
4.4.7 Final Steps for the FEMIS PC Installation and Configuration ....................... 4-18

4.5 Configuring FEMIS for All PCs at an EOC ................................................................. 4-19
4.5.1 Verifying the Zone Name Lookup for EMIS PAR .......................................... 4-19
4.5.2 Using FZONES.EXE Tool .............................................................................. 4-19

4.6 Validating the FEMIS PC Installation .......................................................................... 4-20
4.6.1 One Time at EACH EOC ................................................................................ 4-20
  4.6.1.1 Ensure Exercise #1 Exists .......................................................................... 4-20
  4.6.1.2 Verify Default D2PC Case Exists .............................................................. 4-20
  4.6.1.3 Verify FEMIS/EMIS Data Exchange Interface (DEI) ............................... 4-21
  4.6.1.4 Test the GIS on the Printer ......................................................................... 4-21
  4.6.1.5 Verify User Feedback ................................................................................. 4-21
4.6.2 Perform on EVERY PC .................................................................................... 4-22
  4.6.2.1 Verify the PC Configuration ......................................................................... 4-22
  4.6.2.2 Verify the Network Time Protocol (NTP) Service ................................... 4-22
  4.6.2.3 Verify Login ............................................................................................... 4-23
  4.6.2.4 Verify D2PC ............................................................................................. 4-23
  4.6.2.5 Verify Notification Service ......................................................................... 4-23
  4.6.2.6 Verify GIS ............................................................................................... 4-24
  4.6.2.7 Verify Electronic Planning ......................................................................... 4-25
  4.6.2.8 Verify Help ............................................................................................... 4-25
  4.6.2.9 Verify Printer ............................................................................................ 4-25
  4.6.2.10 Verify FEMIS Tools ................................................................................ 4-25

5.0 Remote Evacuee Registration and Point to Point Protocol .................................................... 5-1
5.1 Remote Evacuee Registration ................................................................................ 5-1
5.2 Installing Remote Evacuee Registration ................................................................. 5-1
5.3 Setting Up Dial-Up Networking ............................................................................. 5-2
  5.3.1 Verifying Modem Installation ........................................................................ 5-2
  5.3.2 Configuring Dial-Up Networking for Windows NT ....................................... 5-2
  5.3.3 Configuring Dial-Up Networking for Windows 2000 ..................................... 5-4
5.4 Verifying Remote Evacuee Registration ................................................................. 5-4

6.0 Standalone Installation of FEMIS v1.5.3 ............................................................................... 6-1
6.1 Disk Space Required ............................................................................................ 6-1
6.2 Removing FEMIS v1.5 Database ............................................................................ 6-1
  6.2.1 Removing Oracle Instance ............................................................................. 6-1
  6.2.2 Removing the Oracle Listener ........................................................................ 6-2
  6.2.3 Removing the Oracle 8.1.6 Software .............................................................. 6-2
6.3 Installing Oracle8i Server or Personal Oracle Edition 8.1.6 or 8.1.7 and Patches ...... 6-2
6.4 Configuring Oracle Network Components ............................................................ 6-4
  6.4.1 Configuring SQLNet ....................................................................................... 6-4
  6.4.2 Setting Up Oracle Listener ............................................................................. 6-4
6.4.3 Enabling NT Authentication ......................................................... 6-5
6.5 Building the Oracle Database ............................................................. 6-6
6.6 Installing PC COTS and FEMIS v1.5.3 .................................................. 6-7
  6.6.1 Uninstalling Previous Version of FEMIS ........................................ 6-7
  6.6.2 Installing FEMIS v1.5.3 ............................................................... 6-8
6.7 Creating FEMIS Database Tablespace ............................................... 6-8
6.8 Putting Data in the Standalone Database ............................................. 6-9
  6.8.1 Obtaining FEMIS Database Exports ............................................. 6-10
  6.8.2 Importing FEMIS Data into the Database ...................................... 6-11
  6.8.3 Updating FEMIS Data into the Database ....................................... 6-12
6.9 Configuring FEMIS Installation for Standalone Database .................... 6-12
  6.9.1 Running SETSTANDALONE.BAT and SETNETWORKED.BAT .......... 6-12
  6.9.2 Testing the Setup ...................................................................... 6-13
6.10 Remote Access Service (NT 4.0 Only) .............................................. 6-13
6.11 Verifying the Standalone Installation ............................................... 6-14
Acronyms and Definitions

APR  Project file format (ArcView GIS)
BOM  Bill of Materials
COTS  Commercial-Off-The-Shelf
CSEPP  Chemical Stockpile Emergency Preparedness Program
D2PC  Chemical wind dispersion model used in FEMIS
DBMS  database management system
DEI  Data Exchange Interface
DNS  Domain Name Services
E-mail  electronic mail
EMIS  Emergency Management Information System
EOC  Emergency Operations Center
FEMIS  Federal Emergency Management Information System
GB  gigabyte–billion bytes
GID  Group Identification number
GIS  geographic information system
GMT  Greenwich Mean Time
HCL  Hardware Compatibility List
IP  Internet Protocol
KB  kilobyte–thousand bytes
LAN  local area network
MB  megabyte–million bytes
MDAC  Microsoft Data Access Components
Met  meteorological
NFS  Network File System
NTP  Network Time Protocol
ODBC  Open Data Base Connectivity
PC  personal computer
PPP  Point to Point Protocol
PNNL  Pacific Northwest National Laboratory
RAM  Random Access Memory
RAS  Remote Access Service
RDBMS  relational database management system
RER  Remote Evacuee Registration
SBCCOM  US Army Soldier and Biological Chemical Command
SMB  Service Message Block
SMTP  Simple Mail Transfer Protocol
SQL  Structured Query Language
SQL script  Sequence of SQL statements that perform database operations
TCP/IP  Transmission Control Protocol/Internet Protocol
TNS  Transparent Network Substrate
UNIX  Generic name for the Server Operating System
WAN        wide area network
WINS       Windows Internet Name Service
Windows NT Microsoft Network Operating System for Workstations
Windows 2000 Microsoft Operating System
1.0 Overview

The Federal Emergency Management Information System (FEMIS©)(a) is an emergency management planning and response tool that was developed by the Pacific Northwest National Laboratory(b) (PNNL) under the direction of the US Army Soldier and Biological Chemical Command (SBCCOM). The Installation Guide for FEMIS Version 1.5.3 provides instructions for installing the FEMIS software package as well as the Commercial-Off-The-Shelf (COTS) software applications that are necessary for FEMIS to operate.

1.1 Point of Contact

We encourage you to contact us with suggestions or to ask questions. You can contact us by mail, telephone, or E-mail:

Julie Raye Dunkle  
Pacific Northwest National Laboratory  
P.O. Box 999, MS K7-28  
Richland, WA  99352  
Telephone:  (509) 375-2245  
E-Mail address:  julie.dunkle@pnl.gov

1.2 Document Organization

This document is organized into six sections that describe the details of the installing and configuring FEMIS.

Section 1.0 – Overview – describes the point of contact, document organization, software products, installation environment and storage requirements, and FEMIS directory structures.

Section 2.0 – FEMIS UNIX Installation – describes installing the UNIX operating system and UNIX-based COTS software, installing the FEMIS UNIX software, and creating the FEMIS database.

Section 3.0 – FEMIS GIS Migration – discusses the GIS migration from FEMIS v1.5 to v1.5.3.

Section 4.0 – FEMIS PC Installation – discusses the installation, configuration, and validation of the FEMIS application on client PCs.

(a) FEMIS software was copyrighted in 1995 by Battelle Memorial Institute.
(b) Pacific Northwest National Laboratory is operated for the US Department of Energy by Battelle Memorial Institute under Contract DE-AC06-76RLO 1830.
Section 5.0 – Remote Evacuee Registration and Point-to-Point Protocol – discusses the Remote Evacuee Registration feature and establishing and setting up the Point-to-Point (PPP)

Section 6.0 – Stand-Alone Installation of FEMIS v1.5.3 – discusses the installation configuration, and validation of the FEMIS Stand-Alone application.

1.3 Software Products

FEMIS integrates the following COTS software products.

<table>
<thead>
<tr>
<th>Software Application</th>
<th>Software Company</th>
</tr>
</thead>
<tbody>
<tr>
<td>ArcView GIS</td>
<td>Environmental Systems Research Institute, Inc. (ESRI)</td>
</tr>
<tr>
<td>Microsoft Windows 2000 Service Pack 2 or</td>
<td>Microsoft Corporation</td>
</tr>
<tr>
<td>Microsoft Windows NT 4.0 Service Pack 6</td>
<td></td>
</tr>
<tr>
<td>Oracle, Net8, and ODBC Driver</td>
<td>Oracle Corporation</td>
</tr>
<tr>
<td>Samba</td>
<td>Samba Team (open source project)</td>
</tr>
<tr>
<td>Solaris</td>
<td>Sun Microsystems, Inc.</td>
</tr>
</tbody>
</table>

FEMIS integrates the following government-furnished software products.

D2PC (February 2000) US Army SBCCOM

PARDOS v3.1 (May 1997) US Army SBCCOM

1.4 Installation

This section discusses the FEMIS environment and storage requirements.

1.4.1 Environment

For FEMIS to operate correctly, the first step is to install all of the COTS software, including Oracle Release v8.1.6 or v8.1.7 on your UNIX system. FEMIS will not operate correctly if versions of the COTS software other than those specified in the Bill of Materials (BOM) for FEMIS Version 1.5 and in the Release Notes for v1.5.3 are installed. The Release Notes for v1.5.3 list any changes for hardware and software since the Bill of Materials (BOM) for FEMIS Version 1.5 was released.

FEMIS uses Samba as its Network File System (NFS) for PC network communications. Samba has been tested by PNNL and is compatible with FEMIS requirements. Although other vendors may claim to offer a fully standard NFS, or Service Message Block (SMB) emulation, PNNL has not verified and tested any other NFS/SMB configurations for PCs, and thus, cannot endorse such installations.
1.4.2 Storage Requirements

The FEMIS application requires disk space on both the client and server machines. PNNL has estimated the disk space requirements for each.

1.4.2.1 FEMIS Server

Disk space on the FEMIS server is used for:

- Server software (such as, the RDBMS [relational database management system]).
- FEMIS application.
- FEMIS server utilities (notification, database monitor, replication).
- EOC databases (including archived and historic data).
- Storage of the FEMIS COTS software and the original GIS maps.

The above items can require 15+ GB of storage to properly support FEMIS.

There are two sources of disk space associated with a FEMIS server as defined by the Bill of Materials (BOM) for FEMIS Version 1.5:

1. System disk(s) resident in the Sun Server.
2. Sun SPARCstorage Array connected to the Sun Server.

As stated in the Bill of Materials (BOM) for FEMIS Version 1.5, PNNL recommends that the FEMIS storage requirement be fulfilled by using arrayed storage disks (StorEdge Array, or an array-like cage system) to ensure that speed and reliability are provided to the FEMIS operational system. PNNL expects the FEMIS application to be placed in its entirety on the arrayed storage disks, which will enable the System Administrators (and PNNL) to better manage the FEMIS product and the EOC databases. PNNL expects the Sun SPARCstorage Array to be reserved solely for FEMIS use.

The system disks are not directly used by FEMIS. The disks are used for the operating system and the supporting applications. PNNL estimates that approximately 2 GB of system disk space will be used for the operating system and swap space. Additional system disk space should be used at the System Administrator’s discretion.
1.4.2.2 FEMIS PC

Disk space on the client PC is required for the following:

- COTS software needed for FEMIS (Windows 2000 or NT 4.0, ArcView GIS, Oracle Net8, and other supporting applications).
- FEMIS application.
- Site-specific GIS maps.

The amount of space required by the FEMIS application and supporting software will vary depending on the size of the GIS the user chooses to install. A FEMIS with a medium size GIS installation requires approximately 900 MB of disk space, COTS included.

1.4.3 Pre-installation Issues

Before you proceed with the installation of FEMIS v1.5.3, the following are pre-installation issues that should be addressed.

- Remove obsolete data such as unneeded exercises and obsolete user accounts.
- Remove obsolete D2PC archive cases.
- Clean up any obsolete server data such as obsolete versions of FEMIS packages.
- Make sure your system has been backed up.

1.5 FEMIS Directory Structures

The following figures illustrate the FEMIS directory structure on the UNIX server and the directory structure for an emergency management PC workstation.
UNIX Server FEMIS Directory Structure
FEMIS GIS APR and multiple theme directories and files can be installed on a different drive and/or directory.
2.0 FEMIS UNIX Installation

The UNIX server is the primary data and information storage and distribution component. Its primary software elements consist of the Oracle database management system (DBMS); the Notification Service; the FEMIS/EMIS Data Exchange Interface (DEI); and the sockets communications service.

The programs discussed require the UNIX environment on a Sun computer running Solaris 7 or 8.

The FEMIS UNIX software installation consists of 10 major parts:

1. Upgrading from FEMIS v1.5
2. Installing and configuring Solaris
3. Setting up a new server for FEMIS v1.5.3
4. Installing the FEMIS UNIX software
5. Installing and configuring server software
6. Checking the FEMIS startup
7. Setting up PC connectivity
8. Installing FEMIS AutoRecovery system
9. Installing AutoRecovery Web Reporting application
10. Installing Web OSB.

The release media consists of files distributed on CDs. The release material contains the necessary scripts and data to perform an initial installation or to upgrade existing FEMIS software to the current version. The Release Notes should be read before proceeding with the UNIX installation.

The FEMIS v1.5.3 media consists of the following:

- COTS CD
- FEMIS application CD
- Suite of FEMIS documentation.

In addition, you will need Sun Solaris 8 media if you are upgrading your operating system and Oracle media if you are upgrading/installing Oracle 8.1.7.

This guide is written assuming that your Emergency Operations Center (EOC) is using local host network files. If your EOC is using some other facility, i.e., NIS/NIS+, then those facility-specific commands must be used.

2.1 Upgrading from FEMIS v1.5

Several tasks need to be performed on the FEMIS server prior to installing FEMIS v1.5.3 software. Complete the following only if you are upgrading the server from FEMIS 1.5.
2.1.1 Removing AutoRecovery

AutoRecovery must be removed to prevent error messages during the upgrade process. You may wish to save the /opt/local/bin/femis_watch.conf file for configuration of the new AutoRecovery package later. If the /opt/local/bin/femis_watch.conf is saved for later, please be aware that it is not a drop-in replacement for the femis_watch.conf file in the new package. It is to be used for reference only.

To remove AutoRecovery, complete the following step.

1. Login as root, and enter the following command:

   # pkgrm FEMISar

2.1.2 Uninstalling the FEMIS 1.5 Application

To prepare for the new version (an upgrade) of FEMIS, complete the following steps to check for the existence of required user accounts, backup the FEMIS directory, and remove the old FEMIS installation:

1. Login as root.

2. Copy the site-specific directories to another location using the following commands:

   Note: The <backup> directory in the following represents a file system of your choice on this server where you can save a copy of the files. You will need to restore files from this directory when you complete Section 2.4.2, Installing the FEMIS Package.

   # mkdir <backupdir>
   # cd /home/femis
   # tar cf - configd etc .login | (cd <backupdir>; tar xf -)

3. Remove the FEMIS application by entering the following:

   # pkgrm FEMIS

   You may see warning messages about package dependencies similar to the following:

   ## Verifying package dependencies.
   WARNING: The <FEMISgs> package depends on the package currently being removed.
   WARNING: The <FEMISdb> package depends on the package currently being removed.
   Dependency checking failed.
Do you want to continue with the removal of this package [y,n,?,q]

If this message appears, answer Yes by typing a y and pressing Enter.

4. Delete the etc and configd directories in /home/femis directory.

   # rm -r /home/femis/configd (This directory may not exist).
   # rm -r /home/femis/etc

### 2.1.3 Removing the Perl Package

To remove the Perl package, complete the following steps:

1. Login as root.

2. Enter the following:

   ```sh
   # pkgrm Perl
   ```

3. Select y to continue when the following prompt displays: Do you want to remove this package?

4. Also select y for the prompt: Removing installed package instance <Perl>. This package contains scripts that will be executed with super-user permission during the process of removing this package. Do you want to continue with the removal of this package [y,n,?,q].

### 2.2 Installing and Configuring Solaris

Installing and configuring Solaris may consist of upgrading to Solaris 8 and installing patches.

#### 2.2.1 Upgrading to Solaris 8

**Note:** If you are upgrading a FEMIS 1.5 server from Solaris 7 to Solaris 8 or moving to a new server, then use this section.

For those EOCs desiring to do new installs of Solaris (rather than upgrading the operating system) and upgrade the current FEMIS installation, steps must be taken prior to the operating system installation to allow the upgrading of FEMIS later.

If any of the FEMIS or Oracle directories will be affected by the new installation, they must be preserved prior to the new installation of Solaris 8 and then restored to the system after the Solaris 8 install so the FEMIS upgrade can be completed.
Those EOCs using the Sun Volume Manager or Disksuite software to manage disk arrays, that wish to maintain array configuration and data throughout the operating system (OS) upgrade, may need to follow special instructions PRIOR to upgrading Solaris.

For Sun Disksuite, Version 4.2.1 is required for Solaris 8. Consult your vendor-supplied documentation prior to the operating system upgrade.

Follow the instructions included with the Solaris 8 documentation along with additional information provided below. If the quantity of server customizations is considered large, the upgrade option is recommended. If server clean up is preferred, then the new install option can be taken instead of upgrading an existing installation.

### 2.2.1.1 New Installation of Solaris 8

To continue preparing your system for a new installation of Solaris or moving to a new server and upgrading of your current version of FEMIS, complete the following steps:

1. Complete both Sections 2.6, Preparing the Server for the Upgrade prior to doing a new installation of Solaris 8 on your current FEMIS server. Verify the exports have been created successfully in the `/home/femis/database/exports/<site>` directory.

2. Do a full system backup to tape. You may need to restore your disks data if you have to reinstall disk management software. You must ensure the `/home/femis` directory will be preserved or data could be lost.

3. Complete an Initial Solaris 8 installation using Section 2.2.1.2, Installing Solaris 8 or move your `/home/femis` directory to the new server.

Recreate users and groups using `group`, `passwd`, and `shadow` files from the `/etc` directory backup. You can also restore the `auto_master`, `auto_home`, and `auto_apps` to preserve automount configuration. These will save time when you are completing the steps in Section 2.3, New Server Setup for FEMIS v1.5.3. You may also wish to restore the `smb.conf` and `smbpasswd` when Samba is installed.

### 2.2.1.2 Installing Solaris 8

Use the following method for disk partitioning and preserving data while running the installation/upgrade program for Solaris 8.
1. Use `ufsadm` to backup your file systems relating to the operating system prior to upgrading.

2. Edit the `/etc/vfstab` file and comment out any entries relating to swap files (not swap partitions) and storage array file systems.

3. Boot the Solaris 8 CD-ROM that launches the interactive installer.

4. Follow the prompts and/or instructions to install/upgrade. Select `no network` unless you are upgrading from a remote install/jumpstart server or booting from the network, then the server needs to be considered `networked`.

5. Check if the `64-bit` button has been selected. If so, this indicates your system can support running the 64-bit kernel. It will not be selected on systems where greater performance may not be realized, and it will be grayed out (not selectable) on systems where the 64-bit kernel cannot be run at all. Selection, as allowed, is up to the installer.

Selecting the 64-bit support only means that the 64-bit support (i.e., for 64-bit application development) will be installed. Even with 64-bit kernel support installed, the default kernel booted will be the one supported by your hardware (as determined by the bootstrap software).

If the current partitions are sized correctly for Solaris 8 and the requested packages, then the installation will complete without interruption.

### 2.2.1.3 Resizing the Disk Partitions

If disk partitions are not large enough according to the interactive installer program’s calculations, then the `More Space Needed` window will display.

1. Select the `Auto-layout` button, and allow it to calculate the necessary new sizes. If `Auto-layout` requires constraints to be changed, continue using it as a tool to plan the correct layout and sizes.

   **Note:** Do not allow Auto-layout to make partition backups and new layouts.

2. Make a note of the current partition size(s) and recommended new size(s). Exit the interactive installation program at this time.

3. Open a command window and dismount the affected volumes that were mounted by installation program.

4. Repartition and resize the disk layout or partitions using the command-line format tool (see the man page on `format`) as recommended by the previously suggested sizes in Step 1.

5. Adjust the swap partition, if desired.
6. Create new file systems on the affected partitions and remount the new partitions back on to the installation file system.

7. Use `ufsrestore -rf <dumpfile>` to restore the affected file systems (backup previously created) onto the new disk partitions.

   Mount or go to the partition containing the actual system’s root file system. Edit the `vfstab` file to reflect any device changes made in Steps 3–6.

8. Remove any `restoresymtable` files created by `ufsrestore`, and dismount all file systems under the `/a` path.

9. Right click in the background workspace area, and select Restart Install. Proceed through the installation process as prompted. You may have to start from the beginning again; however, if disk space partitions were correctly assigned, the upgrade should continue without interruption.

Separate partitions are not absolutely necessary for `/`, `/usr`, `/var`, and `/opt`. They can be combined into one `/partition or split into various subsets. The `/usr` is static and does not usually contain dynamic data; `/var` is used for logging and temporary areas, so it can grow considerably; and `/opt` is for optional software package installations, so its size depends on the planned usage of the server.

The following packages are not functionally required in case of space limitations:

- Packages pertaining to manuals, especially developer manuals and/or software.
- DHCP server if not used by clients.
- Developer profiled libraries.
- Unnecessary device drivers (this may not be easily determined, use discretion).
- Documentation tools.
- International locale and font support.
- Font server software (if not used).
- NIS support (if not used – basic packages can not be deselected).
- Demos (binaries and software).
- PCMCIA support (if not used).
- Point-to-point protocol (if not used).
- Power management utilities (if not used).
- Programming tools and libraries.
- WEBNFS (if not used).
- Others (site dependant and based on Installer experience).

All packages not installed at upgrade time can be installed later if desired using a variety of package management tools/software.
2.2.2 Installing Solaris Patches and Patch Clusters

All servers, even if no operating system changes were made, should maintain current patches.

Solaris Versions, Maintenance Updates, and Patch Clusters

FEMIS was not tested on any particular Maintenance Update of Solaris. If a site desires to install a current stable Maintenance Update, conflicts with Solaris Maintenance Updates and FEMIS are not anticipated. Because all operating systems require patches to improve security and fix bugs, PNNL strongly recommends installing Sun’s Solaris patch clusters. For more information on patch clusters, consult Sun Solaris documentation, specifically installation release notes and/or Sun’s Web site (http://sunsolve.sun.com) for further information. The patch cluster is strongly recommended as a minimum patch set for each system and periodic refresh installations of the patch cluster are recommended for security enhancements.

The following patches must be installed on Solaris 7 systems. Use the following command to check if the required patches have been installed:

```
showrev -p | grep <patch number>
```

- 106541 – requires quiescent system
- 107171-09 – is necessary to correct certain patch order problems when installing cluster patches.

These patches will be included in the patch cluster and do not have to be individually installed. To install the latest patch cluster, complete the following steps:

1. Download the latest Solaris 7 or 8 Patch Cluster from Sun at

   http://sunsolve.sun.com

2. Create the Solaris 7 or 8 recommended directory by uncompressing the downloaded file.

   Example: #unzip 8_Recommended.zip

3. Check the CLUSTER_README file for precautions and cluster installation instructions. The patch cluster can be installed from the Solaris 7 or 8 recommended directory by issuing this command:

   #./install_cluster

You can defer the reboot of your system until after FEMIS v1.5.3 package is installed if you are upgrading from 1.4.7.2 on the server. Otherwise, you should reboot after the patch or patch cluster is installed.

The patch cluster directory and zip file can then be removed.
2.3 New Server Setup for FEMIS v1.5.3

Complete the following sections if FEMIS has not been previously installed.

2.3.1 Automounting and FEMIS

**Note:** Using the automounter is optional but strongly recommended.

Solaris uses the automounter to automatically and transparently mount file system resources for both home and application directories. The automounter uses a series of maps to define the file resources to be mounted. Setting up the automounter consists of defining the maps and starting the automounter program.

2.3.1.1 Master Map

The master map is located at `/etc/auto_master`. This file provides a list of all maps on the system. It is read by the automounter daemon at system startup. The map for FEMIS looks similar to the following.

```
/net  -hosts  -nosuid,nobrowse
/home auto_home
/apps auto_apps
/xfn   -xfn
```

2.3.1.2 Indirect Maps

Indirect maps are used to mount file resources under a common directory. FEMIS needs two indirect maps for automounting: 1) `/etc/auto_apps` and 2) `/etc/auto_home`. The map, `/etc/auto_home`, contains the entries of the UNIX user login accounts to be mounted under `/home`. The indirect map for `/etc/auto_home` must look similar to the following.

**Note:** The current site map should list users and directory paths at your site. Remember to replace `system#` with the name of your server. The hostname `localhost` may also be used as the server name for directory structures located on the same server\(^{(a)}\).

```
femis -intr,rw,nosuid system1:/files3/home: &
femx -intr,rw,nosuid system1:/files3/home: &
usera -intr,rw,nosuid system1:/files5/home: &
userb -intr,rw,nosuid system1:/files5/home: &
userc -intr,rw,nosuid system1:/files5/home: &
```

\(^{(a)}\) The term `localhost` must be used carefully when the automount map is distributed via NIS/NIS+ in a multiple server configuration, or where PC clients can interpret NIS automount map information.
userd -intr,rw,nosuid system1:/files5/home:&
usere -intr,rw,nosuid system2:/files5/home:&

The /etc/auto_home map gives us a consistent view of home directories across a network. All home directories, whether remote or local, are mounted under each server’s /home directory. As an example, a UNIX account for usere, which has a directory on system2 on partition /files5/home/usere, is mounted at /home/usere on the current system.

The indirect map for /etc/auto_apps should look similar to following.

oracle -intr,rw,nosuid system1:/files2/app:&

### 2.3.1.3 Automounter Map Availability

Changes to indirect maps are available right away. Changes to the /etc/auto_master are effective only by restarting the automount daemon.

```
# /etc/init.d/autofs stop
# /etc/init.d/autofs start
```

**Note:** Automount cannot reflect new file systems in cases where the currently automounted file system is moved out from underneath an actively automounted file system in lieu of a replacement file system. To replace a mapped automount file system, make sure no processes are active in the automount tree by using `fuser -nc <auto_mount_path>`, and that automount has released the mount point before changing an automounted file system.

### 2.3.2 Creating FEMIS Accounts on the Server

You will need to create the femis UNIX account on the server prior to the FEMIS package installation.

1. Login as `root`.
2. Create the following accounts (numeric IDs are for example only):

   ```
   # /usr/sbin/groupadd -g 30510 femisrun
   # /usr/sbin/useradd -u 30508 -g femisrun -c "FEMIS Account" -d /home/femis -s /bin/csh femis
   
   If you are running DEI, create the following account **only on the onpost server**:
   
   ```
   # /usr/sbin/useradd -u 30509 -g femisrun -c "FEMX Account" -d /home/femx -s /bin/csh femx
   ```
3. Create the appropriate home directories for the newly created accounts. Make sure each directory has the correct owner and group.

```
# mkdir -p /<file system>/home/femis
# chown femis:femisrun /<file system>/home/femis
```

**Note:** Creating the `femx` directory should only be done on the onpost server.

```
# mkdir -p /<file system>/home/femx
# chown femx:femisrun /<file system>/home/femx
```

4. Set the account passwords.

```
# passwd femis
# passwd femx  (if it exists)
```

5. Edit `/etc/auto_home` and add entries for both the `femis` and `femx` accounts, if your system uses automount maps. The entries must look similar to the following:

```
femis   -intr,rw,nosuid  systemname:path:&
femx   -intr,rw,nosuid  systemname:path:&
```

Example:

```
femis   -intr,rw,nosuid  mysystem:/<file system>/home:&
femx   -intr,rw,nosuid  mysystem:/<file system>/home:&
```

The colon and ampersand (:`&`) in the above examples may also have a `/<map_key>` instead. Either method of map specification is fine.

See Section 2.3.1, Automounting and FEMIS, for more information.

### 2.4 Installing the FEMIS UNIX Software

**Note:** The following sections must be performed on every server in the site’s configuration.

#### 2.4.1 Installing the Perl Package

To install Perl, complete the following steps:

1. Login as root, and insert the FEMIS application CD into the CD-ROM drive.
2. Run the pkgadd utility to install the Perl package.

```bash
# pkgadd -d /cdrom/cdrom0 Perl
```

3. Select `y` to continue if the following prompt displays: The following files are already installed on the system and are being used by another package: `/opt/local/bin <attribute change only> *` - conflict with a file which does not belong to any package. Do you want to install these conflicting files?

4. Select `y` to continue when the following prompt displays: This package contains scripts which will be executed with super-user permission during the process of installing this package.

5. Use `pkgchk` to verify that Perl installed correctly.

```bash
# pkgchk -n Perl
```

**Note:** The packages installed successfully if no error output is displayed.

### 2.4.2 Installing the FEMIS Package

To install the FEMIS package, complete the following steps:

1. Login as `root`, insert the FEMIS application CD into the CD-ROM drive.

2. Enter the following command to mount the FEMIS installation directory, if you are using the automounter:

```bash
# cd /home/femis
```

3. Run the following command to install the FEMIS package:

```bash
# pkgadd -d /cdrom/cdrom0 FEMIS
```

4. Answer the questions as prompted by the package installation program.

5. Use `pkgchk` to verify the FEMIS package has installed correctly after the FEMIS application has been installed.

```bash
# pkgchk -n FEMIS
```

If no errors are reported, then the package installed correctly.

6. Restore the `eocnum.dat` from the backup you made in Section 2.1.2, Uninstalling the FEMIS 1.5 Application (Step 2). If this is a new installation, skip this step.

```bash
# cp -p <backupdir>/etc/eocnum.dat /home/femis/etc
```
2.4.3 Configuring Network Time Protocol (NTP)

**Note:** You do not need to configure NTP if you already have the Solaris version of NTP configured from FEMIS 1.5 and did not do a new Solaris 8 installation.

NTP is included with the Solaris operating system. To configure NTP complete the following steps:

1. Login as root.

2. Enter the following:
   
   cd /home/femis/install

3. Run the following script to configure an ntp.conf file in the /etc/inet directory and start the NTP daemon (xntpd). You may need information from the ntp.conf.old file in the /etc directory before running this script. Then you may remove the ntp.conf.old file.
   
   sh ntp_config

   The installation will ask if the server will get time from another server; select y if Yes, otherwise select n.

   If you selected y above, the installation will prompt for the NTP server’s Internet Protocol (IP) address. Make sure the NTP server is accessible (available on the network) as the installation will attempt to ping the NTP server.

   The message: “/etc/inet/ntp.conf already exists. It will not be reconfigured,” means the script found an existing /etc/inet/ntp.conf file and exited without making any changes to the /etc/inet/ntp.conf file.

4. Check your NTP configuration.
   
   ntptrace <servername>

   It may take awhile before your output shows a traceback other than a “timeout”. Once the traceback information displays correctly, NTP is configured.

For additional information on NTP see the Section 10.0, Server Network Time Protocol (NTP) Set Up, in the *FEMIS System Administration Guide Version 1.5.3*.

**Note:** If the server is not synching with any time source, you must change the file so NTP will work. See Section 10.0, Server Network Time Protocol (NTP) Set Up, in the *FEMIS System Administration Guide Version 1.5.3* for instructions.
2.5 Installing the GIS and Oracle Database Packages

Note: If this is a new install, complete this section. If you are upgrading the existing GIS and database skip this step.

The FEMIS GIS and/or database packages are available from PNNL and may be distributed on CD-ROM. Packages installed from CD-ROM do not need to be spooled to disk and can be installed directly from the CD. Refer to specific instructions that will be distributed with the media because the GIS package will require multiple CDs.

To install the FEMIS GIS and database package from tape, complete the following steps:

1. Insert the GIS and database tape into the tape drive.

   This installation may require considerable disk space for a spool directory. To create a temporary spool directory, run the following commands but only if you did not create the spool when you installed the FEMIS package.

   # mkdir /<dir>/spool

   Spool the installation package from the 8mm tape using the Solaris software installation utility.

   # pkgadd -s /<dir>/spool -d /dev/rmt/??

   where ?? is the device number of the tape drive. Select the packages desired, and run the pkgadd utility to install the GIS and database packages.

   # pkgadd -d /<dir>/spool

2. Select the numbers corresponding to your site’s GIS and database using commas as separators.

3. Select q to quit, after the GIS and database have been installed.

4. Use pkgchk to verify the packages were installed correctly.

   # pkgchk -n <package name>

   No output is expected as a result of this command.

5. Remove the spool directory.

   # rm -r /<dir>/spool

6. Remove the tape from the drive.
Verifying the GIS.INI Files on the Server

If a common set of GIS files is being used by all EOC, this step can be skipped. If some or all of the EOCs are using a GIS that is customized for that EOC, an extra step is necessary to ensure that the correct set of INI files are in place before installing FEMIS on the PCs.

The /home/femis/gis/<site_code>_apr directory on the server is where Setup will look for the INI files. This directory has subdirectories for each EOC that is using a customized GIS that contains the three INI files. Before running Setup on the PCs, log onto the server as the user femis, and copy the files from the subdirectory for your EOC to the /home/femis/gis/<site_code>_apr directory. For example, at Maryland State EMA, you would log onto the server and enter the commands:

```
% cd /home/femis/gis/sbcc_apr
% cp ./mema/* ./
```

2.6 Preparing the Server for the Upgrade

In FEMIS, database topologies are defined either as NxN or NxM, which are number pairs that indicate the number of EOC databases and the number of servers. For example, a 3x3 (or NxN) configuration indicates three EOCs on three servers. Likewise, an 8x4 (or NxM) configuration represents eight EOCs on four servers.

On each server, Oracle schemas are created to store the EOC data. The schemas are broken into two groups: 1) data owner schema or 2) snapshot owner schema. A data owner schema has the database tables that store the data for an EOC. A snapshot owner schema has a set of specialized snapshot tables that are created to support the replication of data.

On every NxN configuration, there is exactly one data owner and N-1 snapshot owners per server. By definition, NxM configurations have more than one data owner on at least one of the M servers in the configuration.

The terms data owner and snapshot owner will be used frequently throughout this section and as the installation is performed. You will need to know which server has which data owner within your configuration.

To properly complete the installation for your site, follow the instructions in the Section 2.5, Installing the GIS and Oracle Database through Section 2.9.6, Setting Up the Oracle Backups.

To prepare your server for the upgrade, complete the following steps to drop database objects and export data owners.

**Note:** If you have v1.5 of FEMIS installed, complete this section.
1. Cycle the database instance on all servers to ensure that every user has been disconnected from the database.

   As **oracle** user on every server:

   % svrmgrl
   SVRMGR>connect internal (system response should be Connected.)
   SVRMGR>shutdown immediate (system response should be Oracle instance shut down.)
   SVRMGR>startup (system response should be “Oracle instance started...”)
   SVRMGR>exit

2. Run the master drop script to drop the non-table database objects. If you are upgrading on an NxM or NxN system, the master drop script will drop objects from all servers in the configuration and only needs to be performed on one server.

   As **femis** user:

   % cd /home/femis/database/eocdba
   % sqlplus /nologin
   SQL> @master_dr

   Be prepared to enter passwords for the Oracle Sys accounts.

   Watch the progress of the **master_dr.sql** script. If you do not have any problems, press **Enter** after each **Pause** statement is encountered. Near the end of the script, you will be given the option to drop non-data owners and the administrator schemas. Choose the option by hitting the **Enter** key.

3. Make a cold database backup in case problems occur in the upgrade.

   As **oracle** user on every server:

   % cd /apps/oracle/admin
   % ./dbbackup_cron -cold

4. Perform an export of all FEMIS data owners on every server. The export files created in this step will be re-imported later so it is very important to perform this correctly. If you are not going to reinstall or upgrade Oracle, then export this data as a safety precaution.

   **Note:** To determine the “data owner” schemas, review the /<backup directory>/etc/eoclist.dat file. The first column lists all EOCs for your site. The third column lists the server where the EOC is a data owner.
As femis user:

% cd $/home/femis/database/exports/<site name>
% exp userid=<EOC_name>/data owner password> file=<EOC_name>_<date (yyyymmdd)}.dmp log=<EOC_name>_<date>.log

Repeat this export command for each data owner schema that resides on this server. For example, if you have eight EOCs at your site but only three EOC databases reside on this server, then you will make three database exports on this server. You must then export the remaining data owners from each of the other servers in the configuration.

2.7 Installing or Configuring the Oracle Software

Note: If you have Oracle 8.1.6 installed and will not be installing Oracle 8.1.7, then proceed to Section 2.7.6, Configuring Existing Oracle for Latest Version of FEMIS.

If you are installing Oracle v8.1.7 and the 8.1.7.4 patch, the following **must be performed on every server in the site’s configuration.**

**Oracle requires a minimum of 128 MB of RAM.** If you do not have this much memory installed, **do not attempt** to install Oracle. To check the amount of memory available, issue the following command:

```bash
# /usr/sbin/prtconf | grep size
```

Before beginning the Oracle v8.1.7 installation, you should review the installation guide provided by Oracle, *Oracle8i Installation Guide Release 2 (8.1.7) for Sun SPARC Solaris.* The following steps are required to install Oracle and identify specific parameter settings required by FEMIS.

2.7.1 Preparing the Server for an Oracle v8.1.7 Installation

To prepare the server for an Oracle installation, complete the following steps:

1. **Login as oracle user and enter the following to shutdown the old database and the listener.**

   ```bash
   % svrmgrl
   SVRMGR>connect internal
   SVRMGR>shutdown immediate
   SVRMGR>exit
   % lsnrctl
   LSNRCTL>stop
   LSNRCTL>exit
   ```
**Note:** Confirm that all Oracle Instances (some facilities have multiple instances running) have been shutdown. Use the `ps` and `grep` commands to identify the Oracle processes.

For example: `ps -ef | grep oracle | sort`

If other instances are running, change the `ORACLE_SID` environment variable to point to these and repeat the commands above to shutdown these instances.

2. Comment out all database instances in the `/var/opt/oracle/oratab` file. To comment out a line in this file, add a pound sign (`#`) at the beginning of the line with an editor. This is important; otherwise you will have difficulty in creating a new instance with the same name as the old one.

   `% cd /var/opt/oracle%
   % vi oratab`

3. Select a drive on which to install Oracle 8.1.7, which will be referred to as `<install_drive>` in the following instructions. This drive must have a minimum of 1000 MB available.

   Select two additional drives on which to locate the FEMIS database files, which will be referred to as `<driveA>` and `<driveB>`.

   Each of these drives should have a minimum of 500 MB available.

   The following command will allow you to view the drives and their available storage space.

   `% df -k -F ufs`

   It is recommended that all drives used are RAID volumes. For complete information on server internal mass storage, see the *Bill of Materials (BOM) for FEMIS Version 1.5*, which is posted on the FEMIS web site (http://www.pnl.gov/femis and the Release Notes for Version 1.5.3).

   **Note:** If Oracle 8.1.6 is installed and is not being upgraded, then use the directories that already exist.

4. Login in as root.

   Check if an oracle account already exists.

   `# logins -m -l oracle`

   The following is an example of output from the above command.

<table>
<thead>
<tr>
<th>oracle</th>
<th>300</th>
<th>dba</th>
<th>26001</th>
<th>Oracle Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>oinstall</td>
<td>26002</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
If the line does not exist, use the following command to add the oracle user assigned to the dba group:

```
# /usr/sbin/useradd -u 300 -G oinstall -c "Oracle Account" -d
/<install_drive>/app/oracle -s /bin/csh oracle
```

Set the Oracle password to your desired value using the UNIX passwd process.

```
# passwd oracle
```

If an Oracle account already exists, verify that the login directory is correct. Change the password, if desired.

Check if there is a group named dba and a group named oinstall in the /etc/group file. Also determine if oracle is a member of the dba and the oinstall group.

```
# egrep '^dba|^oinstall' /etc/group
```

Verify that output from the above command resembles the following:

```
dba:*:26001:oracle
oinstall:*:26002:oracle
```

If you do not get the output above, use the following command to add a dba and/or an oinstall group, as necessary:

```
# /usr/sbin/groupadd -g 26001 dba
# /usr/sbin/groupadd -g 26002 oinstall
```

**Note:** You may select any number for your group identification (GID) number that is not currently being used. Be sure to check for the existence of a GID in both the /etc/group file and NIS+ (if your site uses NIS+).

Edit the /etc/group file, and add oracle to the group oinstall, as necessary.

5. Create the following directories, if they do not already exist.

```
% su -
# mkdir -p /<install_drive>/app/oracle
# chown oracle:dba /<install_drive>/app/oracle
# chmod 755 /<install_drive>/app/oracle
# mkdir -p /<driveA>/app/oracle
# chown oracle:dba /<driveA>/app/oracle
# chmod 755 /<driveA>/app/oracle
# mkdir -p /<driveB>/app/oracle
# chown oracle:dba /<driveB>/app/oracle
# chmod 755 /<driveB>/app/oracle
```
6. Set up the automount map. If your system uses automount maps, edit `/etc/auto_apps`, and add the following line:

```bash
oracle   -intr,rw,nosuid   systemname:path
```

Example:

```bash
oracle   -intr,rw,nosuid Mysystem:/<install_drive>/app/oracle
```

See Section 2.3.1, Automounting and FEMIS, for more information.

7. Make sure there is adequate shared memory. Examine the following parameters in the `/etc/system` file.

```bash
set shmsys:shminfo_shmmax=4294967295
set shmsys:shminfo_shmin=1
set shmsys:shminfo_shmmni=400
set shmsys:shminfo_shmseg=36
set semsys:seminfo_semmni=256
set semsys:seminfo_semmsl=600
set semsys:seminfo_semmns=1800
set semsys:seminfo_semopm=100
set semsys:seminfo_semvmx=32767
```

If there are no parameters, copy them from the template file in `/home/femis/install/oracle_template/kernel_parms.dat`. As root, set them to the recommended values shown above or as high as possible for the operating system.

**Note:** If any of these parameters are changed, you must reboot the server (as root, use the `init 6` command to reboot) before proceeding.

8. Verify there is at least two times (preferably three) as much swap space as physical RAM (a minimum of 400 MB is recommended). If additional swap space is required, see your System Administrator.

To determine how much physical RAM you have, enter the following command:

```bash
# prtconf | grep size
```

To determine the available swap space, enter the following command:

```bash
# /usr/sbin/swap -s
```
9. Verify that the necessary Solaris packages are installed prior to installing Oracle.

   # pkginfo -i SUNWarc SUNWbtool SUNWhea SUNWlibm SUNWlibms SUNWsprot SUNWtoo

   If any of the patches and/or packages above are not displayed as installed, then install them.

10. Verify there is a local bin directory /usr/local/bin. If the directory does not exist, then it should be created as root.

11. Create the /var/opt/oracle directory, if it does not exist.

    #> mkdir -p /var/opt/oracle
    #> chown -R oracle /var/opt/oracle
    #> chgrp -R dba /var/opt/oracle
    #> chmod -R 755 /var/opt/oracle

12. Log completely off and back onto the server as oracle.

13. Create the admin directory, if it does not exist, and then copy the template files to the admin directory.

    % cp -r /home/femis/install/oracle_template/* /<install_drive>/app/oracle/admin
    % chown -R oracle /<install_drive>/app/oracle/admin
    % chgrp -R dba /<install_drive>/app/oracle/admin
    % chmod -R 755 /<install_drive>/app/oracle/admin

14. Create the product directories, if they do not exist.

    % mkdir -p /<install_drive>/app/oracle/product/8.1.6
    % chown -R oracle /<install_drive>/app/oracle/product
    % chgrp -R dba /<install_drive>/app/oracle/product
    % chmod -R 755 /<install_drive>/app/oracle/product

15. Copy the new Oracle UNIX setup file to the installation directory.

    **Note:** If you previously had FEMIS installed, you should compare your existing configuration files with the new ones. If your existing files have been customized, then do not overwrite them but perform Step 14 to make sure the values are still correct for this server.

    % cd /<install_drive>/app/oracle/admin
    % cp -p oracle.mycshrc /<install_drive>/app/oracle/.mycshrc
    % cp -p oracle.cshrc /<install_drive>/app/oracle/.cshrc
    % cp -p oracle.oraclerc /<install_drive>/app/oracle/.oraclerc
    % cp -p oracle.login /<install_drive>/app/oracle/.login
16. Make sure the following environment variables are correct in `.oraclerc` file.

```
ORACLE_TERM (set it to match the xterm for the given keyboard: xsun or xsun5)
ORACLE_BASE = /<install_drive>/app/oracle
ORACLE_HOME = /$ORACLE_BASE/product/8.1.6
PATH includes:
   $ORACLE_HOME/bin
   /etc
   /usr/local/bin
   /bin
   /usr/bin
   /usr/ccs/bin
ORACLE_SID = fi<x>
ORACLE_DOC = $ORACLE_BASE/doc
CLASSPATH = $ORACLE_HOME/JRE:$ORACLE_HOME/jlib
LD_LIBRARY_PATH =
   /usr/lib:/usr/dt/lib:/usr/ucblib:/usr/openwin/lib:$ORACLE_HOME/lib
ORACLE_EXPORT = /<driveA>/app/oracle/admin/fi<x>/exp
ORACLE_LOGS  = /<driveA>/app/oracle/admin/fi<x>/logs
ORACLE_FULL = /<driveB>/app/oracle/admin/fi<x>/full
ORACLE_COLD = /<driveB>/app/oracle/admin/fi<x>/cold
```

17. Create the directories that Oracle uses for database backups and redo logs.

```
% source .oraclerc
% cd /<install_drive>/app/oracle/admin
% ./dbbackup_setup
```

This executable will check on needed environment variables and then create directories. If any errors are reported, correct them and then rerun the setup process.

### 2.7.2 Installing the Oracle Software

To install the Oracle v8.1.7 software, complete the following steps:

1. Log completely off and back onto the server as `oracle` with the group set to `oinstall`.

   ```
   % newgrp oinstall
   % id
   ```

   This should return something like `uid=26000(oracle) gid=26002(oinstall)`.

2. Insert the Oracle8 Server v8.1.7 CD#1 into the CD drive.

3. Mount the CD.

   ```
   $ cd /cdrom/oracle8i
   ```
4. Run the installer.

./runInstaller &

5. Install the Oracle products. After the Universal Installer comes up, perform the following operations at the indicated windows:

WELCOME — Click Next.

FILE LOCATIONS — Ensure Destination path settings point to the v8.1.7 directory, and then click Next.

UNIX GROUP NAME — Enteroinstall in the space provided. (This window may not display if any Oracle products are currently installed.)

AVAILABLE PRODUCTS — Select the Oracle8i Enterprise Edition 8.1.7.0.0, then click Next.

INSTALLATION TYPES — Select Custom, then click Next.

AVAILABLE PRODUCTS COMPONENTS — Select the following components (a check mark indicates a selected product); the plus (+) and minus (–) signs expand or contract the upper level menus:

-Oracle8i Enterprise Edition 8.1.7.0.0
  +Oracle8i Server 8.1.7.0.0
  -Oracle HTTP Server 1.3.1.2.0.1a
  +Oracle Product Options 8.1.7.0.0
  +Net 8 Products 8.1.7.0.0
  +Oracle Utilities 8.1.7.0.0
  -Oracle Java Products 8.1.7.0.0
  +Oracle Enterprise Manager Products 8.1.7.0.0
  +Oracle Configuration Assistant 8.1.7.0.0
  -Oracle Development Tools 8.1.7.0.0
  -Oracle Installation Products 8.1.7.0.0
  +Oracle Universal Installer 1.7.1.8.0
  +Oracle8i for UNIX Documentation 8.1.7.0.0

Click Next.

COMPONENT LOCATIONS — Click Next.

PRIVILEGED OPERATING SYSTEM GROUPS (change to dba for both) — Click Next.
CREATE DATABASE — Select NO, and click Next to continue.

SUMMARY — Review your selections. You will probably see more products than you
selected (some are required to support your selections), but as a minimum, you should see the
products that were originally selected. Click the Install button if your selections are correct.
If they need to be revised, then click on the Previous button and revise selections. When the
install is about 90% complete, a prompt will be given to load the second CD. You will have to
ejject the first one and mount the next one. Change the Source locator to
/cdrom/oracle8#1, and continue the install.

When the install is complete a message is given to execute the root.sh file. As root, execute
the root.sh. When prompted by the following: Enter the full pathname of the local
bin directory, accept the default path. When the script is finished, click OK.

The Configuration Tools window displays to aid in setting up the Net8 software. On the Net8
Configuration Assistant: Welcome window, check the Typical box, and then click Next. Some
changes will be made to the tnsnames.ora files, and when this is finished, the End of
Installation window displays. Click Exit to end the installation of Oracle 8.1.7.

6. Create an empty database using the Database Creation Assistant.

As the oracle user, verify that you are part of the dba group by entering the following and
pressing Enter:

% id

The above id command should return uid=26000(oracle) gid=26001(dba).

If the group is not correct, change it by entering:

% newgrp dba

Change the directory to the new ORACLE_HOME, and run the Database Creation Assistant.

% cd $ORACLE_HOME/bin
% ./dbassist &

7. Perform the following operations, after the Database Creation Assistant comes up, at the
indicated windows:

ORACLE DATABASE CONFIGURATION ASSISTANT
Select Create a database, and click Next.
Select Custom, and click Next.
Select Multipurpose, and click Next.
Change Concurrently connected users to 35, and click Next.
Select Dedicated Server Mode, and click Next.

Verify a box is checked for each of the following:

Advanced Replication and SQL*Plus Help.

Click Next to continue.

Enter the Global Database Name, and click Next.

Example: fil

Then set the Compatible Parameter to the highest version available, and click Next.

Example 8.1.0

Note: If an Alert window regarding an instance is already in use, choose another instance name. Acknowledge the Alert window by clicking OK. Edit the /var/opt/oracle/oratab file to remove the offending instance line, and click Next.

If an Oracle Database Configuration Assistant Alert window displays and states that the database already exists, then click Yes to proceed. This removes the old folder with the same instance name in the $ORACLE_BASE/admin directory, and allows the same instance name to be recreated.

Change the ControlFiles so that each control file has a different number in the /filesX line where X = 0....n.

Example: /files0, /files1, /files2. Leave the maximum Datafiles = 254 and Max Log files = 32. Change the Max Log members = 4.

Click Next.

To create tablespaces for each tabbed tablespace, input the following parameters (Create file locations based on your best judgment of space available and disk usage):

**SYSTEM**

- Size (MB): 400
- File: (Verify the File Location)
- Autoextend: ON
- Next (KB): 1000
- Min Extent (KB): 1000
- % Increase: 0
- Initial (KB): 100
- Next (KB): 100
- Min: 1
- Max: Check "Unlimited"

**TOOLS**

- Size (MB): 50
- File: (Verify the File Location)
- Autoextend: ON
- Next (KB): 1000
Min Extent (KB): 1000
% Increase: 0
Initial (KB): 100
Next (KB): 100
Min: 1
Max: Check “Unlimited”

USER
Size (MB): 5
File: (Verify the File Location)
Autoextend: OFF
Min Extent (KB): 1000
% Increase: 0
Initial (KB): 100
Next (KB): 100
Min: 1
Max: Check “Unlimited”

ROLLBACK
Size (MB): 200
File: (Verify the File Location)
Autoextend: OFF
Min Extent (KB): 1000
Initial (KB): 1000
Next (KB): 1000
Min: 2
Max: Check “Unlimited”

INDEX
Size (MB): (Accept the default)
File: (Accept the default)
Autoextend: (Accept the default)
Next (KB): (Accept the default)
Min Extent (KB): (Accept the default)
% Increase: (Accept the default)
Initial (KB): (Accept the default)
Next (KB): (Accept the default)
Min: (Accept the default)
Max: (Accept the default)

TEMPORARY
Size (MB): 50
File: (Verify the File Location)
Autoextend: OFF
Min Extent (KB): 1000
Initial (KB): 500
Next (KB): 500

Note: SYSTEM, ROLLBACK, and TEMPORARY should be on different disk devices to distribute I/O.

Click Next.
On the Review of the Redo Log Parameters window, set file sizes = 10000KB, put the logs on separate drives, and click Next.

Ignore the Checkpoint settings, leave the Enable Archive Log box unchecked, and click Next.

Verify and change the following parameters as indicated:

Shared Pool Size 52428800
Block Buffers 24567
Log Buffer Size 163840
Processes 300
Block Size 4096

Click Next.

Leave the Trace File Directory settings intact and click Next.

Select the Save information to a shell script setting, and click Finish. In the popup window, accept the default location, and enter the file in the format of <sid>master.sh (Example: fi1master.sh). Click OK to save the file. Acknowledge the Alert windows that indicate the status of the file creations. This will end the Database Creation Assistant.

8. Change directory to the location of the saved scripts generated in the previous step:

```
% cd $ORACLE_HOME/assistants/dbca
% ls -l fi*.sh
```

This should produce a listing of scripts as per the example below:

```
% ls -l fi*.sh
-rwxr-xr-x 1 oracle dba 214 Feb 10 20:22 filalterTablespace.sh
-rwxr-xr-x 1 oracle dba 548 Feb 10 20:22 filmaster.sh
-rwxr-xr-x 1 oracle dba 253 Feb 10 20:22 filreplicate.sh
-rwxr-xr-x 1 oracle dba 682 Feb 10 20:22 filrun.sh
-rwxr-xr-x 1 oracle dba 4004 Feb 10 20:22 filrun1.sh
-rwxr-xr-x 1 oracle dba 452 Feb 10 20:22 filrun2.sh
-rwxr-xr-x 1 oracle dba 188 Feb 10 20:22 filsqlplus.sh
```

9. Review and edit the scripts that are displayed in Step 8 above; make changes as indicated below to the named scripts:

```
- fi*run.sh
```

Add the following under maxlogfiles 32:

```
maxlogmembers 4
```
Add the following text \texttt{MAXSIZE 800M} to the end of the \texttt{SYSTEM} tablespace line \texttt{DATAFILE 'file' SIZE 400M AUTOEXTEND ON NEXT 1000K}.

Edit the \texttt{LOGFILE} definition for the correct file and instance names.

\texttt{logfile}
\begin{verbatim}
GROUP 1 ('/install_drive/app/oracle/oradata/fi9/redo01a.log',
   '/driveA:/app/oracle/oradata/fi9/redo01b.log') SIZE 10M,
GROUP 2 ('/install_drive/app/oracle/oradata/fi9/redo02a.log',
   '/driveA:/app/oracle/oradata/fi9/redo02b.log') SIZE 10M,
GROUP 3 ('/install_drive/app/oracle/oradata/fi9/redo03a.log',
   '/driveA:/app/oracle/oradata/fi9/redo03b.log') SIZE 10M;
\end{verbatim}

10. Verify the \texttt{ORACLE_SID} entry. If it is not set, set it appropriately (instance name), change directory to the \texttt{pfile} directory for the instance, and review/change the \texttt{init.ora} script per the example below.

% env | grep ORACLE_SID
% setenv ORACLE_SID <fi#>
% cd $ORACLE_BASE/admin/$ORACLE_SID/pfile

If there is no \texttt{init.ora} file present, then copy the sample \texttt{init.ora} file, and edit per the following example:

% cp /install_drive/app/oracle/admin/initfix.ora ./initfi<SID#>.ora
% chmod u+w initfi<SID#>.ora

where \texttt{<SID#>} is the instance number.

Enter the following command, and edit the \texttt{init.ora} file:

- Replace instance and file specific values that are different from the original file.
- Verify that rollback segment and control file names and locations are correct.
- Update the path for the \texttt{log_archive_dest_1} parameter (it should match \texttt{$ORACLE_LOGS}).
- Delete any rollback segments beyond \texttt{RBS7}.
- Change the compatible parameter to \texttt{8.1.7.4}.

% vi init<SID#>.ora

11. Verify that all database file directories exist before executing the database creation script.

% ls -la /*/app/oracle/oradata/$ORACLE_SID
% ls -la $ORACLE_BASE/admin/$ORACLE_SID (check for bdump, cdump, udump)

12. Change directory to the location of the database creation scripts and execute the master script, as per the example below:
Note: This task is a time consuming and may take up to several hours, depending upon the speed of your system. You may see many ORA-04132 errors regarding nonexistent objects. These will be created and are normal output.

% cd $ORACLE_HOME/assistants/dbca
% ./<SID>master.sh

Note: If during the process of creating the database you see messages that the orapwd file is corrupt or missing, it will need to be recreated. To recreate the orapwd file, enter the following commands:

cd $ORACLE_HOME/dbs
orapwd file=orapw<SID> password=<create a password> entries=<a number>

You will have to re-execute the master script at the beginning of Step 12.

13. Review database creation log files for errors.

% cd $ORACLE_BASE/admin/$ORACLE_SID/create
% ls -lat *.log
% grep ORA- *.log | more

14. Change the password for the SYS and SYSTEM accounts, via svrmgrl, as per the example below:

SVRMGR> connect internal
SVRMGR> alter user sys identified by dba<SID#>; (for example for fi6 use dba6)
SVRMGR> alter user system identified by dba<SID#>; (for example for fi6 use dba6)

15. Edit the oratab, as oracle, in /var/opt/oracle, and change the third field from no (N) to yes (Y) so that the database is brought up when the server is rebooted. Also make sure that the path is preceded by ORACLE_SID parameter followed by a colon as shown below (the example is for a database instance with ORACLE_SID = fi1).

    fi1: /<install_drive>/app/oracle/product/8.1.7:Y

16. Login in as root, and copy a file named dbora into the /etc/init.d directory, if it does not already exist.

    # cp /<install_drive>/app/oracle/admin/dbora /etc/init.d/dbora
    # ls -la /etc/init.d/dbora

17. Link dbora by entering the following:

    % ln -s /etc/init.d/dbora /etc/rc0.d/K10dbora
    % ln -s /etc/init.d/dbora /etc/rc2.d/S99dbora
18. Replace the `dbstart` and the `dbshut` scripts with the following command (assumes you are still in `/<install_drive>/app/oracle/admin`):

   ```
   % cp dbstart dbshut $ORACLE_HOME/bin
   ```

19. Reserve a port for the Net8 listener by making the following entry in the `/etc/services` file (insert this in port number sequence):

   ```
   listener_name 1521/tcp # Net8 listener
   ```

20. View the SQL*Net files (`sqlnet.ora`, `listener.ora`, `tnsnames.ora`), in the `$ORACLE_HOME/network/admin` directory (they are compatible with Net8).

   ```
   % cd $ORACLE_HOME/network/admin
   ```

   Change the hostname, instance name, and `$ORACLE_HOME` path to the correct identity for the server that you are working on.

   If there were no existing files, enter the following commands:

   ```
   % cd /<install_drive>/app/oracle/admin
   % cp -p listener.ora tnsnames.ora sqlnet.ora $ORACLE_HOME/network/admin
   % chmod u+w $ORACLE_HOME/network/admin/*.ora
   ```

   Check and modify the files in the destination path to match your site’s server and database instance names. Be sure to include listener definitions for the whole site in the `tnsnames.ora` file.

21. Verify the listener status.

   ```
   % lsnrctl
   LSNRCTL>status
   ```

   If the response to the status command lists a summary of approximately 10 parameters, and one of these is `uptime`, then the listener is running. Exit by entering:

   ```
   lsnrctl>exit
   ```

   If the listener is not working, then start it by entering:

   ```
   lsnrctl>start
   ```

22. Switch user to `femis` and link the `oracle` environment parameter file to the `femis` home directory to preserve environment file setting integrity.

   ```
   % su - femis
   % ln -s -oracle/.oraclerc
   ```
23. Switch user to oracle.

```
% su – oracle
```

Review the init<fu#>.ora file, and ensure that the log_archive.start parameter is set to True.

Put the database in archive mode.

```
% svrmgrl
SVRMGR> connect internal
SVRMGR> shutdown immediate
SVRMGR> startup mount;
SVRMGR> alter database archivelog;
SVRMGR> archive log list;
SVRMGR> shutdown immediate
SVRMGR> startup
SVRMGR> exit
```

### 2.7.3 Applying the Oracle v8.1.7.4 Patch

To fix several database issues in Oracle v8.1.7, a database patch is needed, which is accomplished by upgrading to Oracle v8.1.7.4. This patch was obtained from Oracle Support and is the terminal release version for Oracle 8.1.7. The patch is included with FEMIS v1.5 distribution and is applied as described below.

Complete the following steps to install the Oracle v8.1.7.4 patch.

1. Login in as root.
2. Insert the FEMIS application CD into the CD-ROM drive.
3. Run the pkgadd utility to install the ORApatch package.

```
# pkgadd –d /cdrom/cdrom0/
```

Select ORApatch and follow the prompts through the installation.

4. Use pkgchk to verify that ORApatch was installed correctly.

```
#pkgchk –n ORApatch
```

**Note:** The packages installed successfully if no error output is displayed. Report any errors to PNNL.
5. Change to the oracle user, and shutdown the listener and all database instances on the server with the following commands from an oracle user window:

```bash
# su - oracle
% lsnrctl stop
% svrmgrl
SVRMGR> shutdown immediate
SVRMGR> exit
%
```

6. Remove the old Oracle product files, and cd to /apps/oracle/patches/8.1.7.4.0patch. Then untar the file 8174_solaris32_release.tar using the following command:

```bash
% cd $ORACLE_BASE/product
% rm -r 8.1.6
% cd /apps/oracle/patches/8.1.7.4.0patch
% tar x[v]f <path>/8174_solaris32_release.tar
```

where <path> is the path location to the patch tar file via local file system, automount, or hard mount. [v] is an optional verbose flag to the tar command.

7. Check to make sure the Oracle environment variables $ORACLE_HOME and $ORACLE_SID are set correctly, and note if there is more than one database running on the server.

8. Start the server-based Oracle installer using this command as the UNIX oracle user.

```bash
% runInstaller&
```

9. Choose the following options on the installer windows:

   Click Next on the Welcome window.

   Click Browse for the Source.

   Select the /apps/oracle/patches/8.1.7.4.0patch/Disk1/stage path to find the products.jar file.

   Click Next.

   Click Install on the window that shows what is in the patch.

   Click Exit on the End of Installation window when the installation is done.

10. Add the following _SYSTEM_TRIG_ENABLED = FALSE line to the bottom the init<sid>.ora file:

```bash
% cd /apps/oracle/admin/<sid>/pfile
% vi init<sid>.ora
```
Restart up the database with the following commands as the oracle user.

```bash
% svrmgrl
SVRMGR> connect internal
SVRMGR> startup
SVRMGR> exit
```

11. Run each of these scripts from sqlplus connected as internal (scripts are in the patch directory) and running as the UNIX oracle user:

**Note:** The following scripts may take several hours to run to completion.

```bash
% cd /apps/oracle/patches/8.1.7.4.0patch
% sqlplus internal
SQL> @do8174patch1.sql
```

Under certain circumstances, the script may instruct you to delete data. Follow these instructions, and delete the data.

```bash
SQL> @do8174patch2.sql
```

If you previously deleted data, follow the instructions to add the data back.

12. Remove the init<sid>.ora entry made in Step 11, and cycle the database by executing the following commands as the oracle user:

```bash
% svrmgrl
SVRMGR> connect internal
SVRMGR> shutdown
SVRMGR> startup
SVRMGR> @do8174patch3.sql
```

Enter the password for the Oracle SYS schema when prompted.

The database patch is complete for the current instance, and your server has been upgraded to Oracle v8.1.7.4.0. If your server has more than one instance, then repeat Steps 10 through 12 for each server.

### 2.7.4 Installing and Using Oracle Documentation

**Note:** The following applications are required to view the Oracle documentation:
- HTML: Netscape Navigator 3.0 (or higher) or Microsoft Internet Explorer 3.0 (or higher).
- PDF: Acrobat Reader 3.0 (or higher) or PDFViewer Web browser plug-in 1.0 (or higher).
Complete the following steps to install the Oracle v8.1.7 documentation.

1. Log completely off and back onto the server as oracle with the group set to oinstall.

   % id should return something like uid=26000(oracle) gid=26002(oinstall)

2. Insert the Oracle8i On-Line Generic Documentation CD into the CD drive.

3. Mount the CD

   $ cd /cdrom/817_docs

4. Run the installer.

   runInstaller &

   Click Next on the Welcome window.

5. Select a product to install. When prompted by the installer, navigate to the CD-ROM drive, and locate the /INSTALL/docs_817.jar file, and select it as your source.

   Install the documentation into the $ORACLE_DOCS directory that exists if a previous version of Oracle has been installed. If the directory does not exist, see Step 3 in Section 2.7.6, Configuring Existing Oracle for Latest Version of FEMIS. If $ORACLE_DOCS is set, the documentation will be installed there regardless of the destination setting specified in this window.

   Click Next to verify the product list is correct.

   Click Install on the Verification window.

To view the HTML and PDF documentation from a local installation or from the CD-ROM, follow these steps:

1. Use your browser to open the top-level index.htm file within the installed documentation directory.

   **Note:** If you do not wish to launch the Information Navigator Java applet, open the file products.htm instead of index.htm.

2. Click on the category of documentation you wish to view (Server and Data Warehousing, Application Development, Networking and Security, Parallel Server, interMedia, Java, or WebDB).
3. Click on the HTML or PDF link, on the resulting product-level index file, corresponding to the book you wish to view. Clicking the HTML link takes you to the table of contents for that book; clicking the PDF link displays the appropriate document using your installed Acrobat products or your browser’s Acrobat plug-in.

2.7.5 Relinking the Oracle Software

**Note:** If you have upgraded or patched the operating system and have Oracle v8.1.7 installed, then complete this section to relink the Oracle software.

If you just completed the steps in Section 2.7.3, Applying the Oracle v8.1.7.4 Patch, then skip this section because Oracle has already been relinked.

1. Shutdown Oracle by logging in to UNIX as the oracle user and complete the following:

   ```
   % svrmgrl
   SVRMGR>connect internal
   SVRMGR>shutdown immediate
   SVRMGR>exit
   ```

2. Relink the Oracle software.

   ```
   % cd $ORACLE_HOME/bin
   % relink all
   ```

   This process may take several minutes to complete. It will produce a large amount of output, which is normal. Some error output will occur regarding portions of Oracle that are not installed, which is normal. As long as the last messages prior to link completion do not indicate fatal errors, the link was successful.

3. Restart Oracle.

   ```
   % svrmgrl
   SVRMGR>connect internal
   SVRMGR>startup
   SVRMGR>exit
   ```

2.7.6 Configuring Existing Oracle for Latest Version of FEMIS

**Note:** If you already had FEMIS v1.5 installed and are upgrading to FEMIS v1.5.3, then you must complete this section. In the steps below, `<install_drive>` is the file name where the Oracle software was installed.

However, if you have just installed Oracle per the steps in Section 2.7, Installing or Configuring the Oracle Software, then skip this section, and go to Section 2.8, Defining the Database Topology.
1. Login to UNIX as the oracle user, and copy the template files to the admin directory.

```bash
% cp -r /home/femis/install/oracle_template/* /<install_drive>/app/oracle/admin
% chown -R oracle /<install_drive>/app/oracle/admin
% chgrp -R dba /<install_drive>/app/oracle/admin
% chmod -R 755 /<install_drive>/app/oracle/admin
```

2. Copy the new Oracle UNIX setup files to the installation directory.

**Note:** If you previously had FEMIS installed, you should compare your existing configuration files with the new ones. If your existing files have been customized, then do not overwrite them, but complete Step 3 to make sure the values are still correct for this server.

```bash
% cd /<install_drive>/app/oracle/admin
% cp -p oracle.mycshrc /<install_drive>/app/oracle/.mycshrc
% cp -p oracle.cshrc /<install_drive>/app/oracle/.cshrc
% cp -p oracle.oraclerc /<install_drive>/app/oracle/.oraclerc
% cp -p oracle.login /<install_drive>/app/oracle/.login
```

3. Make sure the following environment variables are correct. Also make sure that all directories specified by the parameters exist and have their owner, group owner, and mode set to oracle, dba, and 755 respectively. These can be set using the chown, chgrp, and chmod commands.

```bash
% su - oracle
% env | sort
ORACLE_TERM (set it to match the xterm for the given keyboard: xsun or xsun5)
ORACLE_BASE = /<install_drive>/app/oracle
ORACLE_HOME = /$ORACLE_BASE/product/8.1.6
PATH includes:
   $ORACLE_HOME/bin
   /usr/local/bin
   /bin
   /usr/bin
   /usr/ccs/bin
ORACLE_SID = fi<x>
ORACLE_DOC = $ORACLE_HOME/doc
LD_LIBRARY_PATH=/usr/lib:/usr/dt/lib:/usr/ucblib:/usr/openwin/lib:/$ORACLE_HOME/lib
   /usr/openwin/lib:
ORACLE_EXPORT = /<driveA>/app/oracle/<x>/export
ORACLE_LOGS = /<driveA>/app/oracle/<x>/logs
ORACLE_FULL = /<driveB>/app/oracle/<x>/full
ORACLE_COLD = /<driveB>/app/oracle/<x>/cold
CLASSPATH = $ORACLE_HOME/JRE:$ORACLE_HOME/jlib
```

4. Switch user to femis, and link the oracle environment parameter file to the femis home directory.
2.7.7 Modifying the Initialization Parameter

Due to changes in FEMIS, one of the Oracle initialization parameters may need to be changed. To determine if changes are necessary, log into UNIX as the oracle user and check the following:

```
% su - oracle
% cd $ORACLE_BASE/admin/$ORACLE_SID/pfile
% vi init<$ORACLE_SID>.ora
```

Look for an entry in this file, e.g., `initfi2.ora`, like `open_cursors = 800`. If this line is not present, add it; or if the line exists but the number is less than 800, change the value to 800. If changes are made, the database must be shutdown and restarted (using the following commands) to make the change active.

```
% svrmgrl
SVRMGR> connect internal
SVRMGR> shutdown immediate

Wait until the database is down, then enter:

SVRMGR> startup
SVRMGR> exit
```

2.8 Defining the Database Topology

**Note:** This section must be completed regardless if this is a new or upgrade installation of FEMIS.

Six configuration files are used to define a topology:

```
/home/femis/etc/eoclist.dat  EOC List  general topology
/home/femis/etc/grplist.dat  Group List  snapshot groups
/home/femis/etc/seqlist.dat  Sequence List  sequence Ids
/home/femis/etc/tablist.dat  Table List  Table privileges
/home/femis/etc/vuelist.dat  View List  Views
/home/femis/etc/eocnum.dat  EOC Numbers  for this site
```

The primary configuration file is the EOC List file, `./etc/eoclist.dat`, which is used by many of the FEMIS shell scripts. The other configuration files are used only by the Make Configuration (makecfg.sh) code generator.
The EOC List file consists of one record for each EOC database. Each record consists of eight space-separated columns. Except for the Yes/No flag in column five, nothing should be uppercase.

1: EOC name name of the EOC and Oracle user account  
2: Password initial password for the Oracle user account  
3: Server server where the data is located  
4: Listener Oracle listener name for the account  
5: Onpost Y=onpost database, N=offpost database  
6: EOC # EOC number used for sequence IDs  
7: Port FEMIS notification port  
8: Other EOCs Comma-separated list of other EOCs on this server, w/o white space. If none, then 0 is used.  
9: Remote EOCs Comma-separated list of remote EOCs, w/o white space. If none, then 0 is used.

The Group List file is used to define the database replication setup. It indicates which tables go in which replication groups, plus which tables must have what kind of snapshots. It contains N major sections, the first one normally for just the one onpost EOC (e.g., DCD), and the remaining ones for the offpost EOCs (e.g., ctoo and utst). The onpost section is different from the offpost sections, which are alike except for the EOC name in the first column.

The Sequence List file is used to define the Oracle sequence IDs in the database, which are used to generate unique keys when inserting records into the database.

The tablist.dat file controls table privileges for database users. It has one row for each table in the database. It is possible to modify this file at the time of this installation but extreme care must be taken. See Section 4.5, Security Provisions, in the Data Management Guide for FEMIS Version 1.5.3 for a description of the format of this file.

The View List file is used to define which views are created on which tables. The views combine data from other EOCs into a site-wide version of shared tables. For example, the S_FACILITY view is a combination of the Facility tables in each of the EOC databases.

The eocnum.dat file is the basic file that determines the names of the EOCs at a site and assigns an EOC number to each. This file is used by the Build Topology Program, bldtopo.sh, and is placed into the /home/femis/etc directory as part of the initial installation of a site’s database package. It is preserved throughout the installation of the FEMIS package (Section 2.1.2, Uninstalling the FEMIS 1.5 Application, Step 2).

2.8.1 Running the Build Topology Program

**Note:** The following must be performed on one server in the site’s configuration.

To define a topology, you must create the configuration files using the Build Topology program (on one server) and then copy the files to the other servers in the site’s configuration.

1. Login as femis.
2. Create the configuration files, and place the files in a standard location.

```
%cd ~femis/etc
% ~femis/database/dba/bldtopo.sh
```

The Build Topology program prompts you for information to define the general topology—the EOC List file. If at any point you do not specify something, the program will exit.

```
How many servers? 
```

Enter the number of servers in the topology. For example, for a 3x1, enter 1; for a 6x6, enter 6; or for an 8x4 enter 4.

The build topology program reads the `eocnum.dat` file and displays the information back to the window.

```
Enter server name for <eoc_name> 
```

Each time you get this prompt, you must enter the name of the Sun server where the FEMIS database for the EOC that is listed will reside. For example, for the CTOO database, enter `tcemsun`.

```
Enter listener for <eoc_name> 
```

Enter the Oracle listener name for that server. For example, `fi3`.

The loop then repeats, asking for the next server and listener until you have supplied all of them.

If you have specified an Nx1 topology, then the script will ask you for the server and listener name only once.

After you answer all the prompts, the Build Topology program creates the remaining topology files automatically.

3. Copy the data files (the `*.dat` files) in the `/home/femis/etc` directory to all the servers in the configuration when the `bldtopo.sh` script has completed.

### 2.8.2 Configuring the FEMIS Files

**Note:** The following must be performed on every server in the site’s configuration.

This section explains how to configure the FEMIS files to accommodate the database topology by running the FEMIS configuration script. Before you run this script, you will need to determine some site-specific values.

Determine the Oracle settings.
ORACLE_SID  (Example: fi4)
ORACLE_BASE  (Example: /files1/app/oracle)
ORACLE_HOME  (Example: /files1/app/oracle/product/8.1.6)

The above values can be determined from the Oracle account environment file
/apps/oracle/.oraclerc, or by logging into the Oracle account briefly and running the env
command.

If DEI was installed, decide upon the following items:

FEMX Home Directory  (Default: /home/femx)
EMIS Host Computer  (Example: teadsun)
EMIS User-Name  (Default: femx)
EMIS Password  (Example: femxfer)

The FEMIS configuration script uses the /home/femis/etc/eoclist.dat, system settings, the
/home/femis/install/femis_info file, and Oracle database settings to create the FEMIS
configuration files, which will be placed in the ./home/femis/etc and ./home/femis/configd
directories.

Note: Before configuring FEMIS files, you must know the EOC name, the EMIS transfer
account password, and your UNIX server netmask.

To configure the FEMIS files, complete the following steps:

1. Login as root.
2. Change the directory to the FEMIS install directory, usually /home/femis/install.
3. Edit the femis_info file so the values match the system setup; in particular, ORACLE_SID,
   ORACLE_BASE, and, for the onpost EOC only, EMIS_HOST.

   The Oracle environment variables should be set to match the values given in the
   ~oracle/.oraclerc file.

   Note: You must include the explicit file path for the Oracle directories listed in this file.
   Automount points will not work in this context.

   EMIS_HOST should be set to the server name. The EMIS_USER should be set to emisx, which is
   the standard user name that DEI uses at CSEPP sites.

4. Execute the ./configure_files.sh script. Follow the install prompts for EOC name(s), EMIS
   transfer account password, UNIX server netmask, and whether Samba paths are generated
   instead of Network File System (NFS) file paths. Contact the EOC server System Administrator
   for more information on these settings.
2.8.3 Setting Up the EOC DBA Directory

**Note:** The following must be performed on one server in the site’s configuration.

As released, FEMIS contains a `~femis/database` directory that has a number of subdirectories, none of which should be changed. However, for your own use, you need a working copy of some of the files. Plus, you need to generate brand new SQL scripts that are specific to your database topology. When you have completed the following steps, you will have your own `~femis/database/eocdba` directory with all the scripts you will need to manage your FEMIS database.

1. Login as `femis`.

2. Create a working directory, `eocdba`, for your own use.

   ```
   % cd ~femis/database/dba
   % mkeocdba.sh
   
   **Note:** Ignore error generated from attempting to copy files from the schema directory.
   ```

3. Generate the scripts used to load the stored procedures.

   ```
   % cd ~femis/database/eocdba
   % makeproc.sh
   
   This shell script creates the driver scripts to create `master_cr_procedures.sql` and drop `master_dr_procedures.sql`, which has the stored procedures in all the FEMIS EOC database schemas. The shell script also creates all the actual server-specific files, `cr_procedures_SERVER.sql` and `dr_procedures_SERVER.sql`.
   ```

4. Generate the scripts used to manage and control the database.

   ```
   % cd ~femis/database/eocdba
   % makecfg.sh
   
   This shell script creates a very large number of SQL scripts.
   
   **Note:** It is essential that all FEMIS servers use the same database topology. **Be sure to copy the `eocdba` directory to all servers in the configuration** because every server needs the same set of files.

2.9 Creating or Updating the FEMIS Database

Complete the following sections to create or update the FEMIS database.
2.9.1 Creating the Database Schemas

Note: The following must be performed on every server in the site’s configuration.

Verify that the files in both the /home/femis/etc and /home/femis/database/eocdba directories were copied to all servers (See Section 2.8.1, Running the Build Topology Program).

To create the database schemas, complete the following steps:

1. Login as femis.

2. Change to the ~femis/database/eocdba directory.

   % cd ~femis/database/eocdba

3. Verify that the create tablespace commands are correct. Edit the cr_db_ts_<server name>.sql file as necessary to ensure that the file names are in the correct locations and the files are set to the correct size.

   If you already have FEMIS v1.5 installed, the tablespaces will already exist on your system and will not require any changes to the cr_db_ts_<server name>.sql file.

   An Nx1 configuration will not have the fsnapshot and fsnaplog definition lines below.

   Some fielded sites, such as Alabama, require larger sizes than defined above. The values referenced below are default sizes.

   For example:

   fmain01.dbf  /<driveA>/app/oracle/oradata/fi<x>  200M
   findex01.dbf  /<driveB>/app/oracle/oradata/fi<x>  200M
   fsnapshot.dbf  /<driveA>/app/oracle/oradata/fi<x>  300M
   fsnaplog.dbf   /<driveB>/app/oracle/oradata/fi<x>  100M
   flob.dbf      /<driveA>/app/oracle/oradata/fi<x>  100M

4. Run the Master Create Database script for either a new installation or an update.

   Note: Before continuing, this script must be executed at each server in the configuration while logged onto the server locally as femis.

   This script creates the new tablespaces and schemas. If you are performing an update, then you will receive error messages stating that the tablespaces and some of the data schemas already exist. Disregard these messages during the update.
**Note:** Oracle’s *sys* schema is required to run the *master_cr_db* script. In some previous versions, the *system* schema was required to run this script.

```
% sqlplus /nologin
SQL> @master_cr_db_<server name>.sql
```

When prompted, enter `<Sys Password>`.

### 2.9.2 Importing the Data

**Note:** Depending on what installation steps you have previously completed, you will either update the data in your database, or import data from one of two places and perform the update. Please review this section carefully.

If you just installed Oracle v8.1.7.4 and had an older version than v1.5 of FEMIS installed, then you will want to import the data that was exported in Step 4 of Section 2.6, Preparing the Server for the Upgrade.

If you did not have a previous version of FEMIS and have installed the GIS and database package (Section 2.5, Installing the GIS and Oracle Database Packages), then you will want to import the data found in the `/home/femis/database/exports/<site name>` directory.

If you had v1.5 installed, you do not need to import data. Proceed to Section 2.9.3, Upgrading the Database Structure from Previous Version of FEMIS.

**Note:** Remember that you need to know where each of the N data owners is for your NxN or NxM database configuration. You will import the data for each data owner exactly one time onto the proper server. If you have an NxN configuration, you will perform one import on each server; but for an NxM configuration, some servers will have more than one data owner. You will not import any data into any of the snapshot owners.

1. Login as femis.

2. Enter the following to complete the Oracle import function:

   ```
   % cd /home/femis/database/exports/<site name>
   % imp <USER1>/<PASSWORD> file=<EOC_name>_EOC_<EOC_date>.dmp log=<USER1_today's date>.log
   % imp <USER2>/<PASSWORD> file=<EOC_name>_EOC_<EOC_date>.dmp log=<USER2_today's date>.log
   ...and so on
   ```

   The actual name of the `.dmp` files will be specific for your site and may contain a date stamp, e.g., `anad_19961210.dmp`. 

2-42
The following is an example for an 8x8 Alabama configuration on a server with the ANAD data owner schema and seven snapshot owner schemas.

```
% imp anad/anad file=anad_19961210.dmp log=anad_<today’s date>.log
```

### 2.9.3 Upgrading the Database Structure from Previous Version of FEMIS

**Note:** Perform the following upgrade only if you had FEMIS v1.5 installed, and you are upgrading to v1.5.3.

The following **must be performed on every server in the site’s configuration.**

When these upgrade scripts are executed, the database structure will be modified for all EOCs at your site.

1. Run the update structure/data scripts to update all the owner schemas, and create the scripts for the upgrade from FEMIS v1.5 to v1.5.3. All databases must be up and available during this operation.

   **Note:** If you prefer to run the update in its entirety and review it later for errors, then you can use the `makerun_nopause.sh` script to create the update scripts without any pause statements.

   If you used the `nopause` shell script and find errors, you may have to start your build process over from the time of the imports.

   ```
   % su - femis
   % cd /home/femis/database/upd/V1.5_V1.5.3
   % makerun.sh
   ```

2. Run the `master_run.sql` script when you are sure the `makerun.sh` script executed successfully. The update scripts will now be run one at a time. There are pause statements scattered liberally throughout the scripts. Watch closely for errors as each script is run.

   ```
   % sqlplus /nologin
   SQL> @master_run
   ```

### 2.9.4 Creating Objects That Share Data

**STOP**

Before continuing, make sure all servers are online and the databases for all EOCs are configured for FEMIS v1.5.3.
Note: The following must be performed on one server in the site’s configuration and that server must host the onpost EOC.

At this point, you should have schemas on all servers and have loaded the data. You are now ready to create views, snapshots, synonyms, and other replication-support items.

The Master Create SQL script (`master_cr.sql`) runs scripts that create the following:

- sequence numbers (All)
- alternate views (All)
- snapshot logs (NxN, NxM)
- snapshots (NxN, NxM)
- snapshot groups (NxN, NxM)
- synonyms for onpost tables (All)
- site views (All)
- replication tables and code (NxN, NxM)

To run the Master Create SQL script, which can take hours to complete on a multi-server configuration, complete the following:

1. Login as femis.

2. Enter the following:

```
% cd ~femis/database/eocdba
% sqlplus /nologin @master_cr.sql
```

You need to watch its progress and occasionally press Enter when prompted. If errors occur, use Ctrl-C to stop the script so you can determine what caused the errors.

### 2.9.5 Fixing the EOC Table

Note: The following must be performed on one server in the site’s configuration.

Run the following script on one server to change the EOC data for all EOCs. It will change the Notify port, the UNIX port, the Server name, and EOC number to match the EOC List file.

1. Login as femis.

2. Enter the following:

```
% cd ~femis/database/eocdba
% fixeoc.sh -fix
```
2.9.6 Setting Up the Oracle Backups

Note: The following must be performed on every server in the site’s configuration.

To set up the crontabs to perform automatic database backups, exports, folder management, and log management, complete Steps 1 and 2; then perform a full cold backup, as described in Step 3.

1. Switch to the femis user, and enter the following:

   ```
   % su – femis
   % cd ~oracle/admin
   % crontab femis.crontab
   ```

2. Switch to the oracle user.

   ```
   % su – oracle
   % setenv EDITOR vi
   % cd ~oracle/admin
   % crontab oracle.crontab
   % crontab -e
   ```

   Check the timing of the automatic jobs to make sure they comply with the EOCs schedule. The `dbbackup_cron_full` should be run prior to a full system backup. The `dbbackup_clean` should be enabled only if it is not being run by the full back script.

3. Perform a full backup by entering the following commands:

   ```
   % cd ~oracle/admin
   % dbbackup_cold
   ```

For more information on the Oracle backups, see Section 12.0, Backup Strategy for FEMIS, in the FEMIS System Administration Guide Version 1.5.3.

2.9.7 Starting Replication

Since neither an NxN nor an NxM configuration store data for all EOCs on each server, the data must be replicated by Oracle to make all of the data accessible to all servers. The following script starts the replication process for your configuration.

If you have an Nx1 database configuration, then skip this step.

Note: The following must be performed on one server in the site’s configuration.

Do not start replication until all the FEMIS databases have been installed and configured on all servers at the site.
To start replication, run the Master Start Replication script.

1. Login as femis

2. Enter the following:

   % cd ~/femis/database/eocdba
   % sqlplus /nologin
   SQL> @master_rep_start.sql

2.10 Miscellaneous Configurations

The following sections consist of other configurations that must be completed as part of the installation process.

2.10.1 Verifying the Configuration Files

Having run the FEMIS configuration script (Section 2.8.2, Configuring the FEMIS Files), you must now verify whether the configuration files it created are correct.

1. Login as femis.

2. Check that the femis account is setup correctly.

   % env
   USER=femis
   HOME=/home/femis
   SHELL=/bin/csh
   FEMIS_HOME=<full path>
   LD_LIBRARY_PATH=/usr/lib:/$FEMIS_HOME/lib:/usr/ucb/lib:

The ORACLE_SID and ORACLE_HOME environment variables must be set. The values for these are site/server dependent. The ORACLE_SID should be set to the string fi followed by a server-specific number. The ORACLE_HOME environment variable will point to the home directory of your Oracle installation.

The PATH environment variable, as a minimum, includes the following:

.:/home/femis:/bin:/usr/bin:/usr/sbin:/$ORACLE_HOME/bin:/etc:/usr/ccs/bin:$FEMIS_HOME/bin:$FEMIS_HOME/database/dba

Note: The PATH variable may include /usr/local/bin on those sites where this directory exists so that remote Secure Shell utilities will work for the femis UNIX account.
3. Verify you have the following files if this is an onpost installation.

   /home/femis/etc/femisdei.cfg
   /home/femis/etc/femisdei.prf

4. Edit the site and EOC values in the /home/femis/configd/fsetup.ini. Change the site value to uppercase letters (e.g., SITE) and replace the EOC value to match your EOC, also using uppercase letters.

5. Validate the /home/femis/configd/addodbc.bat file: FEMIS uses the home/femis/configd/addodbc.bat batch file to add all the necessary ODBC (Open Data Base Connectivity) values. Verify that the mapping from EOC code to listener ID is correct in each line. Copy good version of addodbc.bat to /home/femis/user.

6. Validate the /home/femis/configd/ntp.conf file: the ntp.conf file should be configured with the correct IP address for the time server.

   The line beginning with server must have the correct IP address of the NTP server, which should be one of the UNIX servers on the wide area network (WAN).

7. Check the system files to verify the FEMIS entries were added.

   /etc/services
   /etc/inetd.conf

   In the /etc/services file, you should see a service named femis setup for port 1776. In the /etc/inetd.conf file, you should see a femis entry pointing at the full file path of the femisd executable.

2.10.2 Setting Up femis_event

The notification daemon now has the capability to limit the number of AUX processes it spawns to control resource loading on servers. This new capability is discussed in Section 3.0, FEMIS Notification Service, in the System Administration Guide for FEMIS Version 1.5.3.

In regard to configuration of parameters that control this new feature, the values inserted into the femis_event.conf file by running configure_files.sh in Section 2.8.2, Configuring FEMIS Files, generally work well. However, on systems that may be utilizing most or all of their disk, memory, and CPU resources already, the values may be too high and need to be reduced. A server’s load depends on many different variables and can vary depending on usage. In general, field experience has shown that SPARCstation 20 platforms and certain older servers with processor speeds at 85 MHz or below with 256 MB memory may also experience heavy loading with the default values as assigned in femis_event.conf. In these cases, the default value can be reduced.
In the file `~femis/etc/femis_event.conf`, the line looking like

```
com maxaux=10
```

can be altered to

```
com maxaux=5
```
on systems that may be suspect of experiencing high loads.

### 2.10.3 Verifying the `/etc/hosts` File

If FEMIS servers on the network define the fully qualified names of other FEMIS servers differently, multiple connections may occur. Check the `/etc/hosts` file to verify consistent fully qualified host names have been used across the site's networks. If inconsistent names have been used, these names need to be changed.

### 2.11 Checking the FEMIS Startup

To check the FEMIS startup, you will need to reboot the server and verify the FEMIS programs are running.

#### 2.11.1 Rebooting the Server

To activate some of the system-level changes that the FEMIS UNIX Installation script makes, complete the following steps to reboot the server:

**Note:** If you have an Nx1 database configuration, then skip Steps 1 and 4.

1. Login as `femis`, and stop master replication.

   ```
   % cd /home/femis/database/eocdba
   % sqlplus /nologin @master_rep_stop.sql
   ```

2. Login as `root`.

3. Enter the following on a Solaris machine:

   ```
   # /etc/init 6
   ```

   As the server reboots, note the status messages during the startup of the FEMIS processes.
4. Login as femis, and start replication.

   % cd /home/femis/database/eocdba
   % sqlplus /nologin @master_rep_start.sql

2.11.2 Verifying the FEMIS Programs

After the server has rebooted, verify that the FEMIS programs are running.

Login as femis.

For an NxN configuration, there should be one FEMIS Notification Server process running. For an
Nx1 configuration, there should be N of them running. For an NxM, there should be one FEMIS
Notification Server process for each EOC per server in the configuration.

   % ps -ef | grep femis_event

If it is not running, restart it with logging turned on.

   % startnotify -log

Then use the Show Notify utility.

   % shownotify aux

If notification fails (core dumps), check the /etc/nsswitch.conf to verify your system uses files
for name resolution prior to any other method like dns. If your nsswitch.conf is configured as:

   hosts:  dns files

Change it to:

   hosts:  files dns

You should also verify all femis servers domain names are correct in the /etc/hosts file. Refer to
Section 3.0, FEMIS Notification Service, in the FEMIS System Administration Guide Version 1.5.3
for more information.

If DEI should be running, check it also.

   % ps -ef | grep femisdei

If it is not running, check the log file home/femis/log/femisdei.log, to see what happened. The
most common problem occurs when DEI cannot connect to Oracle. Check the configuration file,
To ensure DEI is running correctly, you should view the bottom portion of the log file at 
/home/femis/log/femisdei.log to see if there are any errors that require investigation.

2.12 PC Connectivity

The FEMIS PCs will need to be able to run the FEMIS installation program located on the FEMIS
server and periodically receive software updates. This requires directories being shared either
through nfs (UNIX native file share) or smb (PC native file share). The two directories required are:

/home/femis
/home/femis/user

These shares should be read-only (except for the femis user on /home/femis) for security purposes
and to protect the integrity of the FEMIS configuration.

If you are upgrading from FEMIS 1.5 to 1.5.3, you should modify the existing PC connectivity
configuration to make these shares read-only and remove the femisrun group restrictions allowing
everyone access. This will eliminate the need for PC user accounts on the FEMIS server. A new
installation of the Samba 2.2.5 package on the FEMIS 1.5.3 Application CD will include these
changes.

2.12.1 Using NFS File Sharing

Add the following line to the /etc/dfs/dfstab if you are not using Samba and are using an NFS
program for PC connectivity (e.g., Maestro):

share -F nfs -o ro,rw=femis </disk>/home/femis

where <disk> is whichever device /home/femis is on.

If previous share entries for </disk>/home/femis exist, remove them.

Note: To restrict NFS access, see the man pages on share and share_nfs in your Solaris
documentation.

If you do not have any other entries in the dfstab file, you will need to start the NFS server process.
If you do not start the NFS server process, you will see errors like RPC: Program not registered
when entering the shareall command (see below). To start the NFS server process, enter the
following:

# /etc/init.d/nfs.server start
To make the /<disk>/home/femis directory available to NFS authentication services (daemon), enter

    # shareall

To check that the directory is available to NFS Maestro, enter

    # share

You should see output similar to the following:

    # -  /<disk>/home/femis ro,rw=femis ""

2.12.2 Installing and Configuring Samba

Installing a current version of Samba is recommended but not required. Skip to Section 2.12.2.2, Configuring Samba, if you are not installing Samba 2.2.5 as packaged on the FEMIS Application CD.

Before installing, you will need to disable and/or remove any previous versions of Samba from the system. Save the old configuration file for reference. Samba may exist on a system in one of two forms.

- It can be launched in a stand-alone mode in which case it is initially started by /etc/init.d startup scripts. To disable in this case, simply remove or rename the Samba startup scripts, and kill all smbd and nmbd processes.

- The other form is launched from the inetd daemon. In this case, the startup lines must be temporarily commented out of the /etc/inetd.conf file, and inetd signaled to reread its configuration file with a kill -HUP <inetd pid>. Then kill all smbd and nmbd processes on the system to disable.

The location of the original configuration file can then be determined either from the startup scripts or the inetd.conf file. The smbd and nmbd binaries usually reside in a bin directory under the Samba main installation root. The old configuration file will be typically located under the lib portion of this tree and is called smb.conf. There may be additional information worth saving in the lib branch, so saving this entire directory for future reference is recommended.

2.12.2.1 Installing Samba

To install Samba v2.2.5, complete the following steps:

1. Login as root, and insert the FEMIS application CD into the CD-ROM drive.
2. Install Samba using the Solaris software installation utility.

   # pkgadd -d /cdrom/cdrom0 SAMBA

3. Answer the questions as prompted:

   - The Windows NT Domain will only apply to those sites using NT Domain services. Enter anything if your site is not using this capability.

   - The WINS address is an IP address of a Windows Internet Name Service (WINS) server. Enter d if you are not using this capability at your site.

4. Select y to continue when the following prompt displays: This package contains scripts which will be executed with super-user permission during the process of installing this package.

5. Select q to quit after installing the Samba package.

6. Use pkgchk to verify the package was installed correctly.

   # pkgchk -n SAMBA

If you only see the above output or get a prompt with no output, the package installed successfully. Continue with the installation by configuring Samba.

### 2.12.2.2 Configuring Samba

Samba configuration can get quite complex because of the flexibility the software offers. Please refer to the man page on smbd.conf for other options and combinations. A template configuration file is provided by the package installation that will set up basic parameters and define basic FEMIS shares. However, manual configuration is inevitable in order to bring the prior version’s definitions into place for compatibility.

1. Edit the /usr/local/samba/lib/smb.conf as necessary according to your site-specific requirements. If you need to bring in configuration from a previous version of Samba, do that here. Pay particular attention to the values for the following parameters:

   - hosts allow is set according to your site’s subnet configuration. By default, it will only allow access to PCs on the same subnet.

   - Change the security and password server according to the authentication method you wish to use. Set security = share if you are not using a domain or password server.
• Uncomment the `interfaces` line if you are running more than one interface on your server (machine is a router) if you want Samba to present itself on all interfaces. The device designation `le0...n` is assumed, but it can be changed to `hme0...n (hme*)` for those sites so configured.

Be sure the share entries for `femis`, `finstall`, and `user` reflect the correct path for your site. The rest of the configuration for these entries is recommended to remain as shipped. If you are using an existing Samba or installed Samba from a source other than the FEMIS Application CD, modify the `smb.conf` to contain the following shares:

```plaintext
[femis]
comment = FEMIS home directory
path = /home/femis
browseable = yes
valid users = femis
read only = no
printable = no
force group = femisrun
force directory mode = 0775
force create mode = 0775

[finstall]
comment = FEMIS install directory
path = /home/femis
browseable = yes
read only = yes
printable = no
guest ok = Yes

[user]
comment = FEMIS user directory
path = /home/femis/user
browseable = yes
read only = yes
printable = no
guest ok = Yes
```

2. Test the configuration by running the Samba `testparm` program.

This program will report on the currently defined configuration. It will point out any configuration errors and report assumed default values for the whole configuration. If this program does not return errors, proceed to the next step. If errors are returned, review and correct the configuration file and re-run `testparm`.

```
# /usr/local/samba/bin/testparm
Load smb config files from /usr/local/samba/lib/smb.conf
Processing section "[homes]"
Processing section "[printers]"
Processing section "[femis]"
Processing section "[finstall]"
Processing section "[user]"
```
3. Join your Windows NT domain (if applicable):

To join an existing NT domain, an entry containing the NetBIOS name of the server must be added to the NT domain on the Primary Domain Controller using Server Manager for Domains.

Once the above is complete, enter the following command on the Samba server:

```
/usr/local/samba/bin/smbpasswd -j <domain name> -r <primary domain controller>
```

You should receive the following response:

```
<date/time stamp>: change_trust_account_password: Changed password for domain <domain name>.
Joined domain <domain name>.
```

4. Enable Samba via the `/etc/inetd.conf` configuration file. The package installation will have added new lines to the `/etc/inetd.conf` file, which specifies the Samba daemon startup. Signal `inetd` to reread its configuration file to launch Samba.

```
# ps -ef | grep inetd
# kill -HUP <inetd pid>
```

5. Add the femis user account to the `smbpasswd` database.

```
# /usr/local/samba/bin/smbpasswd -a femis
```

Enter the femis password when prompted.

6. Verify client connectivity by attempting to connect to one of the default new shares defined in the `smb.conf` file from a PC.

The Samba Web Administration Tool http://<servername>:901/ contains useful information regarding Samba operation and use, especially in integrating with Microsoft Windows environments. In addition, Samba provides detailed UNIX manual pages on its primary components that are included with the package and are located under the default path `/usr/local/samba/man`. Further information and up-to-date news regarding Samba can be obtained from the Samba Web site: http://www.samba.org/ (locate a close mirror site from there).

2.13 Installing the FEMIS AutoRecovery System

**Note:** You must have the FEMIS Perl package installed to use AutoRecovery, see Section 2.4.1, Installing the Perl Package.
The FEMIS AutoRecovery system is used to monitor the FEMIS server and application.

The following files are used, generated, or indirectly affect the FEMIS AutoRecovery system:

```
/opt/local/bin/femis_watch
/opt/local/bin/femis_watch.conf (typical path)
/opt/local/bin/logit
/var/log/femislog[1-7]
/tmp/.auto.debug
/tmp/.autorecovery.pid
/var/tmp/.autorecovery.run
/home/femis/etc/eoclist.dat
/etc/syslog.conf
```

The two files, `femis_watch` and `femis_watch.conf`, are Perl scripts that comprise the heart of the FEMIS AutoRecovery system.

The FEMIS AutoRecovery system is run by cron. The run schedule is set in the root crontab. The default schedule is

```
Mon thru Fri
7:00a to 6:00p - run AutoRecovery every ten minutes
6:00p to 7:00a - run AutoRecovery every half hour
Sat & Sun - run AutoRecovery hourly
```

### 2.13.1 Installing AutoRecovery

The FEMIS AutoRecovery system has been included with the FEMIS software distribution. FEMIS AutoRecovery requires the FEMIS packaged Perl version 5.8 to run. To install, see Section 2.4.1, Installing the Perl Package.

1. Login in as `root`, and insert the FEMIS CD into the CD-ROM drive:

   ````
   # pkgadd -d /cdrom/cdrom0 FEMISar
   ````

2. Use `pkgchk` to verify that `FEMISar` was installed correctly.

   ````
   #pkgchk -n FEMISar
   ````

   **Note:** The packages installed successfully if no error output is displayed. Report any errors to PNNL.

### 2.13.2 Configuring AutoRecovery

To configure FEMIS AutoRecovery, complete the following steps:

1. Login as `femis`.

   ````
   ```

2-55
2. Edit the AutoRecovery configuration file `/opt/local/bin/femis_watch.conf`. Example:

   % chmod u+w femis_watch.conf
   % vi /opt/local/bin/femis_watch.conf

   Enable/disable Auto-Carve/Auto-Insert as desired and set appropriate thresholds, if necessary.

   Verify the restart commands are correct for all restartable processes.

   Add additional $Custodians to receive E-mail when a problem is detected.

   Verify the $ENV{ORACLE_HOME} variable points to the Oracle installation directory.

   Modify disk thresholds and default disk names; add disks as necessary.

   Replace the host entries in the @network list with the other servers at your site.

   Save and exit the file.

   Enter chmod u-w femis_watch.conf.

3. Enable the FEMISar lines in the root crontab.

   % su -
   # crontab -e

   Uncomment the following FEMISar execution lines.

   0 * * * * /opt/local/bin/femis_watch > /dev/null 2>&1 #FEMISar
   30 * * * * /opt/local/bin/femis_watch > /dev/null 2>&1 #FEMISar
   10,20,40,50 7-18 * * 1-5 /opt/local/bin/femis_watch > /dev/null 2>&1 #FEMISar
   0 0 * * * sh /opt/local/bin/logit > /dev/null 2>&1 #FEMISar

   The FEMIS AutoRecovery should start running at the next scheduled FEMIS AutoRecovery (femis_watch) cron event. To verify it is running, check the log file for recent entries.

   % tail /var/log/femislog

2.13.3 Messaging Service

The AutoRecovery system uses three messaging services: logging, E-mail, and FEMIS Notification Service. By default the three messaging services are enabled.

To disable any of the messaging services, comment out the appropriate line in the file:

   /opt/local/bin/femis_watch.conf
For example, to disable syslog messages, comment out the following line:

```bash
$syslog_it = 1;
```

To disable E-mail messages, comment out the following line:

```bash
$mail_it = 1;
```

To disable notification through the FEMIS Notification Service, comment out the following line:

```bash
$notify_it = 1;
```

### 2.13.4 Logging

AutoRecovery logging is performed through syslog and can be configured with the following levels:

- `warn` - log only warning messages
- `notice` - log warning messages and restart messages
- `info` - log all reported messages

The default log level is `info`.

To log both warning and restart messages, complete the following steps:

1. Edit `/etc/syslog.conf` and change:

   ```bash
   local7.info to local7.notice
   ```

   Log archiving is performed by the script `/opt/local/bin/logit`. This script is run nightly from the root crontab. The default number of logs archived is 7 days. The number of days archived can be configured by changing the value for `NUM_OF_DAYS_TO_ARCHIVE` in the `/opt/local/bin/logit` script.

   The log file is set in `/etc/syslog.conf`. The default log file is `/var/log/femislog`. The log file can be changed by editing `/etc/syslog.conf` and `/opt/local/bin/logit`.

2. Restart `syslogd`.

   ```bash
   % su -
   # sh /etc/init.d/syslog stop
   # sh /etc/init.d/syslog start
   ```

### 2.13.5 Sending E-mail

AutoRecovery sends all warning messages via E-mail to the root user by default. This configuration can be changed or added to by editing the file `/opt/local/bin/femis_watch.conf` and changing or
adding E-mail addresses to the `$Custodian` line. Note a single space separates each E-mail address. See the example below for clarification:

```
$Custodian = 'root femis admin@smtp.foo.com';
```

E-mail can be sent to any valid Simple Mail Transfer Protocol (SMTP) recipient. For instance, addresses can be to real users, local and remote server aliases, other mail gateways, and to files and/or programs for filtering. For syntax, and mail configurations to support expanded E-mail capability, consult your site’s mail server documentation.

### 2.13.6 Running Processes

AutoRecovery verifies certain processes are running. The processes are defined in `/opt/local/bin/femis_watch.conf`. The format is as follows: daemon name, minimum number of processes, maximum number of processes, time value, restartable flag, and restart command.

The following line is the default configuration for the syslog daemon. The line defines the syslog daemon process syslogd. A minimum of one process is to be running, and not more than three. Also, the time value specifies a one second wait before attempting to verify that a restart of the daemon was successful. The daemon is restartable, and the restart command is `sh /etc/init.d/syslog start`.

```
[ "syslogd", 1, 3, 1, 1, "sh /etc/init.d/syslog start" ],
```

The following line is the default configuration for only one NFS Maestro daemon, and it will restart the daemon if the number of processes is less than one.

```
["hclnfsd",1, 1, 1, 1, "sh /etc/init.d/hclnfs stop; sh /etc/init.d/hclnfs start" ],
```

**Note:** To effectively disable process monitoring (which we do not recommend), set min to 0, and max to a high number, such as 500.

The time value, mentioned above did not have functionality in previous versions of FEMIS (formerly known as the status flag). In this version the value specifies a time to wait (in seconds) before verification of a process restart is attempted. This applies to all so-defined restartable processes.

### 2.13.7 Monitoring Swap and Disk Space

AutoRecovery monitors used disk and swap space. The thresholds are defined in `/opt/local/bin/femis_watch.conf` and can be customized for each server.
The following are two examples of configuration changes.

1. Complete the following steps to change the swap space monitoring to report 60% full instead of 80% full:

   Edit /opt/local/bin/femis_watch.conf

   Change $swap = 80; to $swap = 60;

2. Complete the following steps to change the disk space monitoring to report when / (root file system) is 90% full:

   Edit /opt/local/bin/femis_watch.conf.

   Look for the "$disks = ( " section.

   Edit the line by changing [ "/" , 80 ], to [ "/" , 90 ].

### 2.13.8 Remote Host Auto-Carve and Auto-Insert

The database design in FEMIS v1.5 now allows AutoRecovery to dynamically remove and reinsert remote servers in a site configuration on the fly. This insertion and deletion primarily affects replicated database data, but also affects messages that AutoRecovery sends out. Four parameters in femis_watch.conf control how these functions behave. They are:

```plaintext
$auto_carve = 1;       # Allow auto_carve if defined
$auto_insert = 1;      # Allow auto reinsertion if defined
# Auto Carve threshold - meaningless if $auto_carve is not defined
$ac_threshold = 5;     # Defined in terms of number of AutoRecovery runs
# Auto Insert threshold - meaningless if $auto_insert is not defined
$ai_threshold = 1;     # Defined in terms of number of AutoRecovery runs
```

**auto_carve** and **auto_insert** define whether each respective feature is enabled. This is controlled with a zero (disabled) or one (greater than zero - enabled) value. The threshold values define the number of AutoRecovery runs required **before** the specific action occurs, and are defined in terms of AutoRecovery runs. Zero can be valid values for either threshold, although it is not highly recommended to use this value. Generally, the values shown are recommended.

**auto_carve** will remove a host from database push replication if the host is down (not reachable, or experiences listener and/or database process errors) for the number defined in $ac_threshold of AutoRecovery runs. For example, on the sixth consecutive failed run with the above set definitions, AutoRecovery will remove the problem server from push replication.

Conversely, as soon as the host becomes available again, on the second successful run of good status, it will be reinserted back into the database replication push configuration.
Please refer to Section 2.1, AutoRecovery, in the *FEMIS System Administration Guide Version 1.5.3* for further information.

### 2.13.9 Remote Process Monitoring

Previous versions of AutoRecovery did not allow any configuration to determine if a remote system was good or bad based on the processes running on that system. This version now has a section in the `femis_watch.conf` file which defines thresholds and values of processes on remote systems for determining if a remote system is “good” or not. The definition table is called `@femismon_proc`. This table must not have the entry order changed, nor any entries removed. Ignoring a particular process altogether is accomplished with an ignore flag which is set or cleared in the array definition. The table columns are defined as follows:

\[
<\text{descriptive \, daemon \, name}, \, \text{ignore\_-flag}, \, \text{min}, \, \text{max} >
\]

To ignore an entry, set `ignore_flag` to `!= 0`. To ignore the `femisdei` process, set the `$deicheck` variable in `femis_watch.conf` equal to `0`.

For example:

```
[ "OraArch", 1, 1, 1 ],
```

defines the eighth row in the `@femismon_proc` array. The ignore flag is greater than zero, so this value will be ignored when determining if a remote server is “good” or not. If it were not ignored, an error would be generated if there were less than, or greater than, one remote `OraArch` process, and the remote server would not have been considered available. The string “`OraArch`” has no bearing in this array on how the remote search is conducted. It is merely just a descriptive string name for output in the error message.

### 2.13.10 Remote Host Connectivity

AutoRecovery checks the availability of the other servers that are part of your EOC’s FEMIS database. These servers need to be specified in the `femis_watch.conf` in the following lines:

```
# Check the following network nodes for connectivity
@network = (‘host1’, ‘host2’, ‘hosts3’, ‘hosts4’);
```

Each of the server names located in the third column of the `/home/femis/etc/eoclist.dat`, except the local host, should replace each of the `host1`, `host2`, entries in the above line. Add or remove hosts from this line if the topology of the site changes. If operating FEMIS on an Nx1 configuration, then the local host has to be the single entry for the network parameter.

During the execution of AutoRecovery, each remote host is subjected to a ping command to verify it is available on the network. A connectivity test to port 1776 (FEMIS registered port) is then executed if the ping command was successful. The parameters of the ping command can be modified by two parameters in the `femis_watch.conf` file. These parameters are as follows:
# Pings to attempt
$ping_nr = 4;

# Ping threshold
$ping_threshold = 25;

The parameter $ping_nr sets the number of packets used by the ping command and $ping_threshold determines least acceptable percentage lost before AutoRecovery determines that the host is unreachable. Notification that a host is unreachable or the socket connection attempt failed will then be sent, and the Oracle Listener, database checks, and remote process checks for that host will not be performed by AutoRecovery.

### 2.13.11 AutoRecovery’s WatchDog Timeout Parameter

AutoRecovery now has a configurable timeout value in the femis_watch.conf file. In the event that AutoRecovery were to hang because of problems completing a command or spawned process, it will now force itself to abort processing if it is active for longer than the value defined in

```
$watchdog_timeout = 480;  # 480/60 = 8 minutes
```

where the value is defined in seconds.

**Note:** Setting the timeout value to something greater than the smallest crontab interval is an acceptable practice; however, subsequent AutoRecovery runs will complain about a previous run of AutoRecovery not completing and will exit if a run gets stuck. This will continue until the hung AutoRecovery process times out as defined. PNNL recommends that to avoid confusion, the value be set less than the smallest cron interval.

### 2.13.12 Oracle Job Monitoring Parameters

AutoRecovery contains several user configurable parameters that define what constitutes hung and late Oracle job scenarios in the femis_watch.conf file. These parameters are hard coded to default values if they do not exist in the configuration file. Otherwise, configuration file parameters override hard coded defaults. These parameters are as follows with their default values:

```
$hung_job_time = 35 minutes
$late_job_time = 30 minutes
$late_job_fail_count = 8 failures
```

The distinguishing feature for a hung job is that the current time minus the job’s start time has exceeded the threshold defined by $hung_job_time. This means the job has been running for longer than the defined $hung_job_time threshold. Correction is accomplished automatically in AutoRecovery by stopping the Oracle snapshot process handling the job’s function. Oracle then respawns a new process to handle the job.
In the case of a late job, this can occur under two different situations and does not indicate a stuck snapshot process if the job’s failure count has been incremented. No automated corrections are ever done on late jobs until they finally break (16 retries as defined by Oracle). Only informational messages are given regarding late jobs. A job can be considered late if its failure count is greater than 0 and the current time minus its last run time is greater than or equal to the value defined in $late_job_time, or its failures are greater than or equal to the value defined in $late_job_fail_count.

Most FEMIS Oracle jobs run in a very short amount of time (usually in terms of a few minutes); however, large data transfers on slow or troubled networks may take longer. The default times were selected to be substantially large considering field experience at most EOCs. Alterations of these values are not usually necessary from the defaults but may be done in situations where network data transfers are extremely slow or sporadic.

2.14 Installing the AutoRecovery Web Reporting Application

AutoRecovery monitors the FEMIS server and reports any errors to your System Administrator, using a standard E-mail message. Your System Administrator must log into E-mail and examine the messages to determine if a server has a problem. PNNL developed the AutoRecovery Web Reporting application to provide a more generic way for your System Administrator to examine the status of their systems.

Using the AutoRecovery Web Reporting application, messages can be sent to a central E-mail account. The E-mail is processed by AutoRecovery Web Reporting and displayed by a web server. Your System Administrator can view the status of your server using any browser application. AutoRecovery Web Reporting can be expanded to receive E-mail from each EOC. Using this capability allows all System Administrators to status their EOC server messages without installing a web server at each EOC.

2.14.1 Software Requirements for AutoRecovery

AutoRecovery Web Reporting requires the following applications:

- FEMIS AutoRecovery
- PERL v5.8
- MailTools v1.13 (a PERL extension included in the FEMIS PERL package)
- Apache Web Server.

FEMIS AutoRecovery and PERL are packaged separately. The Apache Web Server and the AutoRecovery Web Reporting scripts are included in the FEMISarw package.
2.14.2 AutoRecovery Web Reporting Description and Installation

If you are upgrading FEMIS, you must remove the previous version of the AutoRecovery Web Reporting package.

2.14.2.1 Removing the AutoRecovery Web Reporting Package

To remove the AutoRecovery Web Reporting package, complete the following steps:

1. Login as root.

2. Enter the following:

   # pkgrm FEMISarw

   Select y to continue when the following prompt displays: Do you want to remove this package?

   Also select y for this prompt: Removing installed package instance <FEMISarw>. This package contains scripts that will be executed with super-user permission during the process of removing this package. Do you want to continue with the removal of this package [y,n,?,q]?

3. Verify that the package was removed successfully.

2.14.2.2 Installing AutoRecovery Web Reporting

   Note: This package has dependencies on the Perl 5.004. The Perl package must be installed before you can install AutoRecovery Web Reporting.

To install AutoRecovery Web Reporting, which has been included with FEMIS v1.5, complete the following steps:

1. Login as root.

2. Insert the FEMIS application CD into the CD-ROM drive.

3. Enter the following:

   pkgadd -d /cdrom/cdrom0 FEMISarw.

4. Select y to continue when the following prompt displays: This package contains scripts which will be executed with super-user permission during the process of installing this package.
5. Select q to quit after installing the FEMISarw package.

6. Use pkgchk to verify the package was installed correctly.

```
# pkgchk -n FEMISarw
```

7. Ignore the following or similar errors:

```
ERROR: /etc/init.d/apache
  Permission <0700> expected <0744> actual
```

**Note:** If you only see the above output or your system prompt appears with no output, the package installed successfully.

8. Remove the CD from the drive.

### 2.14.3 Configuring AutoRecovery Web Reporting

To configure AutoRecovery Web Reporting, complete the following steps:

1. **Login as root.**

   Two new users, femisar and www (if they do not already exist), are created with the installation of the FEMISarw package.

2. **Be sure to set the femisar password.** Example: `passwd femisar`.

3. **Edit** `/opt/local/apache/htdocs/index.html`. Change `YOUR_SYSTEM_NAME_HERE` to your servername (e.g., tornado.pnl.gov).

4. **Edit** `/opt/local/apache/conf/httpd.conf`. Change the Server Admin variable to reflect the E-mail address of your System Administrator.

5. **Edit** `/opt/local/apache/htdocs/femis/mb/index.pl`. Change `root@localhost` to the System Administrator’s E-mail address (e.g., admin@pnl.gov).

6. **Edit** `/opt/local/apache/home/femisar/bin/mail.pl`. Change `root@localhost` to the System Administrator’s E-mail address (e.g., admin@pnl.gov).

7. **Edit all html files in the** `/opt/local/apache/htdocs/femis/help` directory. Change
   `http://tornado.pnl.gov` to `http://YOURSERVERNAME.YOURDOMAIN`. Change the E-mail address from `root@localhost` to the System Administrator’s E-mail address.
8. Run `/opt/local/apache/bin/setup_femisarw`. When prompted, enter the name of each server that will send AutoRecovery E-mail messages. The script will create a directory for each server with the appropriate permissions.

9. Start the web server.

```
sh /etc/init.d/apache start
```

10. Test the application with a web browser. The address should be

```
http://YOURSERVERNAME.YOURDOMAIN (e.g., http://tornado.pnl.gov)
```

11. Edit the `/opt/local/bin/femis_watch.conf` on each server from which you will receive AutoRecovery E-mail, and add `femisar` to the Custodian list (e.g., `$Custodian = 'femisar@yoursystem.yourdomain'`).

AutoRecovery Web Reporting is now available for you to use.

## 2.14.4 Customizing AutoRecovery Web Reporting

To customize AutoRecovery Web Reporting, complete the following sections.

### 2.14.4.1 Setting the $retainFlag Variable

The variable $retainFlag in `/opt/local/apache/home/femisar/bin/clean.pl` is used to control how old messages are removed from the MessageBase. The string is comprised of three parts. The first part is a single letter that specifies what method to use to remove the messages.

- If the letter is a p (pruned), then messages that are older than the current date minus the specification in the next two parts are removed.

- If the letter is a t (truncated), messages are removed at a time that is a multiple of the unit specification and modulus of the unit specification. In other words, if the span and unit specification is a 1d (1 day), then the messages that are older than midnight GMT of the previous day would be removed.

The next two parts are the number of units and the type of the unit. The number must be a positive whole number or 0. The unit code may be one of the following: s, m, h, d, or w, which stand for seconds, minutes, hours, days, or weeks. These number and type of units could be used in a specification, such as `t0d` that would remove all messages before the current day (Greenich Mean Time [GMT]).

The default is set to `p24h`. 

2-65
2.14.4.2 Changing the Refresh Rate

To change the refresh rate of the AutoRecovery Web Reporting application, edit `/opt/local/apache/htdocs/femis/mb/index.pl`. The default is set to 60 seconds. To change the default value, change `content="60"` to your preferred refresh rate.

2.14.4.3 Customizing the Apache Web Server

For additional information on customizing the Apache Web Server, see the online manual at http://<your server name>/manual or go the Apache Web Page at http://www.apache.org.

2.15 Installing Web OSB

Before installing Web OSB, previously installed Web OSB software needs to be removed by completing the following steps.

1. Remove previously installed Java 2 directory `/usr/j2sdk`...

2. Remove the WebOSB directory. The FEMIS Web OSB v1.5.3 will be installed in `/opt/WebOSB`. Previous locations on servers can vary, but is typically located on the same disk as the FEMIS software.

3. Check and remove any root cron for entries that stopped and restarted Web OSB.

2.15.1 Installing Java™ 2 Runtime Environment 1.4.1

Web OSB requires Java™ 2 be installed. This can be installed from packaged software released by Sun and included on the FEMIS 1.5.3 Application CD. To install the Java2 package, complete the following steps:

1. Login as root.

2. Insert the FEMIS application CD into the CD-ROM drive.

3. Enter the following command to install the Java packages:

   ```
   # pkgadd -d /cdrom/cdrom0 SUNWj3rt
   # pkgadd -d /cdrom/cdrom0 SUNWj3dev
   ```

   Answer the questions as prompted by the package installation programs. The packages need to be installed in the `/usr` directory or Web OSB will not work.
2.15.2 Installing the Web OSB Package

The Web OSB package installs new software to the following locations:

- Jakarta-Tomcat 4.1.12 – /opt/WebOSB/jakarta-tomcat-4.1.12-LE-jdk14
- MySQL 3.23.40 – /opt/WebOSB/mysql-3.23.40-sun-solaris2.7-sparc
- Web OSB Software – /opt/WebOSB/webfemis

To install the Web OSB package, complete the following steps:

1. Login as root.

2. Insert the FEMIS application CD into the CD-ROM drive.

3. Enter the following command to install the FEMIS package:

   # pkgadd -d /cdrom/cdrom0 WebOSB

4. Answer the questions as prompted by the package installation program. Answer y to the following message:

   The following files are already installed on the system and are being used by another package:
   /etc <attribute change only>
   /etc/init.d <attribute change only>
   /usr/java

5. Run the Web OSB setup script to create the /opt/WebOSB/webnotify.sh and /opt/WebOSB/mysql/dbs.sql files.

   #/opt/WebOSB/setup.sh

   **Note:** If you need to set up Web OSB to connect to FEMIS databases located on all the servers at your site, run /opt/WebOSB/setup.sh -a.

   **Note:** If you are installing Web OSB on a server that does not have FEMIS installed, the setup.sh script will fail. The webnotify.sh and dbs.sql scripts can be created by copying the dbs.pl and notify.pl to the FEMIS server and as the femis user, run dbs.pl > dbs.sql and notify.pl > webnotify.sh. Move these two created files back to the Web OSB server to their appropriate directory (reference setup.sh for locations). Run chmod u+x on webnotify.sh to make the script executable. The Perl scripts dbs.pl and notify.pl can also be run with the -a option.
2.15.3 Generating Secure Certificate

The website needs a secure certificate generated to allow secure connections. To generate a certificate for your web server, complete the following steps.

1. Login as root.

2. Enter the following if you are upgrading from a previously installed Web OSB installation to delete a previously generated certificate.

   # /usr/java/bin/keytool -delete -alias tomcat

3. Generate the certificate by entering the following:

   # /usr/java/bin/keytool -genkey -alias tomcat -keyalg RSA

4. Enter the password changit, when prompted.

5. Enter the name of the server you are installing on when prompted for “What is your first and last name?”. Answer the remaining questions as asked.

2.15.4 Setting Up MySQL

1. Login as the root.

2. Change your location to the MySQL directory

   # cd /opt/WebOSB/mysql

3. Enter the following command to install the MySQL software.

   #./scripts/mysql_install_db

4. Change the ownership of the data directory to enable use by the mysql user.

   #chown -R mysql:mysql data

5. Start the MySQL database.

   #/etc/init.d/mysql start

6. Login to MySQL as root, set the root user password, grant the webosb user access to the spar database and set its password. You can replace the word “new-password” with a password you can remember.
# ./bin/mysql
mysql> use mysql
mysql> update user set password=password('new-password') where user = 'root';
mysql> grant all privileges on spar.* to webosb@localhost identified by 'webosb'
with grant option;
mysql> flush privileges;
mysql> exit

7. Login to MySQL as the user webosb, and configure the dbs tablespace in the spar database to match your FEMIS database configuration.

# ./bin/mysql -u webosb -p
   enter webosb (when prompted for the password)
mysql> use spar
mysql>

8. Verify the dbs table has been configured for the databases on the server.

   mysql> select * from dbs;

9. Exit MySQL.

   mysql> quit

2.15.5 Running Web OSB

Start Web OSB by running /etc/init.d/webosb start. This will start the jakarta-tomcat web server and a notification process for each database. You can verify it is operating successfully using Internet Explorer version 5 and above with the Java 2 plug-in (j2re-1_4_0-win.exe) installed (The Java 2 plug-in is available on the FEMIS v1.5.3 COTS CD). The URL will be https://<server>/WebFemis (Note that the URL is case sensitive).

2.16 Creating a CD to Perform PC Installations of FEMIS

To create a PC installation CD for FEMIS, copy the following directories and all of their subdirectories from the /home/femis directory on the FEMIS server to the root of the CD you are creating:

   configd/
gis/
pc/

Note: Do not create this CD until after all of the server configuration has been completed since some of the files under configd are edited during that configuration.
After burning the CD, you can install directly from the CD, as you would from a mapped drive.

If your site’s GIS does not fit onto a single CD, you can create a single CD if you do not install the large GIS. (The FEMIS installation program does not deal with multiple CD volumes.) Using Alabama as an example, modify the above instructions as follows: copy the three directories to the CD including all of their subdirectories except `gis/anad/images/im_24k/`. When installing on a PC, be sure to select the Medium or Small GIS option.
3.0 FEMIS GIS Migration

The GIS migration from FEMIS v1.5 to v1.5.3 only requires an update of the FEMIS version number to the FEMISGIS.INI file. This update was accomplished during the FEMIS package installation in Section 2.0, FEMIS UNIX Installation. No further upgrades are necessary.
4.0 FEMIS PC Installation

The following sections describe the steps needed to install FEMIS on a PC.

4.1 Installing the PC COTS

The order for installing the COTS on a new FEMIS PC is as follows:

1. Windows 2000 Service Pack 2 or Windows NT 4.0 Service Pack 6
2. Internet Explorer 4 or above (for Windows NT only)
3. Oracle Net8 Client v8.1.6 and ODBC Driver v8.1.6.2
4. ArcView GIS v3.1 and v3.1.1 patch
5. Microsoft Data Access Components (MDAC) v2.1 (only for new installs on Windows NT 4.0 PCs).

At the end of this section, PNNL has provided two checklists that can be used for each PC installation.

- FEMIS PC Installation Checklist
- FEMIS PC Validation Checklist.

4.1.1 Installing Windows 2000 Service Pack 2 or Windows NT 4.0 Service Pack 6

Service packs for the operating system are on the COTS CD for FEMIS v1.5.3. For Windows 2000 Service Pack 2 should be installed and for Windows NT 4.0 Service Pack 6 should be installed.

To install Windows 2000 Service Pack 2, insert the FEMIS v1.5.3 COTS CD into the CD drive and complete the following steps.

1. Double-click on `<COTS DRIVE>\W2KSP2\w2ksp2.exe` to extract the files.
2. Accept the license agreement, and the installation process begins.
3. Restart the PC when the installation process has completed.
To install Windows NT Service Pack 6, insert the FEMIS v1.5.3 COTS CD into the CD drive and complete the following steps:

1. Double-click on `NT4SP6a/SP6I386.EXE` to extract the files.
2. Accept the license agreement, and the installation process begins.
3. Restart the PC when the installation process has completed.

### 4.1.2 Installing Oracle Net8 Client v8.1.6 and ODBC Driver v8.1.6.2

Both Oracle Net8 Client v8.1.6 and ODBC Driver v8.1.6.2 must be installed for FEMIS v1.5.3. If you are upgrading from FEMIS 1.5, these should already be installed.

#### 4.1.2.1 Installing Oracle Net8 Client v8.1.6

**Note:** When Oracle Universal Installer is installed, Java Runtime Environment 1.1.7.24 will also be installed. If you use a later version, you may need to reinstall it.

To install Oracle Net8 Client v8.1.6, insert the FEMIS v1.5.3 COTS CD into the CD drive and complete the following steps:

1. Login to Windows as a user with **Administrator** privileges.
2. Start Windows Explorer, and browse to `<COTS drive letter>:\Oracle816`.
3. Select the `SETUP.EXE` program, and run it by clicking **Open** and **OK**. The Oracle Universal Installer will start.
4. Click **Next** on the Welcome window.
5. Check the path on the File Locations window under Destination Path if you are upgrading to ensure Oracle installs in the same path where v8.1.5.3 was installed. Click **Next** to continue.
6. Choose **Custom** on the Installation Types window. Click **Next**.
7. Ensure boxes on the Available Products window are checked next to the following products.

   - **Net8 Products**
     - **Net8 Client**
   - **Net8 Client**
   - **Oracle Installation Products**
     - **Oracle Universal Installer**
Uncheck all unneeded products.

**Note:** These are the minimum required products for FEMIS. If you need additional items, they can be installed also, but it may require additional configuration during setup that is not covered in this document.

Click Next.

8. Click Next on Component Locations window.

9. Click Install on the Summary window.

After Oracle products are installed, the Configuration Tools window may appear and attempt to run the Net8 Configuration Assistant. If this happens, select the Net8 Configuration Assistant and click Cancel. Click Yes to confirm the cancellation, click OK on the error message window that appears, and then click Next.

10. Click Exit on the End of Installation window—unless you need to install the ODBC Driver v8.1.6.2, then click Next Install and proceed to Step 3 of the next section.

### 4.1.2.2 Installing Oracle ODBC Driver v8.1.6.2

Before you can install the ODBC driver 8.1.6.2, Oracle Net8 Client 8.1.6 must be previously installed. Insert the FEMIS v1.5.3 COTS CD into the CD drive and complete the following steps:

1. Click Start → Programs → Oracle Installation Products → Universal Installer.

2. Click Next in the Welcome window.

3. Browse to `<COTS drive>:\ODBC8162\Disk1\stage\products.jar` for the Source... Path. Click Next.

4. Click Install in the Summary window.

5. Click Exit in the End of Installation window.

### 4.1.3 Installing Microsoft Data Access Components on Windows NT PCs

**Note:** If you have FEMIS v1.5 installed, Microsoft Data Access Components (MDAC) has probably been installed on Windows NT PCs. If this is a new install on a Windows NT PC, then complete this section.
For PCs using Windows NT 4.0, the MDAC needs to be upgraded from the default version installed during setup of the NT 4.0 operating system. Many Microsoft programs upgrade these components automatically so installation may not be necessary, but they should be installed in case the components are not correct. To install MDAC, insert the FEMIS COTS CD into the CD drive, and complete the following steps:

1. Login to Windows as a user with Administrator privileges.
2. Select `<CD drive>:\mdac_typ.exe`, and run it.
3. Click Next after checking the license agreement.
4. Click Finish to install the software, and click Close when installation is done.

### 4.1.4 Installing ArcView GIS v3.1 and v3.1.1 Patch

If you have FEMIS v1.4.7.2 installed, ArcView v3.1 and v3.1.1 patch should already be installed so you can skip this section.

**Note:** If you reinstall ArcView GIS after having already installed FEMIS, the correct version of the file DEFAULT.APR will be overwritten by the ArcView GIS installation. Copy the DEFAULT.APR file from your C:\FEMIS directory to the `<DRIVE>\ESRI\AV_GIS30\ARCVIEW\ETC` directory on the PC. If you cannot find C:\FEMIS\DEFAULT.APR, then the file may be copied from `/home/femis/pc/femmisc/ on your server.`

**Note:** ArcView GIS v3.1 must be installed on the computer before you install the v3.1.1 patch, and the patch must be installed for FEMIS to work properly.

If an older version of ArcView GIS is currently on the PC, remove it before installing ArcView GIS v3.1.

**Note:** If more than one version of ArcView GIS is installed on the PC, FEMIS will find the most recently installed version. If you have multiple versions of ArcView GIS installed, check the %WINDIR%\FEMIS.INI file after the FEMIS installation is complete to make sure that the file references the correct installation.

### 4.1.4.1 Installing ArcView GIS v3.1

You will need to have the ArcView GIS license number for this installation. The CD key number is located on the ArcView GIS installation disk or included with its documentation.
To Install ArcView GIS v3.1, insert the FEMIS COTS CD into the CD drive, and complete the following steps:

1. Login to Windows as a user with Administrator privileges.

2. Select `<CD drive>:\AV3.1\SETUP.EXE`, and run it.

3. Click Next in the Welcome window.

4. Click Yes in the License Agreement window.

5. Choose Local install for installation type. Click Next.

6. Select Custom and other options you may want to install. Click Next.

   **Note:** If you are upgrading, click Yes to replace current installation.

   If you are attempting to upgrade and you are not prompted to replace the current installation, click Back and verify the install destination has ArcView installed.

7. Deselect the Map data and Launch Seagate Crystal Reports 6.0 setup. Click Next.

   **Note:** Map data and Seagate Crystal Reports are not used by FEMIS but can be installed if desired.

8. Click Next to accept the defaults for Program Folders and Existing Folders. The Start Copying Files window displays.

9. Click Finish to start copying the files.

10. Click OK in the information window.

11. Click Yes and Finish on the Setup Complete window to restart the computer.

12. Re-logon to the computer using the same user account that was used to install ArcView.

13. Click Start → Programs → ESRI → ArcView GIS version 3.1 → ArcView GIS version 3.1.

14. Enter the name and organization and the ArcView GIS license number. Click OK, and ArcView GIS will start.

15. Deselect the Show this window when ArcView GIS Starts box on the Welcome to ArcView GIS window. Click Cancel.
16. Click File Æ Exit to close The ArcView GIS v3.1 application.

4.1.4.2 Installing ArcView GIS v3.1.1 Patch

Note: ArcView GIS v3.1 must be installed before installing ArcView GIS v3.1.1 patch.

To Install ArcView GIS v3.1.1 patch, insert the FEMIS COTS CD into the CD drive, and complete the following steps:

1. Login to Windows as a user with Administrator privileges.
2. Select <CD drive>:\AV3.1 PATCH\AV31PATCH.EXE, and run it.
3. Click Yes to continue the installation of ArcView GIS v3.1.1 patch.
4. Click Next to accept the default Local Install.
5. Click Next to accept the default destination location.
6. Click Next in the Review Current Settings window that displays inside the Start Copying Files window.
7. Click Finish and reboot the PC before using ArcView GIS v3.1.

4.1.4.3 Creating the ArcView GIS Icon for All Users

The ArcView installation only installs the ESRI Program folder that contains the ArcView GIS 3.1 icons for the user that installed the software. If you would like more than this user to run ArcView from Program folders, you will need to copy the ESRI Program folder to the All Users profile.

FEMIS does not require ArcView GIS v3.1.1 be in Program folders.

To copy the Program folder from the installer’s user profile to the All Users profile, use the following procedure:

1. Login to Windows as a user with Administrator privileges.
2. Browse to the %WINDIR%\PROFILES\<Installation user>\Start Menu\Programs or %SYSTEMDRIVE%\DOCUMENTS AND SETTINGS\<Installation user>\Start Menu\Programs.
3. Right click on the ESRI folder and select Cut.
4. Browse to the %WINDIR%\PROFILES\All Users\Start Menu\Programs or %SYSTEMDRIVE%\DOCUMENTS AND SETTINGS\All Users\Start Menu\Programs.
5. Right click on the Programs folder and select Paste.

### 4.1.5 Installing Other COTS

The following COTS products should be installed using the installation documentation for each product.

**E-mail application** (if desired)

Use the standard product installation notes provided with the software.

### 4.2 Configuring the FEMIS Setup Program

---

**CAUTION**

Configuration is only done once at each EOC. Stop PC installation until all configurations have been performed.

---

Several other files must be configured for your site or EOC. Most of these files should have been configured during the FEMIS UNIX installation but should be validated before installing the FEMIS application on the PCs.

**Note:** Directories specified below are from the PC. You will need to use the UNIX version of these directories if you are editing files from the UNIX server.

#### 4.2.1 Connecting the Network Install Drive

To connect the FEMIS network drive to the install directory, complete the following steps. The parts in *italics* are what should be changed.

1. Obtain the shared name of the FEMIS account home directory from your System Administrator. Example: `\<server\>\femis`.
2. Open Windows Explorer.
3. Select **Tools** ➔ **Map Network Drive** menu option, and fill in the fields in the Connect Network Drive window as follows.

   - **Drive:** `I:\`
   - **Path:** `\<server>\femis`
For Windows 2000, click on Connect Using a different user name. On the Connect As window, enter as femis in the User name field and in the Password field, enter the server femis account password.
For Window NT, Connect as: femis and enter femis in the Connect as: field. Enter the server femis account password when prompted.

Any available drive letter can be used in place of I:\ for the installation drive. However, this documentation will assume that FEMIS is being installed from the I:\ drive. If you have another drive mapped to the server (such as M:\) as a user other than femis, you will need to disconnect it.

4.2.2 Validating the I:\CONFIGD\FSETUP.INI File

The FEMIS Setup program uses a configuration file to determine the defaults for the installation. Validate that the I:\CONFIGD\FSETUP.INI file was correctly configured during the server installation.

Note: The site and EOC values need to be uppercase.

The first section of the INI file, the [Setup Defaults] section contains entries that set defaults for the Setup program. Starred items (*) are those that should have been configured by the UNIX installation scripts.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site*</td>
<td>Default site code. This should be the FEMIS four-letter code for your site.</td>
</tr>
<tr>
<td>EOC*</td>
<td>Default EOC code. This should be the FEMIS four-letter code for your site.</td>
</tr>
<tr>
<td>DestDir</td>
<td>Default installation destination directory for new installations. Re-installations and upgrades will default to the current FEMIS path.</td>
</tr>
<tr>
<td>Version</td>
<td>Gives the version of FEMIS for which this instance of FSETUP.INI was created.</td>
</tr>
<tr>
<td>DateThisFSETUPCreated</td>
<td>Gives the build date for this version of FEMIS.</td>
</tr>
<tr>
<td>mDriveNetPath*</td>
<td>Path to the FEMIS M:\ drive that the FEMIS startup script will connect. This does not need to be set if you use an alternate method to map the M:\ drive. Enter this specification only if you desire to have fstartup.exe attach the M:\ resources on the majority of PC installations.</td>
</tr>
<tr>
<td>LocalStartupScript</td>
<td>Full path for a local startup script to be run by the FEMIS startup script. This is optional.</td>
</tr>
<tr>
<td>EMIS_StartupScript</td>
<td>Full path to the EMIS startup script file. The FEMIS startup script file will run this file.</td>
</tr>
<tr>
<td>fupdateLocation</td>
<td>The UNC Path for the location of FUPDATE.BAT is used to update files on the user’s PC. Refer to Section 4.2.7, Updating Files on All PCs Using FUPDATE.BAT.</td>
</tr>
</tbody>
</table>
The second section of the INI file, the [Sites] section, is used to fill the Site drop-down list in the Select Site and EOC window in the PC Setup program. You can edit this list to limit the possible selections available in Setup. Each site entry must be formatted as SiteNN=<SITECODE> where NN is a two-digit integer and <SITECODE> all uppercase. If you shorten the list of sites to a single entry, the user will be forced to accept that entry when running Setup. If you edit the list, the numbering for the sites must be sequential, starting at 01.

Subsequent sections are lists of EOCs for each site in the [Sites] section. Each site listed in the [Sites] section must have a corresponding [<SITECODE> EOCs] section. These sections are used to fill the EOC drop-down list in the Select Site and EOC window in the PC Setup program when the corresponding site is selected on the same window. The EOC list sections can be edited in the same manner as the Site list. Each EOC entry must be formatted as EOCNN=<EOCCODE> where NN is a two- digit integer and <EOCCODE> must be all uppercase. If you shorten the list of EOCs to a single entry, the user will be forced to accept that entry when running Setup. If you edit the list, the numbering for the sites must be sequential, starting at 01. EOC list sections that do not have a corresponding site listed in the [Sites] section will be ignored.

4.2.3 Validating the I:\CONFIGD\TNSNAMES.ORA File

The TNSNAMES.ORA file should be configured with the correct database names, listeners, and IP addresses. This file should be a copy of $TNS_ADMIN/TNSNAMES.ORA on the UNIX server. For each listener on each server, it should contain a section like the following. The parts in Italics are what should be changed.

```plaintext
fi_ctoo =
  (DESCRIPTION =
   (ADDRESS_LIST =
    (ADDRESS =
      (COMMUNITY = TCP)
      (PROTOCOL = TCP)
      (HOST = ctoosun.utah.gov)
      (PORT = 1521)
   )
   (CONNECT_DATA =
    (SID = fi_ctoo)
   )
  )
... 
```

Note: The setup program will not copy the TNSNAMES.ORA file to a PC if that PC already has a TNSNAMES.ORA file. See Section 14.2, FUPDATE.BAT in the System Administration Guide for FEMIS Version 1.5.3 for more details on how to configure FUPDATE.BAT, if you need to update the TNSNAMES.ORA file on all of the PCs that will be running FEMIS.
4.2.4 Validating the I:\CONFIGD\ADDODBC.BAT File

FEMIS uses the I:\USER\ADDODBC.BAT batch file to add all the necessary ODBC data source names to each PC. Verify that the mapping from EOC code to listener ID is correct for each line.

4.2.5 Validating the I:\CONFIGD\AUTOEXNT.BAT File

During the installation process, the I:\CONFIGD\AUTOEXNT.BAT file is copied to the %WINDIR%\SYSTEM32 directory, usually C:\WINNT\SYSTEM32. This file should contain the following commands. The <TEMPLATE_HOSTNAME> should have been changed to the name of the FEMIS UNIX server.

```bash
net stop NetWorkTimeProtocol
%WINDIR%\SYSTEM32\PING -w 60000 TEMPLATE_HOSTNAME
%WINDIR%\SYSTEM32\NTPDATE -b TEMPLATE_HOSTNAME
net start NetWorkTimeProtocol
```

The AUTOEXNT.BAT file is invoked at boot up. Its purpose is to synchronize time on the PC while bypassing the usual NTP time adjustment algorithms. NTPDATE immediately sets the time on the PC to be the same as on the UNIX server. After boot up, the usual NTP algorithms apply.

4.2.6 Validating the I:\CONFIGD\NTP.CONF File

During the installation process, the NTP.CONF file is copied to the %WINDIR% directory, usually C:\WINNT.

The NTP configuration file on the PC should contain at a minimum one drift file and one-or-more server directives. The format of the drift file directive is driftfile %WINDIR%\NTP.DRIFT, where %WINDIR% usually is C:\WINNT.

The format of the server directive is server <hostname>, where hostname is the name of the UNIX server from which the PC is to acquire time synchronization. Generally, this is the UNIX computer located on the same Local Area Network (LAN) as the PC. PCs should acquire time synchronization first from the closest UNIX computer and not from some distant host on the WAN or the Internet. Distant hosts can be used as a secondary time synchronization source. To designate the primary NTP host, include the keyword, prefer, in the server directive.

As an example, the following NTP.CONF file is the preferred format for NTP configuration. It lists the local UNIX server as the preferred time server and the other (far away) servers as secondary. In this manner, if the preferred host is inaccessible, one of the secondary servers can provide time synchronization:

```conf
server    <IP address of UNIX server> prefer
server    <IP addresses of other servers on WAN>
```
The Network Time Protocol service is very sensitive to the format of this file. Occasionally, in transferring this file from between UNIX and Windows computers, extra carriage return characters will be appended to the end of each line in this file. These extra characters are not detectable in a PC editor, but show up as “^M” characters at the end of each line in a UNIX editor, such as vi. These extra characters at the end of a line with a server directive will prevent the Network Time Protocol service from loading correctly. If the Network Time Protocol service does not appear to be working, this should be checked.

For more details on NTP set up and configuration methods, see Section 10.0, Server Network Time Protocol (NTP) Set Up, in the System Administration Guide for FEMIS Version 1.5.3.

4.2.7 Updating Files on All PCs Using FUPDATE.BAT

FUPDATE.BAT is a utility that can be used to update any file(s) on all FEMIS PCs such as the HOSTS file or GIS data files. View the I:\user\fupdate.bat file itself for specific instructions on how to configure it to update files on all FEMIS PCs.

See Section 14.2, FUPDATE.BAT in the System Administration Guide for FEMIS Version 1.5.3 for more details on how to configure FUPDATE.BAT.

4.2.8 Updating the PC HOSTS File

Depending on the DNS and TCP/IP configurations for the local PCs, it may be necessary or desirable to update the HOSTS file on PCs as part of the FEMIS installation. If the PC does not have a HOSTS file and one has been configured on the installation server in the /home/femis/configd directory, the PC Setup program will copy that file to the PC. However, if a HOSTS file already exists on the PC, the PC Setup program will not overwrite it.

If it is decided to update the HOSTS file on all PCs, the update should be done using the FEMIS FUPDATE tool. The FUPDATE tool is run as part of the PC Setup program, so updates will be installed when FEMIS is installed. FUPDATE is also run each time a user logs into a PC, so updates, that are configured after one or more PCs have been installed, will still be copied to those PCs.

Note: The setup program will not copy the HOSTS file to a PC if that PC already has a HOSTS file. See Section 4.2.7, Updating Files on All PCs Using FUPDATE.BAT, if you need to update the HOSTS file on all of the PCs that will be running FEMIS.
4.3 Installing the FEMIS Client Software

This software is for the PC workstations that are connected to the FEMIS data server and contains the FEMIS client software and a collection of GIS theme files. The installation program for the FEMIS client software assumes the necessary COTS packages have already been installed.

The FEMIS client software is installed over the network from a UNIX server. The client software contains over 120 files representing approximately 50 MB of file space.

The FEMIS executable and other FEMIS support files will be loaded to the following locations:

- **current %WINDIR% directory, usually C:WINNT or C:WINDOWS**
- %WINDIR\SYSTEM32 directory
- C:FEMIS directory

All files needed by the installation process should have previously been copied from the release tape or CD to the server. The files specified in Section 4.2, Configuring the FEMIS Setup Program, should have been configured or validated before the FEMIS client software is installed.

### 4.3.1 Preparation

To prepare for starting to install FEMIS v1.5.3, complete the following steps:

1. Login to Windows as Administrator or to a Windows account that has administrator privileges. In order for FEMIS to be installed correctly and work properly, it must be installed from an account that has administrator privileges.

2. Verify that all COTS needed by FEMIS are installed on the PC. At the minimum, the following should be installed (the Setup program will also verify that these are installed).

   - Microsoft Windows 2000 Service Pace 2 or Windows NT 4.0 Service Pack 6
   - Oracle Net8 v8.1.6
   - Oracle ODBC Driver v8.1.6.2
   - ArcView GIS (ESRI) v3.1 and v3.1.1 Patch.

   **Note:** FEMIS also requires the PC to connect drives to directories on the FEMIS server. If Samba is being used on the server, no additional software is required on the PC. If an NFS software package such as Hummingbird Maestro or Sun Solstice NFS Client is being used, then the client software needs to be installed on the PC.

3. Close all programs that are running, especially all FEMIS programs, including KeyPrint.
4. Open Windows Explorer, select Tools → Map Network Drive menu option, and fill in the fields in the Connect Network Drive window as follows.

<table>
<thead>
<tr>
<th>Drive:</th>
<th>I: \</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path:</td>
<td>&lt;server&gt;\install</td>
</tr>
</tbody>
</table>

If you are upgrading from a previous version of FEMIS, uninstall the previous version of FEMIS by completing the following steps:

1. Open Add/Remove Programs window by selecting Start → Settings → Control Panel → Add/Remove Programs.

2. Select FEMIS, and click the Remove button.

   If you are asked for the path to the FEMIS.MSI file, browse to I: \pc\setup\v15\FEMIS.MSI, open the FEMIS.MSI file.

3. Click OK on the message to restart the PC, if you get a message about restarting your PC.

4.3.2 Running the Setup Program

The FEMIS Oracle database on the UNIX server must be operational before the setup program is run.

1. Run the I: \ drive, and run the I: \PC\SETUP\SETUP.EXE program, and click Next on the Welcome window.

   **Note:** The Windows Installer may need to be installed on some Windows NT PCs. If so, the setup program will install it, and you will need to restart the PC. If the setup program fails to continue after restarting, remap the I: \ drive, and rerun SETUP.EXE.

   If you are installing on a Windows NT PC, you may get the following error: Internal Error 2755. 1631, I: \pc\setup\femis.msi. This indicates that a registry key in HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\Environment contains a null value. The workaround for this problem is to remove null environment variables before running the setup program.

2. Click Next on Select Site and EOC. This allows you to select the Site and EOC from drop-down lists. The contents of the lists are controlled by the I: \CONFID\FSETUP.INI file.

3. Click Next on Custom Setup. This allows you to select which FEMIS features will be installed.

   Verify the FEMIS Location is correct, and click Next. The default location is C: \FEMIS.
4. Verify the GIS path, and click Next on Select GIS Size and Location. To change the GIS path, click the Change button. To change the GIS size, click on the appropriate size.

**Note:** If FEMIS was previously installed on the PC and is being upgraded, you can select the upgrade checkbox. Upgrading will regenerate the FEMIS GIS, but it will not recopy the GIS data from the server. It will use the GIS data that is already on the PC.

5. Click Install. The program features you selected will be installed. This may take several minutes.

**Note:** You may see improved performance from the FEMIS GIS if you choose to install the GIS on a separate physical disk than the one on which you are installing FEMIS.

Your default database will be set.

As part of this step, the following processes are completed:

- The FEMIS.INI for the PC name, FEMIS and GIS directories, and COTS paths are updated.
- ArcView opens to convert the FEMISGIS.INI file to v1.5.3 format (if applicable) and to regenerate the FEMISGIS.APR file.
- ODBC information for the FEMIS databases is added.
- NTP service to synchronize time on the PC with the server is installed.
- The C:\WINNT\SYSTEM32\AUTOEXNT.BAT file is created.
- Obsolete files from older FEMIS installations are removed.
- FEMIS environment variables, if needed, are added.

6. Select Yes, I want to restart my computer now. on the Setup Complete window, if prompted. Click Finish.

7. Log back in as Administrator after the PC restarts.

### 4.3.3 Regenerating the FEMIS GIS Dynamic Themes

The FEMIS GIS has both static and dynamic themes. The Setup program installs the files for the static themes. The files for the dynamic themes are generated by the FEMIS application from data stored in the FEMIS relational database. These dynamic theme files need to be regenerated after installing (or reinstalling) FEMIS on a PC.
To regenerate the dynamic GIS themes, complete the following steps:

1. Start FEMIS and log in.

2. Select Operations mode, and click OK.

3. Click Utility on the menu bar, and select Regenerate Map Layers ➔ Regenerate Point Map Layers.


5. Exit FEMIS.

### 4.4 Configuring the PC

To configure the PC, several configuration and verification processes need to be completed.

#### 4.4.1 Windows XP Only: Configuring FEMIS to Run in Windows 2000 Compatibility Mode

Some functions of FEMIS do not behave as designed on PCs using Windows XP. To correct this behavior on Windows XP PCs, configure FEMIS (`FEMIS.EXE`) to run in Windows 2000 Compatibility mode by completing the following steps. Other programs on that PC will run in normal XP mode.

1. Open Windows Explorer and browse to the FEMIS installation folder, usually `C:\femis`.

2. Right-click on the `FEMIS.EXE` file, and select Properties.

3. Select the Compatibility tab.

4. Check the checkbox next to Run this program in compatibility mode for, and then select Windows 2000 from the drop-down list.

#### 4.4.2 Adding User Accounts to Windows 2000, NT, and XP

To add a user account on a PC, log onto the system with an account with Administrator privileges and complete the following steps:
Windows 2000

1. Click Start → Settings → Control Panel → Users and Passwords.

2. Select the Advanced tab, and click the Advanced button under Advanced User Management.

Windows NT

1. Click Start → Program → Administrative Tools → User Manager.

2. Select New User under the User menu item.

Windows XP

1. Click Start → Control Panel → User Accounts.

2. Select the Advanced tab, and click the Advanced button under Advanced User Management.

3. Right click on the Users folder, and select New User.

   Enter values for the following fields:

   Username:
   Full Name:
   Description:
   Password:
   Confirm Password:

4. Check with your System Administrator to determine which of the following options should be checked.

   User must change password at next logon
   User cannot change password
   Password never expires
   Account disabled

4.4.3 Configuring User Accounts

After creating the Windows account, verify the account is at least in a member of the Standard User (Power User) Group for Windows 2000/XP. If they are only members of the user group FEMIS operations will return errors when attempting to write to files not located in the users profile directory. If you require PC users be only members of the user group, write permissions need to be enabled for the user group on the following files/directories:

- %WINDIR%\FEMISUSR.INI
- %TEMP% as defined in the system variables (usually C:\TEMP). If the folder does not exist, you will need to create it.
- The directory where the FEMIS GIS was installed.
- The FEMIS USER directory (%FEMISTOPDIR\User).

### 4.4.4 Running the FEMIS FSTARTUP.EXE

Periodically updates may be required for the FEMIS software. To make these updates as easy as possible, a program is installed with FEMIS called FSTARTUP.EXE. This program uses information located in the %WINDIR%\FEMIS.INI to install updates from the FEMIS server. The %WINDIR%\FEMIS.INI contains values that indicate the location of the update script FUPDATE.BAT (usually \<server>\user) and any drives that need mounted. The FSTARTUP.EXE program should be run automatically when a user logs into Windows. Depending on how your network and PCs are set up, use one of the two methods listed below for the program to run automatically.

**Method 1: As a User Login Script**

1. Use the Local Users and Groups management console for Windows 2000/XP or User Manager for NT as instructed in Section 4.4.2, Adding User Accounts to Windows 2000, NT, and XP.

2. For every user account that will run FEMIS, select the user in the list. Then select the menu item Properties or Action, and click the Profile button or tab on the form that appears. If you use a domain to manage user accounts, this should be done on the domain server. Otherwise, this should be done on each PC that is used for FEMIS.

3. In the Logon Script Name field, enter FSTARTUP.EXE.

**Method 2: In Startup Folder**

1. Using Windows Explorer, open the %AllUsersProfile%\START MENU\PROGRAMS\STARTUP folder. From the File menu, select New → Shortcut, and a Create Shortcut dialog box displays. At the Command Line, enter %WINDIR%\SYSTEM32\REPL\IMPORT\SCRIPTS\FSTARTUP.EXE, and click Next. Enter a name for the shortcut, such as FEMIS Startup Script.

See Section 4.2.2, Validating I:\CONFIGD\FSETUP.INI File if you wish to customize the startup. You can specify additional drives to be mapped by the FEMIS startup script, and specify local startup scripts to be run after the drives have been mapped.

### 4.4.5 Verifying the Temporary Directory and Environment Variables

The GIS and other programs need a directory to store temporary files. Use the following steps to verify that this process was completed correctly by the Setup program.
1. Select `Start \ Settings \ Control Panel \ System \ Advanced.\n    (For Window NT, select `Start \ Settings \ Control Panel \ System.)

2. Select `Environment Variables.\n    (For Window NT, select `Environment.\n
3. Verify there is a User Variable named `TEMP (usually `C:\TEMP). If not, enter `TEMP in the `Variable field and `C:\TEMP in the `Value field. Click `Set.

4. Verify that a `FEMISTOPDIR environment variable exists in the `System Variables box. If not, select it and change the value in the `Variable and `Value text boxes, and click `Set. The value of this variable should be set to the directory in which FEMIS was installed.

   If you change anything, you must log out of Windows and login again for the changes to take effect.

5. Click `OK to exit the System Properties (Configuration for Windows NT) in the Control Panel.

### 4.4.6 Creating FEMIS Icons

The FEMIS Setup program creates a shortcut on the All Users’ desktop to the FEMIS folder on the `Start menu. If you wish to add more shortcuts to the FEMIS folder on the Windows `Start menu, you can simply add the shortcuts to the FEMIS folder on the desktop.

If you wish to have any of the FEMIS icons on the desktop, copy the shortcuts from the FEMIS menu on the desktop to the `%AllUssersProfile%\DESKTOP` folder.

If you wish to delete any of the shortcuts, right click on the shortcut to be deleted, and select the `Delete` option. This will only delete the shortcut, not the program to which it points.

**Note:** If an icon or a shortcut is not created in the All Users profile, the FEMIS icon will only show up for the user under whose profile the shortcut was created.

### 4.4.7 Final Steps for the FEMIS PC Installation and Configuration

**Note:** If this is an upgrade installation, you may wish to clean up old icons from the `Start \ Programs. These may include old icons for the FEMIS program and old icons for running the startup batch files in the Startup group.

Complete the following steps for the FEMIS installation and configuration:

1. Log out of Windows.

2. Log into Windows as the appropriate user account, and open the FEMIS application.
3. Verify the installation of the first PC thoroughly by following Section 4.6, Validating the FEMIS PC Installation, before any more PC installations are started. If you must edit any of the configured files (e.g., ADDODBC.BAT, TNSNAMES.ORA), copy the corrected file back to the server and install again to be sure that it will work correctly.

4.5 Configuring FEMIS for All PCs at an EOC

The following validation steps need to be performed one time at each EOC. Since these configuration changes affect values stored in the FEMIS database for the EOC, they will take effect on all of the PCs using the same database.

4.5.1 Verifying the Zone Name Lookup for EMIS PAR

**Note:** If both of the following two conditions are true, you must complete this section:
1. You are currently installing FEMIS on an onpost PC.
2. EMIS is used onpost at your site.

You can skip this section if you are upgrading from an earlier version of FEMIS, and you performed these steps when that version was installed.

Because EMIS allows users to change zone names at will, there is a possibility that FEMIS and EMIS zone names will not match exactly. It is important, however, for FEMIS to be able to map its zone names to the zone names used in EMIS so that Protective Action Recommendations (PARs) may be shared between the systems. For this reason, a simple utility named FZONES.EXE has been added to the list of system administration software tools available on the PC. This tool allows your FEMIS System Administrator to set up the EMIS zone name aliases so FEMIS will be able to correctly map PAR information sent from EMIS. If EMIS is part of the site configuration, then this utility must be run on the onpost FEMIS at installation and again whenever EMIS changes their zone names.

4.5.2 Using FZONES.EXE Tool

FZONES.EXE is a system tool that runs on the PC and is located in the directory where FEMIS was installed (usually C:\FEMIS). Before you can run this tool, you will need to install at least one PC with system tools.

This tool displays a two-column spreadsheet of zone information. In the first column, there is a read-only list of FEMIS zone names. In the second column, there is a writable copy of the EMIS zone names. When you first start this utility, it will load the values currently in the database for the FEMIS and EMIS zone names. If at any time during the editing process you wish to reload the spreadsheet based on the values in the database, click the **Reset Spreadsheet** button.
To populate the FEMIS/EMIS zone lookup table, you will need to get a list of all the EMIS zone names for the site. This information may be found on the EMIS server in the following file: 
\(/<\text{disk}>/\text{emis3run/emisdyn/data/}<\text{site code}>/\text{emisgis/giszne.dat}\). The <disk> and <site code> will be site specific. Once you have the EMIS list of zones, the simplest way to populate the lookup table is to run the FZONES utility, and then type the EMIS zone names directly in the spreadsheet next to the corresponding FEMIS zone name. When the spreadsheet is complete, click the Save button.

4.6 Validating the FEMIS PC Installation

This section will assist your System Administrator to validate that the FEMIS system has been properly installed and is operating correctly.

The FEMIS PC Validation Checklist, provided at the end of this section, includes items that should be checked to ensure that the FEMIS system is operating properly. The Checklist correlates to the items listed below. These items are tested from the PC to ensure access and integration into the FEMIS application.

If problems are encountered during the validation, refer to FEMIS Troubleshooting guide found under the Help menu on the FEMIS Workbench for suggestions and guidance.

4.6.1 One Time at EACH EOC

The following validation steps must be performed one time at each EOC.

4.6.1.1 Ensure Exercise #1 Exists

Ensure Exercise #1 or another Exercise is recognized by EMIS has been created. This will allow EMIS to communicate with FEMIS in Exercise mode.

4.6.1.2 Verify Default D2PC Case Exists

From the FEMIS Workbench or the Navigator, click D2PC. On the D2PC window, select Edit mode, and select File → Site Defaults → Revert to Site Defaults.

If a message displays stating there is “no current D2PC case selected” or “no site defaults yet assigned for this site”, then you will need to create a site default D2PC case.
STOP

If there is not a site default D2PC case, select a case that runs and make it the default case.

Consult with the Hazard Analyst to make sure the new default case is modified to meet the EOC’s needs and properly saved.

Once the EOC has a default case, repeat this verification section.

4.6.1.3 Verify FEMIS/EMIS Data Exchange Interface (DEI)

Note: The definitive description of this interface can be found in Section 7.0, FEMIS Data Exchange Interface (DEI), in the System Administration Guide for FEMIS Version 1.5.3.

To verify that DEI is operating, click the Status menu in Operations mode and select Met Condition. If the current meteorological (Met) data appears in the table, then the DEI is probably running.

4.6.1.4 Test the GIS on the Printer

Not all printers display graphics the same. For each printer to which you anticipate printing, use both KeyPrint and the Print option on ArcView GIS to print a GIS map that contains a D2PC case, Threat Area, Risk Area and one or more facilities under each. Review the printout to ensure that it prints graphics in such a way that:

- Risk and No Risk can be differentiated.

- One feature does not totally obscure an underlying feature (e.g., You can still see facilities located in the Threat Area, and the Threat Area does not wipe out the D2PC isopleths.).

4.6.1.5 Verify User Feedback

Verify the User Feedback option to report software enhancements or problems reports (SEPRs) with FEMIS can be sent directly to PNNL (ranata.johnson@pnnl.gov [Ranata Johnson’s E-mail address] or blanche.wood@pnnl.gov [Blanche Wood’s E-mail address]).
4.6.2 Perform on EVERY PC

The following validation sections should be performed on every PC.

Note: Login to Windows as a user with Administrator privileges.

4.6.2.1 Verify the PC Configuration

Verify each of the following items to make sure the PC’s configuration is correct.

- Icons left from previous installations of FEMIS but are no longer linked to a program should be removed from the Start → Programs → Femis folder.

- KeyPrint is in the Startup group for all users.

- The FEMIS startup file is called either in each user’s profile or from the All User Startup folder.

- System Environment variable FEMISTOPDIR is defined and set to the directory where FEMIS is installed.

4.6.2.2 Verify the Network Time Protocol (NTP) Service

To verify the Network Time Protocol (NTP) will synchronize with the server for small variations in time when the PC is booted up, complete the following steps:

- Click Start → Programs → Administrative Tools → Event Viewer to the Event View window. Under the Log menu item, select Application. Check for warning or error messages (yellow or red icon) with NTP as the source. Troubleshoot as necessary.

- Change the PC clock to a significantly different time (1 hour or more).

- Restart the PC (Start → Shut Down → Restart the Computer).

- Login and verify that the PC clock has been reset correctly.

- From a DOS prompt, enter the command ntptrace. This should return a list of the servers that are used to synchronize time to the PC. If this does not happen, see Section 4.2.6, Validating the I:\CONFIGD\NTP.CONF File for more information on this file.

Note: Do not use Administrator privileges to perform the rest of the validation steps.
4.6.2.3 Verify Login

For Windows, check to make sure a shortcut to FEMIS exists.

- Validate the ability to access the FEMIS application by double clicking on the FEMIS icon.
- Confirm that the correct default Site/EOC is highlighted.
- Enter a valid usercode and password. The Select Mode window should display.
- Verify the ability to enter Operations mode.

4.6.2.4 Verify D2PC

Complete the following steps to verify D2PC.

- Click the Navigator button.
- Click D2PC on the Navigator. Be patient while the initial connection is made to the D2PC application and the FEMIS database. D2PC should come up with a default case and should be ready to run. Select Edit mode.
- Start FEMIS on a second PC, and click the Navigator button. This second PC will also be used in Section 4.6.2.5, Verify Notification Service.
- Right-click on the AutoUpdate button, and turn off AutoUpdate on the second PC.
- Save the D2PC case on the first PC.

Onpost users may get messages about sending the D2PC case offpost. Click Yes, and close the D2PC window.

**Note:** Close the GIS, if it is open.

4.6.2.5 Verify Notification Service

On the Navigator of the second PC, you should see a blinking icon (New Data button) that looks like a package. A magenta bar on the D2PC Function box should also appear. This means that FEMIS data notifications are being sent and passing messages to your PC. Click the New Data button.
4.6.2.6 Verify GIS

**Note:** Make sure the GIS is not open before starting this verification.

Click the Map button from the FEMIS toolbar. The ArcView GIS application should start, and you should see a base map displayed within an ArcView GIS window.

To check the link between FEMIS and the GIS, select Facilities theme on the left side of the GIS window. Click the i+ button on the ArcView GIS toolbar; and then click a facility icon on the map. A view-only facility/resource window should appear.

**Do not close the GIS** as it will be used in the following steps.

Check the CSEPP Emergency Zones upgrade by creating a Risk Area with all CSEPP zones at risk. Plot the Risk Area on the GIS. The CSEPP Emergency Zones should turn red.

Check the General Hazard Zones upgrade. Enter a hazard using the general hazard zones as a hazard layer, and create a Risk Area with all general hazard zones at risk. Plot the Risk Area on the GIS. The General Hazard Emergency Zones (the county theme) should turn red.

Verify that the following GIS ViewMarks options load successfully: Select, Save as Private, Save as Shared, Delete, and Use at Startup.

From the FEMIS GIS, click on ViewMarks and then

- Click on **Select**, choose a ViewMark from the drop-down list, and click **OK**. Verify that it loads successfully.

- Click on **Save as Private**, enter a name for the ViewMark, and click **OK**. Verify that the ViewMark was saved as private. Select the private ViewMark, and verify that it loads successfully.

- Click on **Save as Shared**, enter a name for the ViewMark, and click **OK**. Verify that the ViewMark was saved as shared. Select the shared ViewMark, and verify that it loads successfully.

- Click on **Delete**, select a test ViewMark to delete, and click **OK**. Verify that the ViewMark has been deleted successfully.

- Click on **Use at Startup**. From the drop-down list, select the ViewMark you want to use at startup, and click **OK**. Verify that the selected ViewMark loads when starting the GIS.
4.6.2.7 Verify Electronic Planning

To verify that FEMIS Electronic Planning is working, click on Utility → Planning Development, and select a plan. If you can do this without any error messages and tasks appear in the spreadsheet; then the Electronic Planning should work properly.

4.6.2.8 Verify Help

Click the Help button to activate the online Help to verify the Help subsystem is working properly. All help files should be checked. This includes the on-line Troubleshooting Guide.

4.6.2.9 Verify Printer

Verify KeyPrint was enabled at log in. Use KeyPrint or the Print Screen button on any FEMIS window to ensure the PC is properly connected to a printer.

4.6.2.10 Verify FEMIS Tools

Verify on a FEMIS PC with System Tools installed. Click on each of the FEMIS Tools (FEMIS Monitor PC, FEMISMon Watcher, and Network Monitor) to ensure they are operational.

FEMIS PC Installation Checklist

<table>
<thead>
<tr>
<th>Task</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4.1.1 – Installing Windows 2000 Service Pack 2 or Windows NT 4.0 Service Pack 6</td>
</tr>
<tr>
<td>2</td>
<td>4.1.2 – Installing Oracle Net8 Client v8.1.6 and ODBC v8.1.6.2 (patches)</td>
</tr>
</tbody>
</table>
| 3    | 4.1.4.1 – Installing ArcView GIS v3.1.1  
  | 4.1.4.2 – Installing ArcView GIS v3.1.1 Patch |
| 4    | 4.1.5 – Installing Other COTS; Site Specific |
| 5    | 4.2 – Configuring the FEMIS Setup Program (Once at Each EOC) |
| 6    | 4.2.8 – Updating the PC HOSTS File |
| 7    | 4.3 – Installing the FEMIS Client Software |
| 8    | 4.4.4 – Running the FEMIS FSTARTUP.EXE |
| 9    | 4.4.5 – Verifying Temporary Directory and Environment Variables |
### FEMIS PC Validation Checklist

<table>
<thead>
<tr>
<th>PC Name:</th>
<th>Validated using Window 2000 or Windows NT 4.0 Login:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>One Time at Each EOC:</strong></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Ensure Exercise #1 exists or whatever exercise is recognized by EMIS</td>
</tr>
<tr>
<td>2</td>
<td>Verify Default D2PC Case exists</td>
</tr>
<tr>
<td>3</td>
<td>Only on the server with the depot database, verify FEMIS/EMIS Data Exchange Interface (DEI)</td>
</tr>
<tr>
<td>4</td>
<td>Test the GIS on the printer</td>
</tr>
<tr>
<td>5</td>
<td>Verify User Feedback option</td>
</tr>
<tr>
<td><strong>Perform on Every PC:</strong></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Ensure Windows login FEMIS/FEMIS does not exist</td>
</tr>
<tr>
<td>2</td>
<td>Verify the PC configuration</td>
</tr>
<tr>
<td>3</td>
<td>Verify Network Time Protocol (NTP) service</td>
</tr>
<tr>
<td>4</td>
<td>Verify login</td>
</tr>
<tr>
<td>7</td>
<td>Verify D2PC</td>
</tr>
<tr>
<td>8</td>
<td>Verify Notification Service</td>
</tr>
<tr>
<td>9</td>
<td>Verify the GIS (including ViewMarks)</td>
</tr>
<tr>
<td>10</td>
<td>Verify Electronic Planning</td>
</tr>
<tr>
<td>11</td>
<td>Verify Help</td>
</tr>
<tr>
<td>12</td>
<td>Verify printer</td>
</tr>
<tr>
<td>13</td>
<td>Verify FEMIS Tools on appropriate PC(s)</td>
</tr>
</tbody>
</table>
5.0 Remote Evacuee Registration and Point to Point Protocol

5.1 Remote Evacuee Registration

The Remote Evacuee Registration (RER) application can be used in shelters where a network connection is not available. It is also suited for use on portable PCs in situations where the user is required to be mobile. Evacuee information can be entered and then uploaded to a site’s database using a standard phone connection and PC modem. Use of the application does not require that the user install the entire FEMIS product line.

To run Remote Evacuee Registration via Dial-Up, your site must have a modem and Point to Point Protocol (PPP) dial-up software and hardware installed as well as properly configured on the server.

5.2 Installing Remote Evacuee Registration

Remote Evacuee Registration can be installed on a PC as an option using the setup program that installs FEMIS. If you also need FEMIS to run on the PC, use the installation instructions in Section 4.0, FEMIS PC Installation. Be sure and check the Remote Evacuee Registration checkbox when selecting components during installation (see Section 4.3.2, Running the Setup Program).

Remote Evacuee Registration needs the following COTS in order for it to be installed and operate properly:

- Windows 2000 Service Pack 2 or Window NT 4.0 Service Pack 6.
- NFS software or Samba server daemon (to install Remote Evacuee Registration only).
- Oracle Net8 Client v8.1.6 and ODBC Driver v8.1.6.2 — Section 4.1.2, Installing Oracle Net8 Client v8.1.6 and ODBC Driver v8.1.6.2.

The FEMIS Oracle database on the UNIX server must be operational before the Setup Program is run.

1. Close all programs that are running.
2. Connect your I:\ drive as specified in Section 4.2.1, Connecting the Network Install Drive.
3. Run the I:\PC\SETUP\SETUP.EXE program.
4. Select your EOC from the drop-down list, and click Next.
5. Check the Remote Evacuee Registration box.

If you will be installing Remote Evacuee Registration without other FEMIS components (which is an option), deselect those components (FEMIS and GIS are selected by default).

Click Next.

If the FEMIS GIS is not installed, the following prompt will display: Set Default FEMIS Database Cannot find the GIS data for <EOC> Do you want to proceed anyway? Click Yes, and then OK to the warning that follows.

Remote Evacuee Registration needs Dial-Up Networking installed and a Phonebook entry configured for your EOC’s dialup service if you intend to use Dial-Up for evacuee registration.

5.3 Setting Up Dial-Up Networking

Setting up Dial-Up Networking consists of verifying the modem has been installed, configuring the dial-up networking, and connecting via the dial-up network.

5.3.1 Verifying Modem Installation

To verify the modem installation, complete the following steps.

1. Login to Windows as a user with Administrator privileges.

2. Click Start → Settings → Control Panel, and double-click the modem icon.

3. Verify the modem is installed.

If no modem is installed, the Install New Modem program will execute. Use the vendor’s recommendation for installing the correct drivers for Windows 2000 or Windows NT 4.0.

5.3.2 Configuring Dial-Up Networking for Windows NT

Complete the following steps to configure the dial-up network. If you are using Windows 2000, proceed to Section 5.3.3, Configure Dial-Up Networking for Windows 2000.

1. Login to Windows as a user with Administrator privileges.

2. Click Start → Programs → Accessories → Dial-Up Networking.

3. Follow the prompts to install the software from the Windows CD if the Dial-Up Networking has not been previously installed.
If it has been installed but not configured for use, you will be prompted to add a phone book entry. Click **OK**.

If you do not get either of these prompts, click the **New** button on the Dial-Up Networking window.

4. Enter a name for the phonebook entry you will use to connect to the server. Click **Next**.

The parameters used to configure your phonebook entry need to be provided to you by the administrator of the dial-up server on the network you will connect to.

**Note:** If you do not enter a DNS server, be sure the IP for the FEMIS server and other systems you wish to connect to on its network are in your hosts table located in the `<WIN\system32\drivers\etc\hosts` file.

5. Click **Finish** to save your phonebook entry.

6. Locate an analog phone line that you will connect to your modem.

7. Click the **Location** button in the Dial-Up Networking window.

8. Click **New** if you have previously configured dialing locations.

9. Edit the **I am dialing from** to reflect the location/phone line you are using.

10. Edit all applicable items in this window, and click **OK**.

Verify the connection by completing the following steps:

1. Login to Windows.

2. Click **Start** ➔ **Programs** ➔ **Accessories** ➔ **Dial-Up Networking**.

3. Select your phonebook entry and dialing from location. Be sure your modem is plugged in, and click **Dial**.

4. Enter your user name, password, and domain as required by Dial-Up Server, click **OK**. The modem will then attempt to dial the Dial-Up Server.

   If you get an After Dial Terminal Window, enter the required user name and password, and click **Done**. Contact the Dial-Up Server administrator, if you cannot logon.

   To test your connection, bring up a DOS window, enter a `ping <FEMIS server>`, and verify you get a response.
5. Disconnect from the server by right clicking on the Dial-Up Networking Monitor icon in the Task Bar → Hang up → Phonebook entry.

### 5.3.3 Configuring Dial-Up Networking for Windows 2000

If you have already configured your PC to C:\ drive, complete the following steps:

1. Login to Windows as a user with Administrator privileges.
2. Click Start → Settings → Network and Dial-up Connections → Make New Connection.
3. Follow the prompts using the Network Connection Wizard and configure a Dial-up connection.
   
   The parameters used to configure your dial-up connection need to be provided to you by the administrator of the dial-up server on the network you will connect to.

Verify the connection by completing the following steps:

1. Login to Windows.
2. Click Start → Settings → Network and Dial-up Connections.
3. Select your dial-up connection. Be sure your modem is plugged in.
4. Enter your user name, password, and domain as required, and click Dial. Wait for the dial-up connection to appear on the task bar indicating connection status and speed.
   
   If you get an After Dial Terminal window, enter the required user name and password, and click Done. Contact the Dial-Up Server administrator, if you cannot logon.
5. Test your connection by bringing up a DOS window, entering a ping <FEMIS server>, and verifying you get a response.
6. Disconnect from the server by right clicking on the Dial-Up connection icon on the Task Bar, and select Disconnect.

### 5.4 Verify Remote Evacuee Registration

To test Remote Evacuee Registration via the Dial-p, complete the following steps:

1. Start the Remote Evacuee Registration application. Answer No to the question about being on the Network.
2. Select the phonebook/dial-up entry for Dial-up Server in the Profile drop-down window, and click the Dial & Sync button when the Exchange Server Dial Assistant dialog is displayed.

3. Enter your user name, password, and domain as required by Dial-Up Server, click OK. The modem will then attempt to dial the Dial-Up Server.

   If you get an After Dial Terminal Window, enter the required user name and password, and click Done. Contact the Dial-Up Server administrator, if you cannot logon.

4. Select your EOC on the FEMIS Login window, and enter your FEMIS user name and password. Click OK.

5. Select the mode that you would like to test in: either Operations or Exercise (by selecting one of the available Exercises). Click OK.

   The Auto Download Data from Server dialog is displayed. This application will take advantage of the dialup connection by downloading the contents of the Lookup tables. Downloading the Lookup table contents will only take place if the number of records in the Lookup table on the server and the Lookup table in the local database are different. You will be warned if there is no data for one of the tables on the server.

6. Click Close on the Auto Download window. The Dial-Up connection will automatically disconnect and the FEMIS Remote Evacuee Registration window will close.

7. Exit FEMIS Remote Evacuee Registration.
6.0 Standalone Installation of FEMIS v1.5.3

The following section contains instructions on the installation of a standalone Oracle database and the configuration of the FEMIS v1.5.3 application on the standalone system. Items that will be required to complete this installation are as follows:

- Oracle8i v8.1.6 or v8.1.7 Server or Personal Oracle Edition
- Exports generated by a FEMIS database
- FEMIS server for installation of Software
- FEMIS v1.5.3 COTS CD.

**Note:** The Oracle version needs to be at or later than is installed on the FEMIS server. If Oracle was upgraded to version 8.1.7 on the FEMIS server, you must upgrade the Standalone PC Oracle also.

6.1 Disk Space Required

The standalone requires that Oracle8i v8.1.6 database software be installed on the PC. The amount of disk space required for a minimal installation of these products is

- ~586 MB for Oracle8i or Personal Oracle8i
- ~500 MB-900 MB for FEMIS data files.

6.2 Removing FEMIS v1.5 Database

FEMIS v1.5 used Oracle 8.1.6 for the server and standalone database. If the server has been upgraded to Oracle 8.1.7, it is required that the standalone PC also be upgraded to that version. Perform the following to remove a previous Oracle 8.1.6 installation prior to installing the 8.1.7 software. If you have an installation of Oracle 8.1.6 client and need to upgrade to 8.1.7, just complete Section 6.2.3, Removing the Oracle 8.1.6 Software.

6.2.1 Removing Oracle Instance

Complete the following steps to remove the Oracle instance.

1. Click Start → Programs → Oracle Oracle-OraHome81 → Database Administration → Database Configuration Assistant.

2. Select Delete a Database, and click Next.


4. Click Finish, and OK to warnings to remove the instance.
6.2.2 Removing the Oracle Listener

Complete the following the steps to remove the Oracle Listener.

1. Click Start → Programs → Oracle Oracle-OraHome81 → Network Administration → Net8 Configuration Assistant.

2. Select Listener Configuration on the Net8 Configuration Assistant: Welcome window, and click Next.

3. Select Delete, and click Next.

4. Highlight LISTENER, and click Next.

5. Click Yes to confirm, and click Next after confirmation of LISTENER was deleted and LISTENER configuration is complete.


6.2.3 Removing the Oracle 8.1.6 Software

Complete the following the steps to remove Oracle 8.1.6.

1. Click Start → Programs → Oracle Installation Products → Universal Installer.

2. Select Installed Products.


4. Check the boxes next to all the products under both sections, and click Remove.

5. Restart the PC after the Products have been removed, and delete the Oracle directory to remove files that may have been in use during uninstall.

6.3 Installing Oracle8i Server or Personal Oracle Edition 8.1.6 or 8.1.7 and Patches

Complete the following the steps to Install Oracle8i Server or Personal Oracle Edition 8.1.6 or 8.1.7:

1. Insert the Oracle installation CD into the CD drive.

2. Select Install/Deinstall Products on the window that appears.
Note: If window does not start automatically upon inserting the CD, click Start → Run, and enter <CD DRIVE>:\SETUP.EXE.

3. Click Next in the Oracle Universal Installer – Welcome window.

4. Verify the destination Name and Path of the Oracle Home directory (typically C:\ORACLE\ORA81), and click Next.

   Note: You should install Oracle to the same Oracle Home Name and Path as the Net8 Client was installed during the COTS installation.

5. Select Oracle8i or Personal Oracle8i Edition, and click Next.

6. Select Minimal Installation Type, and click Next.

7. Select No in the Select Starter Database window, and click Next.

8. Click Install in the Summary window.

   Note: You may receive the message – Error in writing to file C:\winnt\system32\<filename>.dll – when the install is copying files to the PC. Browse to the location of the file, right click on the file, and select properties. Uncheck the Read-only box, and click OK. Then return to the message, and click Retry.

9. Click Cancel in the Net8 Configuration Assistant Welcome window that displays after the installation is complete.

10. Click OK in the Error window that follows.

11. Click Next in the Configuration Tools window.

12. Click Exit in the End of Installation window.

Installing Oracle8i Patch Set 8.1.6.3 or 8.1.7.4

The Oracle8i patch set 8.1.7.4 must be installed after Oracle8i Server or Personal Oracle Edition 8.1.7.0.0 has been installed. If you installed Oracle 8.1.6, install the 8.1.6.3 patch.

1. Click Start → Run, and enter services.msc /s

2. Stop all Oracle services that may be running. Oracle services start with OracleOra.
3. Insert the FEMIS v1.5.3 COTS CD.

4. Click Start → Programs → Oracle Installation Products → Universal Installer.

5. Click Next on the Welcome window.

6. Browse to `<COTS drive>:\Oracle8174\Disk1\stage\products.jar` or `<COTS drive>:\Oracle 8163 Patch\Disk1\stage\products.jar` for the Source… Path.

   Click Next.

7. Click Install on the Summary window.

   **Note:** You may receive the following error message, if you did not stop the Oracle services that were running prior to this step.

   Certain files which need to be reinstalled by Oracle Universal Installer are being used by one or more running services.
   The following running services need to be shutdown:
   - OracleOraHome8iAgent
   - OracleOraHome8iDataGatherer
   - OracleOraHome8ihttp server

   *Press "Help" for more information
   Press "Retry" to try again
   Press "Cancel" to stop this installation

8. Click Exit on the End of Installation window.

### 6.4 Configuring Oracle Network Components

Before the database instance can be installed, the Net8 components and Listener need to be configured. Complete the following steps to configure these.

#### 6.4.1 Configuring SQLNet

1. Click Start → Programs → Oracle Oracle-OraHome8i → Network Administration → Net8 Assistant.

2. Go to Net8 Configuration → Local, and select Profile.

3. Go to the Naming section, and select the Methods tab. Use only TNSNAMES as Selected Methods. To add or remove selected items, use the < and > buttons.

4. Click the Oracle Names tab, and enter World as Default Domain.
5. Click **File** on the menu bar, and select **Save Network Configuration**.

6. Click on **File**, and select **Exit**.

### 6.4.2 Setting up Oracle Listener

1. Click **Start** → **Programs** → **Oracle Oracle-1OracleHome81** → **Network Administration** → **Net8 Configuration Assistant**.

2. Select **Listener Configuration** in the Net8 Configuration Assistant: Welcome window, and click **Next**.

3. Select **Add**, and click **Next**.

4. Use the default Listener name, **LISTENER**, and click **Next**.

5. Verify TCP is the only item in the **Selected Protocols** field on the Select Protocols window. Use the < and > buttons to add or remove Selected Protocols. Click **Next**.

6. Use the standard port number of **1521** for the TCP/IP port number. Click **Next**.

7. Select **No** for **Would you like to configure another listener?** Click **Next**.
   
   If you receive the following message, you will need to use the **Back** buttons to delete the listener that you just created and begin again.
   
   The TCP Protocol is currently in use by another listener. You can proceed with the configuration, as it is, but it will not be possible to start this listener until the conflict is resolved. Would you like to continue with the configuration anyway?

8. Click **Next** for **Listener configuration complete!** You will be returned to the Net8 Configuration Assistant: Welcome window.

9. Click **Finish**.

### 6.4.3 Enabling NT Authentication

To enable NT Authentication, complete the following steps.

1. Use a text file editor (like WordPad) to edit the **Oracle home/network/ADMIN/sqlnet.ora** file.

2. Add the following parameter: `SQLNET.AUTHENTICATION_SERVICES = (NTS)` to the list of parameters.
3. Save and close the file.

4. Verify the Windows NT/2000 user account(s) you will use to build and administer the database. They are members of the ORA_DBA group account (the user who installed Oracle is added to this group automatically.).

   **Note:** If you are using domain authenticated accounts, the PC will need to be connected to the network for NT authentication to work.

### 6.5 Building the Oracle Database

If you have Personal Oracle or Oracle Server 8.1.6 installed, skip this section.

If you are upgrading to Oracle8i Server or Personal Oracle Edition 8.1.7.0.0, then complete the following steps to build the database for v1.5.3.

1. Click Start → Programs → Oracle Oracle-OraHome81 → Database Administration → Database Configuration Assistant.

2. Select Create a database, and click Next.

3. Select Custom for type of database to create, and click Next.

4. Select Multipurpose for Primary type of application that will be used. Click Next.

5. Enter 1 for Concurrently connected users, and click Next.

6. Select Dedicated Server Mode for mode in which you want your database to operate by default. Click Next.

7. Deselect the Oracle JServer, and verify that only the following items are checked for the Select Options that will be configured for use in your database window.

   Advanced Replication
   SQL*Plus Help

   Click Next.

8. Enter fi0.world for the Global Database Name. fi0 will be automatically entered for the SID. Accept the default Initialization Filename location. For Compatible Parameter, select 8.1.0. **Do not select** Change Character Set. Click Next.
Note: If you are prompted to enter a password for the Internal privileged account, cancel the database creation, and verify Section 6.4.3, Enabling NT Authentication, was completed successfully. Restart this section at Step 1 after changes have been made.

9. Accept the default locations and parameters for the Control Files if you are installing on a system that has only one physical disk. If you have multiple disks, locate the control files on separate disks, whenever possible. To change the drive location, only change the drive letter and leave the file location path intact. Click Next.

10. Change each to the following for the Size parameter of the tablespaces. Each tablespace that is going to be created by the Oracle Database Configuration Assistant is represented by a tab in this window. Use the default Name, File, Extent, and Storage parameters for all tablespaces.

<table>
<thead>
<tr>
<th>Tablespace</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>100MB</td>
</tr>
<tr>
<td>Tools</td>
<td>3MB</td>
</tr>
<tr>
<td>User</td>
<td>3MB</td>
</tr>
<tr>
<td>Rollback</td>
<td>50MB</td>
</tr>
<tr>
<td>Index</td>
<td>3MB</td>
</tr>
<tr>
<td>Temporary</td>
<td>20MB</td>
</tr>
</tbody>
</table>

Click Next.

11. Accept the default location and parameters for the Redo Logs. If you have multiple disks, locate the Redo Logs on the separate disks, whenever possible. To change the drive location, only change the drive letter, and leave the file location path intact. Click Next.

12. Accept the defaults Checkpoint Interval and Checkpoint Timeout. Do not check Enable Archive Log. Click Next.

13. Accept the default SGA parameter information, and click Next.


15. Check Create database now. Click Finish.

16. Click Yes on the Message box that follows to create the instance.

Note: The database creation process will take some time.

17. Click OK in the Oracle Database Configuration Assistant Alert window.
6.6 Installing PC COTS and FEMIS v1.5.3

6.6.1 Uninstalling Previous Version of FEMIS

If you are upgrading from a previous version of FEMIS, uninstall the previous version of FEMIS by completing the following steps:

1. Map your I: drive to \<femis server>\finstall.

2. Open the Add/Remove Programs window by selecting Start → Settings → Control Panel → Add/Remove Programs.

3. Select FEMIS, and click the Remove button.

   If you are asked for the path to the FEMIS.MSI file, browse to I:\pc\setup\v15\FEMIS.MSI, open the FEMIS.MSI file.

4. Click OK on the message to restart the PC, if you get a message about restarting your PC.

6.6.2 Installing FEMIS v1.5.3

Complete the following the steps to install FEMIS v1.5.3.

1. Follow the instructions in Section 4.1.4, Installing ArcView GIS v3.1 and v3.1.1 Patch, to install ArcView 3.1.1, unless it is already installed from FEMIS v1.5.

2. Map your I: drive to \<femis server>\finstall.

3. Run the I:\PC\SETUP\SETUP.EXE.

4. Select the Modify option in the Program Maintenance window if you have v1.5.3 already installed.

5. Select your Site and EOC, and click Next.

6. Select the Standalone option to be installed to your local hard drive on the Custom Setup window.

7. Select Next in the Select GIS and Location window, and click Install to begin the installation.

8. Click Cancel on the message indicating failed to connect to the FEMIS Oracle Database.
6.7 Creating FEMIS Database Tablespaces

To prepare the database for FEMIS data, additional tablespaces and public rollback segments need to be created.

Complete the following steps to create additional tablespaces and public rollback segments:

1. Use Windows Explorer to browse to the STANDALONE directory under the FEMIS directory created during the install, usually C:\FEMIS\STANDALONE.

2. Use a text editor, such as WordPad, to open the CR_TABLESPACE.SQL file.

3. Modify, if necessary, the path locations for the FMAIN, FINDEX, FSNAPSHOT, FSNAPLOG, and FLOB DATAFILES to be located in the ORADATA folders created by the instance installation. If you have multiple hard drives on which to install, preferably locate them on drives other than the drive where Oracle was installed. If you had three drives, for example:

   Oracle installed drive C:\ORACLE\ORA81
   FMAIN D:\ORACLE\ORADATA\FI0\FMAIN01.DBF
   FINDEX E:\ORACLE\ORADATA\FI0\FINDEX01.DBF
   FSNAPSHOT D:\ORACLE\ORADATA\FI0\FSNAPSHOT01.DBF
   FSNAPLOG E:\ORACLE\ORADATA\FI0\FSNAPLOG01.DBF
   FLOB D:\ORACLE\ORADATA\FI0\FLOB01.DBF

4. Ensure the paths specified in the CR_TABLESPACE.SQL exist. If not, create them.

5. Verify you have sufficient disk space for the data files Size parameter in the CR_TABLESPACE.SQL and room for additional growth when FEMIS data is imported.

   Note: Disk space requirements will vary depending on the amount of FEMIS data that has been inputted at your site. FMAIN or FSNAPSHOT can exceed 300 MB in some installations.

6. Locate the Instance initialization file, INITFI0.ORA, which is located in the <INSTALL DRIVE>:\ORACLE\ADMIN\FI0\PFILE.

7. Edit the INITFI0.ORA with a text editor (such as WordPad). Enable private rollback segments by removing the # from the beginning of the parameter and modify it to match the following.

   ROLLBACK SEGMENTS = (RBS0, RBS1, RBS2, RBS3, RBS4, RBS5)

6.8 Putting Data in the Standalone Database

The standalone database uses data from the FEMIS database located on the server using export files it generates. This allows you to use current data or specify a time when certain data you wish to use
was in the database but may have been archived. After a standalone database has been created, you can use this section to either make the standalone current using the latest exports generated by the server or use older FEMIS v1.5.3 database exports to review older data.

### 6.8.1 Obtaining FEMIS Database Export

The data needed to create a FEMIS database on the PC is located on the FEMIS server where your EOC’s database resides. You will need to know the password for the Oracle account on the server to complete this step. To obtain a FEMIS database export file, complete the following steps:

1. Click on **Start → Run. Enter** `telnet <femis server>`.
2. Enter `femis` at the login prompt, and press Enter.
3. Enter the `femis` user password for the FEMIS server at the password prompt.
4. Enter `cd $ORACLE_EXPORT`.
5. Enter the command `pwd` to display your current path and note this for later use.
6. Enter the command `ls -l` to list the files in the current directory.
7. Determine the FEMIS database export file you wish to use for the database. If you want the most current data, use the file with the latest date.
   
   **Note:** The database exports are created nightly by FEMIS provided the cron jobs run successfully. These files remain on the system until the femis cron or successful backup deletes the older files. If you wish to use older database exports than those that are present, you will need to restore them from tape backup. The export files are created and named `system_<fi#_date>.dmp` and then compressed, adding the `.Z` extension on the end. You can verify the export was created successfully by viewing the `.log` file with the same name.

8. Enter `uncompress <export_file.Z>` to uncompress the file. This will take a few minutes depending on the size of the export file. The export file will no longer have the `.Z` extension after it is uncompressed.
9. Go back to the PC, and click on **Start → Programs → Command Prompt. The Command Prompt window will display.**
10. CD to the standalone directory (usually `C:\FEMIS\STANDALONE`).
11. Enter `ftp <femis server>`.
12. Logon using the femis user and password.

13. Enter `cd <export path>`. This is the path you observed from the `pwd` command in Step 8.

14. Enter `bin` to establish binary mode.

15. Enter `get system_<fi#_date>.dmp`. This will take a few minutes depending on size of export file and the speed of your network.

16. Enter `quit` to return the command prompt after the ftp has successfully finished.

17. Return to the `telnet <femis server>` window initiated earlier in this section.

18. Enter `compress system_<fi#_date>.dmp`. This will take a few minutes.

19. Enter `exit` to close the telnet window when the prompt returns.

### 6.8.2 Importing FEMIS Data into the Database

To import the FEMIS data into the database, complete the following steps:

1. Verify you are located in the standalone directory (usually `C:\FEMIS\STANDALONE`) in a command prompt window.

2. Enter the following at the command line:

   ```
   createstandalone.bat system_<fi#_date>.dmp
   ```

   The command will prompt you to press Return after each script or command is executed. If you receive unexpected errors from any part of the command, you can use Ctrl+C to abort; then correct the problem, and rerun the `createstandalone.bat system_<fi#_date>.dmp`. The step where tables are imported into the database will take some time to complete.

**Note:** During the execution of the scripts, ignore the following import messages:

```
IMP-00015: following statement failed because the object already exists:
IMP-00017: following statement failed with Oracle Error 600: Create snapshot. Refresh force with Rowid as.
IMP-00003: Oracle 600 encountered
ORA-00600: internal error code, arguments: [kbbchlob1], [ ], [ ], [ ], [ ], [ ], [ ]
```

**Note:** If the batch scripts are unable to connect to Oracle, verify the Oracle services are running and that you have completed Section 6.4.3, Enabling NT Authentication, successfully.
6.8.3 Updating FEMIS Data in the Database

In the future, if you would like to update the database with current data from your FEMIS server, repeat Section 6.8.1, Obtaining FEMIS Database Export, to get a current database export file, and then run the following command:

```
updatetandalone.bat system_<fi#_date>.dmp
```

6.9 Configuring FEMIS Installation for Standalone Database

When FEMIS was installed from the server, your system was configured for connecting to the server. The following procedure describes the changes needed for FEMIS to run in a standalone mode.

6.9.1 Running SETSTANDALONE.BAT and SETNETWORKED.BAT

The `SETSTANDALONE.BAT` and `SETNETWORKED.BAT` files are located in the `FEMIS\STANDALONE` directory on the PC. Shortcuts to these command files are put in `Start ➔ Programs ➔ FEMIS` when the standalone option is selected. The `SETSTANDALONE.BAT` script file will configure your PC to run FEMIS in standalone mode. The configuration changes made to your PC are

- Changes the Oracle DSNs for your EOCs FEMIS server’s database to point to the PCs database listener. Other servers DSNs will remain unchanged but should not be used unless in networked mode.

- Sets the `RunAsStandAlone` entry in the `[Notification Service]` section of `FEMIS.INI` to `TRUE`. This will cause the FEMIS Notification Service to run in standalone mode.

Run the `SETNETWORKED.BAT` script to return a PC to the standard networked configuration. Running `SETNETWORKED.BAT` will

- Run the `ADDODBC.BAT` file to set the Oracle DSNs to connect to the networked databases.

- Set the `RunAsStandAlone` entry in the `[Notification Service]` section of `FEMIS.INI` to `FALSE`. This will cause the FEMIS Notification Service to run in networked mode.

**Note:** If you are going to be changing a PC’s configuration between networked and standalone mode, the `TNSNAMES.ORA` file must be configured for the database installed on the local PC and the databases on the networked FEMIS servers. Use the Net8 Assistant to modify this file by adding Service Names for your local configuration using the following parameters:
Net Service Name – fi#.world
Protocol – TCP/IP
Host Name – FEMIS server
Port Number – 1521
(Oracle8i) Service Name – fi#

The tnsnames.ora you saved in Step 1 of Section 6.3, Installing Oracle8i Server or Personal Oracle Edition 8.1.6 or 8.1.7 and Patches, can be used as a reference.

6.9.2 Testing the Setup

You should test the standalone system by shutting the PC down and removing the system from your network. After restarting the PC, check to see if you can start FEMIS. Data on this PC is completely separate and different from a PC running FEMIS that connects to the operational database at your EOC.

If your system is not connected to the network, and you have Remote Access Service (RAS) installed, you might receive a Dial-Up Networking prompt if Auto-Dial is enabled (It is enabled by default.). See Section 6.10, Remote Access Service (NT 4.0 Only), for instructions on disabling Auto-Dial.

6.10 Remote Access Service (NT 4.0 Only)

If you have Remote Access Service (RAS) installed on the PC (used with Remote Evacuee Registration [RER]), you may be prompted to use Dial-Up Networking whenever you attempt to connect to the local database. If you receive this prompt, you can disable this Auto-Dial feature by choosing the following options:

1. Select Yes, Dial when the Dial-Up Networking window displays.

2. Click OK to add an entry, and in the Phonebook entry wizard, click Cancel if you received a prompt that your Phonebook is empty.


4. Select Yes to disable the Auto-Dial feature when you receive the following message:
   Auto-Dial attempt failed. Do you want to disable auto-dial from this location?
You can turn this feature off before attempting to install the standalone database by doing the following:

1. Select an entry to dial from the Phonebook list in Dial-Up Networking.

2. Click on More, and select User Preferences.

3. Clear each location listed in the Enable Auto-Dial by location list on the Dialing tab.

4. Turn on Auto-Dial by reselecting a location in the Enable Auto-Dial by location list.

### 6.11 Verifying the Standalone Installation

To verify that the standalone installation is complete and that FEMIS is fully operational, see Section 4.6, Validating the FEMIS PC Installation. The FEMIS PC Validation Checklist (at the end of Section 4.6) includes items that need to be checked to ensure that FEMIS is operating properly. Because this is a standalone installation, you will not need to, verify FEMIS/EMIS Data Exchange Interface (DEI) on the server with the depot database.